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End-User License Agreement
You have acquired a device ("DEVICE") that includes software licensed by EXFO Inc. (EXFO) from an affiliate of Microsoft 
Corporation ("MS"). Those installed software products of MS origin, as well as associated media, printed materials, and 
"online" or electronic documentation ("SOFTWARE") are protected by international intellectual property laws and treaties. 
Manufacturer, MS and its suppliers (including Microsoft Corporation) own the title, copyright, and other intellectual property 
rights in the SOFTWARE. The SOFTWARE is licensed, not sold. All rights reserved.

This EULA is valid and grants the end-user rights ONLY if the SOFTWARE is genuine and a genuine Certificate of Authenticity 
for the SOFTWARE is included. For more information on identifying whether your software is genuine, please see 
http://www.microsoft.com/piracy/howtotell.   

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT ("EULA"), DO NOT USE THE DEVICE OR COPY THE 
SOFTWARE. INSTEAD, PROMPTLY CONTACT EXFO FOR INSTRUCTIONS ON RETURN OF THE UNUSED DEVICE(S) FOR A 
REFUND. ANY USE OF THE SOFTWARE, INCLUDING BUT NOT LIMITED TO USE ON THE DEVICE, WILL CONSTITUTE 
YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF ANY PREVIOUS CONSENT).

GRANT OF SOFTWARE LICENSE. This EULA grants you the following license: 

 You may use the SOFTWARE only on the DEVICE.

 Restricted Functionality. You are licensed to use the SOFTWARE to provide only the limited functionality (specific tasks 
or processes) for which the DEVICE has been designed and marketed by EXFO. This license specifically prohibits any 
other use of the software programs or functions, or inclusion of additional software programs or functions that do not 
directly support the limited functionality on the DEVICE. Notwithstanding the foregoing, you may install or enable on a 
DEVICE, systems utilities, resource management or similar software solely for the purpose of administration, 
performance enhancement and/or preventive maintenance of the DEVICE.

 If you use the DEVICE to access or utilize the services or functionality of Microsoft Windows Server products (such as 
Microsoft Windows Server 2003), or use the DEVICE to permit workstation or computing devices to access or utilize the 
services or functionality of Microsoft Windows Server products, you may be required to obtain a Client Access License for 
the DEVICE and/or each such workstation or computing device. Please refer to the end user license agreement for your 
Microsoft Windows Server product for additional information.

 NOT FAULT TOLERANT. THE SOFTWARE IS NOT FAULT TOLERANT. EXFO HAS INDEPENDENTLY DETERMINED HOW TO 
USE THE SOFTWARE IN THE DEVICE, AND MS HAS RELIED UPON EXFO TO CONDUCT SUFFICIENT TESTING TO 
DETERMINE THAT THE SOFTWARE IS SUITABLE FOR SUCH USE.

 NO WARRANTIES FOR THE SOFTWARE. THE SOFTWARE is provided "AS IS" and with all faults. THE ENTIRE RISK AS TO 
SATISFACTORY QUALITY, PERFORMANCE, ACCURACY, AND EFFORT (INCLUDING LACK OF NEGLIGENCE) IS WITH YOU. 
ALSO, THERE IS NO WARRANTY AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE SOFTWARE OR AGAINST 
INFRINGEMENT. IF YOU HAVE RECEIVED ANY WARRANTIES REGARDING THE DEVICE OR THE SOFTWARE, THOSE 
WARRANTIES DO NOT ORIGINATE FROM, AND ARE NOT BINDING ON, MS.

 No Liability for Certain Damages. EXCEPT AS PROHIBITED BY LAW, MS SHALL HAVE NO LIABILITY FOR ANY 
INDIRECT, SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES ARISING FROM OR IN CONNECTION WITH THE 
USE OR PERFORMANCE OF THE SOFTWARE. THIS LIMITATION SHALL APPLY EVEN IF ANY REMEDY FAILS OF ITS 
ESSENTIAL PURPOSE. IN NO EVENT SHALL MS BE LIABLE FOR ANY AMOUNT IN EXCESS OF U.S. TWO HUNDRED 
FIFTY DOLLARS (U.S.$250.00).

 Restricted Uses. The SOFTWARE is not designed or intended for use or resale in hazardous environments requiring 
fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air 
traffic control, or other devices or systems in which a malfunction of the SOFTWARE would result in foreseeable risk of 
injury or death to the operator of the device or system, or to others.

 Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or 
disassemble the SOFTWARE, except and only to the extent that such activity is expressly permitted by applicable law 
notwithstanding this limitation. 

 SOFTWARE as a Component of the DEVICE - Transfer. This license may not be shared, transferred to or used 
concurrently on different computers. The SOFTWARE is licensed with the DEVICE as a single integrated product and may 
only be used with the DEVICE. If the SOFTWARE is not accompanied by a DEVICE, you may not use the SOFTWARE. You 
may permanently transfer all of your rights under this EULA only as part of a permanent sale or transfer of the DEVICE, 
provided you retain no copies of the SOFTWARE. If the SOFTWARE is an upgrade, any transfer must also include all prior 
versions of the SOFTWARE. This transfer must also include the Certificate of Authenticity label. The transfer may not be 
an indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the SOFTWARE must agree to all 
the EULA terms.

 Consent to Use of Data. You agree that MS, Microsoft Corporation and their affiliates may collect and use technical 
information gathered in any manner as part of product support services related to the SOFTWARE. MS, Microsoft 
Corporation and their affiliates may use this information solely to improve their products or to provide customized 
services or technologies to you. MS, Microsoft Corporation and their affiliates may disclose this information to others, but 
not in a form that personally identifies you.
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 Internet Gaming/Update Features. If the SOFTWARE provides, and you choose to utilize, the Internet gaming or update 
features within the SOFTWARE, it is necessary to use certain computer system, hardware, and software information to 
implement the features. By using these features, you explicitly authorize MS, Microsoft Corporation and/or their 
designated agent to use this information solely to improve their products or to provide customized services or 
technologies to you. MS or Microsoft Corporation may disclose this information to others, but not in a form that personally 
identifies you. 

 Internet-Based Services Components. The SOFTWARE may contain components that enable and facilitate the use of 
certain Internet-based services. You acknowledge and agree that MS, Microsoft Corporation or their affiliates may 
automatically check the version of the SOFTWARE and/or its components that you are utilizing and may provide 
upgrades or supplements to the SOFTWARE that may be automatically downloaded to your DEVICE. Microsoft 
Corporation or their affiliates do not use these features to collect any information that will be used to identify you or 
contact you. For more information about these features, please see the privacy statement at 
http://go.microsoft.com/fwlink/?LinkId=25243. 

 Links to Third Party Sites. You may link to third party sites through the use of the SOFTWARE. The third party sites are 
not under the control of MS or Microsoft Corporation, and MS or Microsoft are not responsible for the contents of any third 
party sites, any links contained in third party sites, or any changes or updates to third party sites. MS or Microsoft 
Corporation is not responsible for webcasting or any other form of transmission received from any third party sites. MS or 
Microsoft Corporation are providing these links to third party sites to you only as a convenience, and the inclusion of any 
link does not imply an endorsement by MS or Microsoft Corporation of the third party site.

 Notice Regarding Security. To help protect against breaches of security and malicious software, periodically back up 
your data and system information, use security features such as firewalls, and install and use security updates. 

 No Rental/Commercial Hosting. You may not rent, lease, lend or provide commercial hosting services with the 
SOFTWARE to others.

 Separation of Components. The SOFTWARE is licensed as a single product. Its component parts may not be separated 
for use on more than one computer.

 Additional Software/Services.   This EULA applies to updates, supplements, add-on components, product support 
services, or Internet-based services components ("Supplemental Components"), of the SOFTWARE that you may obtain 
from EXFO, MS, Microsoft Corporation or their subsidiaries after the date you obtain your initial copy of the SOFTWARE, 
unless you accept updated terms or another agreement governs. If other terms are not provided along with such 
Supplemental Components and the Supplemental Components are provided to you by MS, Microsoft Corporation or their 
subsidiaries then you will be licensed by such entity under the same terms and conditions of this EULA, except that (i) 
MS, Microsoft Corporation or their subsidiaries providing the Supplemental Components will be the licensor with respect 
to such Supplemental Components in lieu of the "COMPANY" for the purposes of the EULA, and (ii) TO THE MAXIMUM 
EXTENT PERMITTED BY APPLICABLE LAW, THE SUPPLEMENTAL COMPONENTS AND ANY (IF ANY) SUPPORT SERVICES 
RELATED TO THE SUPPLEMENTAL COMPONENTS ARE PROVIDED AS IS AND WITH ALL FAULTS. ALL OTHER 
DISCLAIMERS, LIMITATION OF DAMAGES, AND SPECIAL PROVISIONS PROVIDED BELOW AND/OR OTHERWISE WITH 
THE SOFTWARE SHALL APPLY TO SUCH SUPPLEMENTAL COMPONENTS. MS, Microsoft Corporation or their subsidiaries 
reserve the right to discontinue any Internet-based services provided to you or made available to you through the use of 
the SOFTWARE.

 Recovery Media. If SOFTWARE is provided by EXFO on separate media and labeled "Recovery Media" you may use the 
Recovery Media solely to restore or reinstall the SOFTWARE originally installed on the DEVICE. 

 Backup Copy. You may make one (1) backup copy of the SOFTWARE. You may use this backup copy solely for your 
archival purposes and to reinstall the SOFTWARE on the DEVICE. Except as expressly provided in this EULA or by local 
law, you may not otherwise make copies of the SOFTWARE, including the printed materials accompanying the 
SOFTWARE. You may not loan, rent, lend or otherwise transfer the backup copy to another user.

 End User Proof of License. If you acquired the SOFTWARE on a DEVICE, or on a compact disc or other media, a genuine 
Microsoft "Proof of License"/Certificate of Authenticity label with a genuine copy of the SOFTWARE identifies a licensed 
copy of the SOFTWARE. To be valid, the label must be affixed to the DEVICE, or appear on [COMPANY's] software 
packaging. If you receive the label separately other than from EXFO, it is invalid. You should keep the label on the DEVICE 
or packaging to prove that you are licensed to use the SOFTWARE.

 Product Support. Product support for the SOFTWARE is not provided by MS, Microsoft Corporation, or their affiliates or 
subsidiaries. For product support, please refer to EXFO support number provided in the documentation for the DEVICE. 
Should you have any questions concerning this EULA, or if you desire to contact EXFO for any other reason, please refer 
to the address provided in the documentation for the DEVICE.

 Termination. Without prejudice to any other rights, EXFO may terminate this EULA if you fail to comply with the terms 
and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE and all of its component parts.

 EXPORT RESTRICTIONS. You acknowledge that SOFTWARE is subject to U.S. and European Union export jurisdiction. 
You agree to comply with all applicable international and national laws that apply to the SOFTWARE, including the U.S. 
Export Administration Regulations, as well as end-user, end-use and destination restrictions issued by U.S. and other 
governments. For additional information see http://www.microsoft.com/exporting/.
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Certification Information

x FTB-500

Certification Information

North America Regulatory Statement

This unit was certified by an agency approved in both Canada and the 
United States of America. It has been evaluated according to applicable 
North American approved standards for product safety for use in Canada 
and the United States.

Electronic test and measurement equipment is exempt from FCC part 15, 
subpart B compliance in the United States of America and from ICES-003 
compliance in Canada. However, EXFO Inc. makes reasonable efforts to 
ensure compliance to the applicable standards.

The limits set by these standards are designed to provide reasonable 
protection against harmful interference when the equipment is operated in 
a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance 
with the user guide, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user will be required to 
correct the interference at his own expense. 

Modifications not expressly approved by the manufacturer could void the 
user's authority to operate the equipment.

European Community Declaration of Conformity

An electronic version of the declaration of conformity for your product is 
available on our website at www.exfo.com. Refer to the product’s page on 
the Web site for details.



1 Introducing the FTB-500
Today’s network technology is more complex than ever. Thousands of 
components have to work in harmony and deployment specialists are 
responsible for tuning entire systems for optimal network performance and 
for ensuring records updates. In addition, fiber counts are skyrocketing. 
DWDM is well entrenched in long-haul applications and is moving into 
metro. You know that you need more efficiency.

You will find it with the FTB-500. Benefit from advanced test operations in 
outside plant installation, maintenance, and troubleshooting. The FTB-500 
streamlines field-based test and measurement operations into a single, 
powerful, revolutionary package. Welcome to multi-tasking in the field.

Note: In this documentation, the words “tap” and “double-tap” (related to the 
use of a touchscreen) replace the words “click” and “double-click”.
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Introducing the FTB-500
Main Features
Main Features

Function buttons 

Speaker 

StylusPower button

LCD/Touchscreen

Module-related LED panel

Unit-related
LED panel

USB ports (2)

Front
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Introducing the FTB-500
Main Features
USB ports (2)

Serial Port (male DB-9)

Fiber inspection probe connector Back supports

 Right side

(four-slot model)

Power Meter (optional)

VFL (optional)

Audio out port
(for 3.5 mm connector)

Audio in port
(for 3.5 mm connector)

Module slots
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Introducing the FTB-500
Main Features
Back support

 Right side

(eight-slot model)

Power Meter (optional)

VFL (optional)

Module slots

Bottom support

Front module lock

USB ports (2)

Serial Port (male DB-9)

Fiber inspection probe connector

Audio out port
(for 3.5 mm connector)

Audio in port
(for 3.5 mm connector)
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Introducing the FTB-500
Main Features
Back supports

DC input connector
(for AC adapter/charger)

Ethernet (RJ-45) port

Video out port

Module
retaining

screws

Left side

(Four-slot model)

Express card reader

Telecom grounding
terminal

Cable strain relief
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Introducing the FTB-500
Main Features
Back support

AC connector Bottom support

Ethernet (RJ-45) port

Video out port

Module retaining screwsLeft side

(Eight-slot model)

Express card reader

Telecom grounding 
terminal

Cable strain relief
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Introducing the FTB-500
Main Features
The FTB-500 runs Microsoft Windows XP Professional for Embedded 
Systems, and the ToolBox software provides you with a graphical, 
user-friendly interface for your testing applications. 

The interface is easy to access, whether you are using the touchscreen or a 
mouse and a keyboard.

ToolBox brings multitasking to field testing. You can perform different tests 
and work on tests results all at the same time, switching between 
applications simply by touching a button. 

The FTB-500 supports local control (via the ToolBox software) and remote 
control (through RS-232 or Ethernet TCP/IP—using SCPI commands or the 
provided LabVIEW drivers).
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Introducing the FTB-500
LED Panel Description
LED Panel Description 
The LED panel on the front of the unit provides you with the status of the 
FTB-500.

LED Definition

Power status (on, off or standby)

Battery status

Hard disk read or write operations

Laser indicator

Alarms for module applications

Pass/Fail status for module applications

Remote control activated
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Introducing the FTB-500
Function Buttons Description
Function Buttons Description
The FTB-500 is equipped with function buttons that give you access to 
features at all times. Below, you will find a table of the function buttons 
available and an overview of their purpose.

Button Purpose

Program Switcher: To switch among running applications. 
It is the equivalent of pressing the Alt-TAB key combination 
on a keyboard.
In emergency system tools mode, this button is used to 
access the mode, then switch between the available 
options.

Backlight: To set the display brightness level. For more 
information, see Changing the Backlight Level on page 54.

LOCAL 

Local: When you are working in remote control mode, to 
return to local control and settings. In emergency system 
tools mode, this button acts as the Enter key on a 
keyboard.
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Introducing the FTB-500
Hard-Drive Structure
Hard-Drive Structure
Your FTB-500 uses several hard-drive partitions for specific purposes.

Automatic Fan Speed Management
The FTB-500 will determine the most appropriate fan speed, depending on 
the power requirements and the type of modules you are using.

If the temperature keeps rising and reaches the limit: your FTB-500 will 
turn off to protect both the modules and the platform itself.

Partition Contents

C Operating system, EXFO applications

D User/EXFO data, EXFO application configurations

E Recovery utilities, FTB-500 backup (Windows Image)

CAUTION
Even if you are using another location to save your data, NEVER 
delete any of the default folders on any of the drives. Deleting 
folders such as the D:\ToolBox folder would prevent you from 
operating ToolBox and require you to contact EXFO’s technical 
support to have your platform function properly again.

IMPORTANT
Fan speed is always determined to cool down the most 
heat-generating modules.

CAUTION
Make sure to use protective covers over empty slots in your 
four-slot model to avoid overheating.
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Introducing the FTB-500
Conventions
Conventions
Before using the product described in this guide, you should understand 
the following conventions:

WARNING
Indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury. Do not proceed unless you 
understand and meet the required conditions.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury. Do not proceed unless you 
understand and meet the required conditions.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 
may result in component damage. Do not proceed unless you 
understand and meet the required conditions.

IMPORTANT
Refers to information about this product you should not overlook.
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2 Safety Information
WARNING

Do not install or terminate fibers while a light source is active. 
Never look directly into a live fiber and ensure that your eyes are 
protected at all times.

WARNING
The use of controls, adjustments and procedures, namely for 
operation and maintenance, other than those specified herein may 
result in hazardous radiation exposure or impair the protection 
provided by this unit.

IMPORTANT
When you see the following symbol on your unit , make sure 
that you refer to the instructions provided in your user 
documentation. Ensure that you understand and meet the required 
conditions before using your product.

IMPORTANT
Other safety instructions relevant for your product are located 
throughout this documentation, depending on the action to 
perform. Make sure to read them carefully when they apply to your 
situation.

CAUTION
When the laser safety light is flashing, at least one module is 
emitting an optical signal. Please check all modules, as it might not 
be the one you are currently using.
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Safety Information
Other Safety Symbols on Your Unit
Other Safety Symbols on Your Unit
One or more of the following symbols may also appear on your unit.

Symbol Meaning

Direct current

Alternating current

Both direct and alternating current

The unit is equipped with an earth (ground) terminal.

The unit is equipped with a protective conductor terminal.

The unit is equipped with a frame or chassis terminal.

On (Power)

Off (Power)
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Safety Information
Laser Safety Information
Laser Safety Information

Units with Built-In VFL

Your instrument is a Class 3R laser product in compliance with standards 
IEC 60825-1: 2007 and 21 CFR 1040.10, except for deviations pursuant to 
Laser Notice No. 50, dated June 24, 2007. Laser radiation is emitted at the 
output port. It is potentially harmful in direct intrabeam viewing.

The following label(s) indicate that the product contains a Class 3R source: 

The modules that you use with your unit may have different laser classes. 
Refer to the user guide or the online help of the different modules for the 
exact information.

Units without Built-In VFL

If your unit is not equipped with a VFL, the laser class of your unit depends 
on the modules that you use. Refer to the user guide or the online help of 
the different modules for the exact information.

Affixed to back panel of unit.
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Safety Information
Electrical Safety Information
Electrical Safety Information
The four-slot model uses an external AC/DC adapter connected to an 
international safety standard three-wire power cable.

The eight-slot model uses an international safety standard three-wire 
power cable. This cable serves as a ground when connected to an 
appropriate AC power outlet.

Note: If you need to ensure that the unit is completely turned off, disconnect the 
power cable and remove the batteries.

WARNING
 Insert the power cable plug into a power outlet with a 

protective ground contact. Do not use an extension cord 
without a protective conductor.

 Before turning on the unit, connect all grounding terminals, 
extension cords and devices to a protective ground via a ground 
socket. Any interruption of the protective grounding is a 
potential shock hazard and may cause personal injury. 
Whenever the ground protection is impaired, do not use the 
unit and secure it against any accidental operation.

 Do not tamper with the protective ground terminal.
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Safety Information
Electrical Safety Information
The color coding used in the electric cable depends on the cable. New 
plugs should meet the local safety requirements and include:

 adequate load-carrying capacity

 ground connection

 cable clamp

WARNING
 Use the external power supply indoors only.

 Position the unit so that the air can circulate freely around it. 

 Operation of any electrical instrument around flammable gases 
or fumes constitutes a major safety hazard.

 To avoid electrical shock, do not operate the unit if any part of 
the outer surface (covers, panels, etc.) is damaged.

 Only authorized personnel should carry out adjustments, 
maintenance or repair of opened units under voltage. A person 
qualified in first aid must also be present. Do not replace any 
components while power cable and battery are connected.

 (Eight-slot model only) Use only fuses with the required rated 
current and specified type (F6.3A L, 5 mm x 20 mm (0.197 in x 
0.787 in), fast-acting, low-breaking capacity, 250 V). Do not use 
repaired fuses or short-circuited fuse holders.

 Unless otherwise specified, all interfaces are intended for 
connection to Safety Extra Low Voltage (SELV) circuits only. 

 Capacitors inside the unit may be charged even if the unit has 
been disconnected from its electrical supply.
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Safety Information
Electrical Safety Information
WARNING
 Use only the listed and certified AC adapter/charger provided by 

EXFO with your unit (four-slot model). It provides reinforced 
insulation between primary and secondary, and is suitably rated 
for the country where the unit is sold.

 Use only accessories (such as the batteries, and fiber inspection 
probe) designed for your unit and approved by EXFO. For a 
complete list of accessories available for your unit, refer to its 
technical specifications.

 When you use the unit outdoors, ensure that it is protected 
from liquids, dust, direct sunlight, precipitation, and full wind 
pressure.

Equipment Ratings

Temperature

 Operation  unit powered by batteries: 0 °C to 50 °Ca (32 °F to 
122 °F)
(total max. of 50 W for modules in four-slot model)
(total max. of 85 W for modules in eight-slot model)

 unit connected to AC power:

 0 °C to 40 °C (32 °F to 104 °F)
(total max. of 100 W for modules 
in four-slot model)

 0 °C to 50 °C (32 °F to 122 °F)
(total max. of 200 W for modules 
in eight-slot model)

 Storage  unit: –40 °C to 70 °C (–40 °F to 158 °F)

Relative humidityb  unit:  95 % non-condensing

 AC adapter: 10 % to 80 % non-condensing
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Safety Information
Electrical Safety Information
Maximum operation altitude  2000 m (6562 ft) (unit connected to external power 
supply)

 5000 m (16405 ft) (unit operated from battery)

Pollution degree  2 (unit connected to external power supply)

 3 (unit operated from batteries)c

Overvoltage category  unit: I

 AC adapter: II

Measurement category Not rated for measurement categories II, III, or IV

Input powerd  unit (four slots): 24 V; 8 A

 AC adapter (four slots): 
100 - 240 V; 50/60 Hz; 4.8 A

 unit (eight slots): 100 - 240 V; 50/60 Hz; 4.8 A

a. With some modules, the maximum operation temperature is 40 °C (104 °F).
b. Measured in 0 °C to 31 °C (32 °F to 87.8 °F) range, decreasing linearly to 50 % at 40 °C (104 °F).
c. Equipment must be normally protected against exposure to direct sunlight, precipitation and full wind

pressure.
d. Not exceeding ± 10 % of the nominal voltage.

Equipment Ratings
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Safety Information
Electrical Safety Information
CAUTION
Use of voltages higher than those indicated on the label affixed to 
your unit may damage the unit. 

IMPORTANT
The operation and storage temperatures of some modules may 
differ from the temperatures specified for your platform. In this 
case, always ensure that you comply with the most restrictive 
conditions (either module or platform).
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3 Getting Started with Your 
FTB-500
Inserting and Removing Test Modules

To insert a module into the FTB-500:

1. Exit ToolBox and turn off your unit.

2. Position the FTB-500 so that its right panel is facing you.

3. Take the module and place it so that the connector pins are at the 
back, as explained and shown below.

CAUTION
Never insert or remove a module while the FTB-500 is turned on. 
This will result in immediate and irreparable damage to both the 
module and unit.

CAUTION
To avoid damaging your unit, use it only with modules approved by 
EXFO.

WARNING
When the laser safety LED ( ) is flashing on the FTB-500, at least 
one of your modules is emitting an optical signal. Please check all 
modules, as it might not be the one you are currently using.

CAUTION
Inserting a module upside down could result in permanent damage 
to the module, as the connector pins might be bent.
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Getting Started with Your FTB-500
Inserting and Removing Test Modules
 (4-slot model) identification sticker must be on left side and 
retaining screw hole under connector pins.

 (eight-slot model) identification sticker must be facing up and 
connector pins at the right of the retaining screw hole.

Protruding edges 
on right side

Identification sticker
on left side

Connector pins 
at the back

Retaining
screw hole
at the back

FTB-500 right panel

Protruding edges 
on bottom

Identification sticker
facing up

Connector 
pins at the 
back

Retaining screw
hole at the

back

FTB-500 right panel
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Getting Started with Your FTB-500
Inserting and Removing Test Modules
Note: If you are using larger or heavier modules, place them near the bottom of 
the unit as much as possible.

4. Insert the protruding edges of the module into the grooves of the 
receptacle’s module slot.

5. Push the module all the way to the back of the slot, until the retaining 
screw makes contact with the receptacle casing.

6. Place the FTB-500 so that its left panel is facing you.
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Getting Started with Your FTB-500
Inserting and Removing Test Modules
7. While applying slight pressure to the module, turn the retaining screw 
clockwise until it is tightened.

This will secure the module into its “seated” position.

Turn retaining screw knob 
clockwise

FTB-500 left panel
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Getting Started with Your FTB-500
Inserting and Removing Test Modules
8. If you are using a larger or heavier module, use a front module lock to 
hold them securely in place. Simply place the retaining part against the 
module, then screw in the holding pin.

When you turn on the unit, the startup sequence will automatically detect 
the module.
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Getting Started with Your FTB-500
Inserting and Removing Test Modules
To remove a module from the FTB-500:

1. Exit ToolBox and turn off your unit.

2. Position the FTB-500 so that the left panel is facing you.

3. Turn the retaining screw counterclockwise until it stops.

The module will be slowly released from the slot.

4. Place the FTB-500 so that the right panel is facing you.

Turn retaining screw knob(s) 
counterclockwise

FTB-500 left panel
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Getting Started with Your FTB-500
Inserting and Removing Test Modules
5. Hold the module by its sides or by the handle (NOT by the connector) 
and pull it out.

6. Cover empty slots with the supplied protective covers.

CAUTION
Failure to reinstall protective covers over empty slots will result in 
ventilation problems.
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Getting Started with Your FTB-500
Turning On the FTB-500
Turning On the FTB-500
To turn on the FTB-500: 

Hold down the On/Off button on the front panel. 

The unit beeps, the startup screen briefly appears and the unit starts.

Each time you start a new ToolBox session, the Modules window appears. 
This window will reflect the modules you are using.
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Getting Started with Your FTB-500
Turning On the FTB-500
Use this window to start single-module applications. The applications will 
change depending on the modules you have in your FTB-500. 

Note: The slot numbers are 0-3 for the four-slot model and 0-7 for the eight-slot 
model. The slots are identified on both sides of the unit.

Function 
tabs

Applications
specific to

selected
module

Modules
inserted in

the
platform

Battery level indicator
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Getting Started with Your FTB-500
Turning Off the FTB-500
Turning Off the FTB-500
There are several ways to turn off the unit, including the following:

 Standby: keeps the unit’s status information in memory (RAM). The 
next time you turn your unit on, you will quickly return to your work 
environment (running applications will still be running).This mode will 
take more battery power while the unit is off. 
 

 Hibernation: saves the unit’s status information that was in memory 
(RAM) to a special file on the disk. The next time you turn your unit on, 
this file will be used to ensure that you return to your work 
environment (running applications will still be running). The unit will 
take longer to start up than in Standby mode, but it requires less battery 
power when the unit is off. You can configure your unit to switch 
automatically from Standby to Hibernation mode after the specified 
delay.

 Shutdown: completely cuts power to the test modules and platform; 
the unit will perform a complete restart routine the next time you use 
it. You should perform a shutdown if you do not intend to use your unit 
for a week or more. 

After a shutdown, the unit will start in Toolbox or in the application you 
defined as the startup application.

Note: Should the unit ever stop responding, you can force a hardware reset by 
pressing and holding down the power button for more than 10 seconds.

By default, your unit will display the standard shutdown window from 
which you can select the desired shutdown mode. However, you can 
configure your unit to perform a different action when the power button is 
pressed.

You can also configure your unit to automatically restart when AC power 
comes back after the unit has turned off (emergency shutdown, standby, 
or hibernation modes) when battery level is too low.
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Getting Started with Your FTB-500
Turning Off the FTB-500
To turn off the unit:

1. Press and hold the On/Off button. 

OR

On the Windows taskbar, tap Start.

This will display the standard shutdown window, from which you have 
a choice of actions or shutdown modes.

2. Select Shutdown.

To define the behavior of the power button:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Power Options.
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Getting Started with Your FTB-500
Turning Off the FTB-500
4. Select the Advanced tab.

5. From the When I press the power button on my computer list, select 
the desired behavior (Ask me what to do option is selected by 
default).

6. Tap Apply to confirm the changes, and then OK to return to Control 
Panel.
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Getting Started with Your FTB-500
Turning Off the FTB-500
To configure your unit to automatically restart after AC power 
comes back:

1. From the main window, select the Tools tab.

2. Tap Platform Settings.

3. Select the Power on the unit when AC outlet is connected or after 
power outage box to enable the corresponding option.

OR

Clear the box if you prefer that your unit does not restart automatically 
after AC power comes back.

4. Tap OK to confirm the changes and return to the Tools tab.
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Getting Started with Your FTB-500
Grounding Your FTB-500
Grounding Your FTB-500
When you perform an outside plant test with modules such as the 
FTB-8100 or the FTB-8110, you have to ground your FTB-500 because it can 
be exposed to overvoltages from the telecommunication network.

Note: To ground your unit, you need a grounding wire (18AWG minimum) with a 
U shape terminal.

To ground your FTB-500:

1. Place the U shape terminal under the grounding stud’s screw head.

2. Screw the grounding stud tight.

WARNING
Not grounding your unit may cause serious injuries to 
communication network staff or other users.

Eight-slot modelFour-slot model
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Getting Started with Your FTB-500
Securing your FTB-500 Using the Kensington Lock
Securing your FTB-500 Using the Kensington 
Lock

Your FTB-500 is equipped with a Kensington lock to help you prevent theft.

To secure your unit:

Connect your lock to the security slot located at the back of your unit.

Four-slot model Eight-slot model
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Getting Started with Your FTB-500
Installing or Upgrading the Applications
Installing or Upgrading the Applications
All the necessary applications have been preinstalled and configured at the 
factory. However, you may have to upgrade some applications when new 
versions become available or to reinstall them. 

Note: All of your product packs have been placed on the D drive for reinstallation 
purposes if necessary.

Note: Only administrator-level users can install software under Windows XP.

Each time you purchase a new module, it could be a good idea to verify 
that the most recent Update Manager application is installed on your unit.

When updates are available for an application, you will need to download 
them from Internet, either directly on your unit or on a computer. The 
update files must be copied to the location that has been specified for the 
deployment packages in Update Manager.

IMPORTANT
If you ever need to reinstall Update Manager on your unit, ensure 
that: 

 The installation files for Update Manager remain on your unit. 
Otherwise, it will not be possible to install new versions of this 
application later.

 You choose the folder containing the Update Manager 
installation files carefully. If you move or rename this folder, you 
will have to manually browse for the modified folder when you 
want to install new versions of this application.
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Getting Started with Your FTB-500
Installing or Upgrading the Applications
For the installation or upgrade, you will need:

 an FTB-500 unit

 a computer equipped with a USB port; Windows must be installed on 
the computer 

 a USB memory key

Note: The computer and USB key are only necessary if you do not wish to 
download the files directly on your unit.

Note: For more information on the installation, refer to the Update Manager 
online help.

To update or reinstall Update Manager:

1. If necessary, retrieve the desired installation files from the Internet.

If you do not intend to download files directly on your unit, connect a 
USB memory key to one of the USB ports of the computer and copy the 
installation files to this USB key.

2. If it is not already done, turn on your unit. 

3. Exit Toolbox and the modules’ applications.

4. If you want to install Update Manager using the USB key, disconnect it 
from the computer and connect it to one of the USB ports of your unit. 

5. On your unit, create a folder on the Windows desktop.

6. Copy the installation files (from the USB key) to the newly created 
folder. 

7. From the newly created folder, tap the Setup.exe file to start the 
installation.

8. Follow the on-screen instructions.

9. When the installation is complete, simply disconnect the USB memory 
key.
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Getting Started with Your FTB-500
Installing or Upgrading the Applications
To install or upgrade the applications:

1. If necessary, retrieve the desired installation files from the Internet.

If you do not intend to download files directly on your unit, connect a 
USB memory key to one of the USB ports of the computer and copy the 
installation files to this USB key.

2. If it is not already done, turn on your unit. 

3. Exit Toolbox and the modules’ applications.

4. If you want to install or update applications using the USB key, 
disconnect it from the computer and connect it to one of the USB ports 
of your unit. 

5. Copy the installation files (from the USB key) to the folder containing 
the update and installation packages on your unit. By default, Update 
Manager will search for files at the root of the USB key. For more 
information, refer to the Update Manager online help.

6. On your unit, from Windows desktop, tap the Update Manager icon to 
start the corresponding application. For more information on how to 
install or upgrade applications, refer to the Update Manager online 
help.

7. When the installation is complete, simply disconnect the USB memory 
key.
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Getting Started with Your FTB-500
Accessing and Exiting ToolBox
Accessing and Exiting ToolBox 
Your FTB-500 comes out of the factory set to start automatically with 
ToolBox.

However, you might need to work with Windows, and can even set the 
system to start with Windows instead of ToolBox, as explained in 
Automating Application Startup on page 65.

To access ToolBox when in the Windows environment:

Double-tap the icon on your desktop. 

OR

In the Start menu, select Programs > EXFO > ToolBox.

To exit ToolBox:

Tap . 
FTB-500 39



Getting Started with Your FTB-500
Starting Module Applications
Starting Module Applications
Your modules can be configured and controlled form their dedicated 
applications in Toolbox.

To start a module application:

1. From the Modules tab, select the module to use.

It will turn blue to indicate that it is highlighted.

2. Under Module Applications, select an application, and then tap Start 
Application.

Selected module

Applications specific to selected module
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Getting Started with Your FTB-500
Installing EXFO LabVIEW Drivers
Installing EXFO LabVIEW Drivers
Before being able to work with EXFO LabVIEW drivers, you must install the 
following elements on your computer or on your FTB-500:

 National Instruments LabVIEW software and the corresponding 
patches. 

 EXFO LabVIEW drivers (including demo applications to help you get 
started with the drivers). 

For more information, see Working with EXFO LabVIEW Drivers on 
page 228

Note: Only administrator-level users can install software under Windows XP.

To install the LabVIEW software:

Follow the instructions provided with your LabVIEW installation CD.

To install the EXFO LabVIEW drivers:

1. Insert the installation CD in the CD-ROM drive.

2. Start the installation process as follows:

2a. On the Windows taskbar, click Start and select Run.

2b. In the Open box, locate Labview Drivers\setup.exe on the storage 
device where the drivers are located.

2c. Click OK to start the InstallShield Wizard and follow the on-screen 
instructions.

For easier use, the drivers will be installed in LabVIEW’s default 
instrument library folder:
C:\Program Files\National Instruments\LabVIEW 6\instr.lib\EXFO.
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Activating Software Options
Activating Software Options
The software options purchased at the same time as your unit have been 
activated for you already. However, if you purchase options afterwards, you 
will have to activate them yourself.

Before being able to activate options, you need to contact EXFO with the 
following information: 

 Purchase order number of the newly purchased options

 Module or platform serial number (depending on whether the software 
options were purchased for a module or the platform)

 Customer's name

 Customer’s company name

 Customer’s phone number

 Customer’s e-mail address

 Module or platform on which the option will be installed

You will receive a single key (.key) file with which you will be able to 
unlock all the new options that you have purchased.

IMPORTANT
If you want to activate software options for modules of the 
FTB-81xx Series or the FTB-85xx Series, refer to the user guide of 
your product for the specific activation instructions.

In all other cases, you can follow the instructions presented in this 
section.
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Getting Started with Your FTB-500
Activating Software Options
To activate the options for your unit:

1. Connect a USB memory key to one of the USB ports of your computer.

2. Copy the key file to the USB memory key.

3. Disconnect the USB key from the computer and connect it to your unit. 

4. Select the Tools tab, then Options Activation.
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Getting Started with Your FTB-500
Activating Software Options
5. In the Platform Options tab, use the Browse button to locate the key 
file that you want to use.

6. Press Activate.

The option indicator will turn into a green check mark to confirm that 
the option is now active.

7. Press OK to close the Option Activation window.

Note: At this point, if you have used a USB key to copy your key file, you can 
remove it as it is not required to use your new options.
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Activating Software Options
To activate software options for your module:

1. Connect a USB memory key to one of the USB ports of your computer.

2. Copy the key file to the USB memory key. 

3. Disconnect the USB key from the computer and connect it to your unit.

4. Select the Tools tab, then Options Activation.
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Getting Started with Your FTB-500
Activating Software Options
5. In the Module Options tab, use the Browse button to locate the key 
file that you want to use.

6. Press Activate.

The option indicator will turn into a green check mark to confirm that 
the option is now active.

Note: You can see the supported options for the module in the Options list.

7. Press OK to close the Option Activation window.

Note: At this point, if you have used a USB key to copy your key file, you can 
remove it as it is not required to use your new options.
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Installing Third-Party Software on Your 
FTB-500

Since your FTB-500 is equipped as a conventional laptop computer would 
be, you can install third-party software on it, provided that it is compatible 
with Microsoft Windows XP Professional. However, EXFO does not provide 
any support for the installation, use or troubleshooting of such third-party 
software. Should you need help, refer to the corresponding third-party 
software documentation or technical support.

Protecting your Unit with an Antivirus 
Software

Since each customer has different security standards and rules for their 
computers and test systems, EXFO does not provide an antivirus on the 
FTB-500. In this manner, you can apply your own standards and antivirus 
strategy once you receive your unit, as you can install third-party software 
on it, as you could on any standard laptop computer.
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4 Setting Up Your FTB-500
Positioning Your Unit

You can change the orientation of your unit with the bottom or back 
supports.

To position the unit using the supports:

Pull out the support pair that will provide you with the best viewing angle 
according to your situation.

IMPORTANT
The supports should always be used in order to ensure that the unit 
is stable during your tests and will not fall down to cause damage 
to the test components or injure you.

Four-slot model

There are two sets of stands on 
the back of the unit with different 
lengths. Select the one that 
provides you with the best angle.

Back
support

Bottom support

Eight-slot model
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Installing a Monitor
Installing a Monitor
Although the FTB-500 is equipped with a top-of-the line LCD, you might 
want to use an external monitor. The monitor must support the SVGA 
format.

Note: Use the Windows Control Panel to configure the display settings of your 
external monitor.

To install a monitor:

Connect the external monitor to the Video Out port, located on the left side 
of the unit.
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Calibrating the Touchscreen
The touchscreen simplifies and accelerates testing procedures by 
providing immediate access to commands. It detects the position of your 
finger or any other blunt pointing device, activating a command, function, 
or button. The FTB-500 comes equipped with a stylus located in the top 
right side of the unit.

When you receive your FTB-500, it will have been calibrated. However, if 
you are used to work at a certain angle that could change the location of 
the pointing device versus what the sensor detects, of if you feel that the 
screen does not behave as you want, you can calibrate it again.

Note: If you are having trouble accessing the touchscreen calibration feature 
because the touchscreen is not behaving as expected, use a USB mouse. 
See Installing a Pointing Device on page 60 for details.

Note: To better see what is on the screen, you can also change the brightness of 
the screen backlight, as explained in Changing the Backlight Level on 
page 54.

IMPORTANT
As it is the case for any computer, you can change the screen 
resolution in the Windows Control Panel. However, be aware that 
this will affect the performance and accuracy of the touchscreen. 
The optimized resolution for using your touchscreen is of 800 x 600.
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Calibrating the Touchscreen
To calibrate the touchscreen:

1. Select the Tools tab.

2. Select Touch Screen Calibration.

3. Follow the instruction on-screen to proceed with the calibration 
procedure. 

Note: If you do not touch the screen within a set period of time, the calibration 
procedure is aborted and you are returned to ToolBox.

4. Once the calibration is complete, this window disappears and you are 
returned to ToolBox.
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Adjusting the Monitor Settings
Adjusting the Monitor Settings
Different work environments call for different monitor settings which can 
be set according to your needs.

To adjust the monitor settings:

1. Select the Tools tab, then Platform Settings.

2. Adjust the brightness settings as needed.

3. Tap OK exit the window.
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Changing the Backlight Level
Changing the Backlight Level
The backlight has five different brightness levels.

To change the backlight level:

Press the backlight button repeatedly to switch between the available 
levels.

Note: For better autonomy, select a lower backlight level which uses less battery 
power.
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Installing a Hardware Keyboard
Installing a Hardware Keyboard
When you are required to enter alphanumeric data, an on-screen keyboard 
will be displayed. However, you can also use a hardware keyboard. 

To install an external keyboard on your FTB-500:

Connect the keyboard to a USB port, located on the right side or on the 
front of the unit.

Note: It is not necessary to turn off the FTB-500 before connecting the keyboard. 
The software will automatically detect its presence.

Although your external keyboard is automatically recognized and 
immediately usable, you might not benefit from all its special features 
unless you install the proprietary driver that usually comes with it. To install 
the proprietary driver, refer to the user guide that comes with your unit. Of 
course, the keyboard that comes as an option with your FTB-500 is fully 
functional.
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Using the On-Screen (Virtual) Keyboard
Your unit is equipped with an on-screen keyboard that supports 
multilingual features. This keyboard functions according to the keyboard 
settings of Windows. It works with all applications on your unit. 

However, if you prefer, you can enable an on-screen keyboard that has 
been specially designed for the module applications (when the 
applications support it). For more information on how to enable this 
keyboard, see Using the Module On-Screen (Virtual) Keyboard on page 56.

To use the unit on-screen keyboard:

1. Select the location where you want to enter text.

2. Tap the virtual keyboard icon on the lower-right part of the screen (over 
the clock).

3. Enter the data as required.

4. Exit the location when you are done entering data.

Using the Module On-Screen (Virtual) 
Keyboard

Instead of the unit on-screen keyboard, you can also use the virtual 
keyboard that originally came with your modules. That keyboard can be in 
either QWERTY, AZERTY or ABCDEF format.

To install a hardware keyboard, see Installing a Hardware Keyboard on 
page 55.
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Using the Module On-Screen (Virtual) Keyboard
To activate the module on-screen keyboard:

1. Select the Tools tab, then Platform Settings.

2. Select Use application integrated virtual keyboard, then select a 
layout, either AZERTY, QWERTY or ABCDEF.

3. Tap OK to confirm your selection, or Cancel to exit the window.

Note: To use the keyboard once it is activated, simply type in the data you want 
and tap either OK or Return to enter it. Tap Cancel to return to your 
application without typing anything. When you are in an application that 
uses the module virtual keyboard, you can activate it simply by selecting the 
box in which you want to enter data.
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Customizing the On-Screen Keyboard
You can customize the appearance and behavior of the (unit) on-screen 
keyboard. For more information on the various parameters that you can 
set, refer to the on-screen keyboard online help.

For information on how to switch from one of the available languages to 
another, see Selecting the Language of Operation on page 69.

To customize the appearance and behavior of the on-screen 
keyboard:

1. Minimize the Toolbox window.

2. On the Windows taskbar, tap Start, then select All Programs > 
Touch-It Virtual Keyboard >Setup.

3. Configure the keyboard according to your needs.

Note: You can access the online help related to the keyboard options by tapping 
the Help button.

4. When you have finished, tap Close.
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Right-Clicking with the Touchscreen
If you are used to work with a mouse, you may find it useful to be able to 
perform a right-click on your touchscreen.

To right-click with the touchscreen:

From the location where you want to right-click, using the stylus or any 
blunt pointing device, press the screen for a few seconds until the shortcut 
menu appears.

If you want to hide the shortcut menu without performing any action, 
simply tap anywhere outside the menu.
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Installing a Pointing Device
A touchscreen offers many advantages when working in applications that 
have been specially designed for it (such as the EXFO test applications).

However, for applications such as spreadsheets, word processors, etc., a 
touchscreen might not be the most efficient pointing device. The FTB-500 
was designed so that you can add external pointing devices (mouse, 
trackball, etc.).

To install a USB pointing device on your FTB-500:

Connect the pointing device to a USB port, located on the right side or on 
the front of the unit. 

Although your external pointing device is automatically recognized and 
immediately usable, you might not benefit from all its special features 
unless you install the proprietary driver that usually comes with it. 

To install the proprietary driver, refer to the user guide that comes with your 
device.

Note: It is not necessary to turn off the FTB-500 before connecting a USB pointing 
device. The software will automatically detect it.
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Installing a Headset or Speakers
The FTB-500 comes with an internal speaker for audible feedback, but 
there are times when you might want to use more powerful speakers. 
Other types of environment may warrant the use of a headset instead of 
the external speaker. You can use any commercially available headset or 
speakers having a 3.5 mm connector.

To connect a headset or speakers to your FTB-500:

Connect the external speakers or the desired headset in the Audio Out port 
located on the right side of the unit.
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Installing a Microphone
On top of being a multitasking test platform, the FTB-500 is a portable 
multimedia computer. From the Windows environment, it can use 
off-the-shelf third party applications that require a microphone. With these 
applications, you can use an external microphone. You can use any 
commercially available microphone having a 3.5 mm connector.

To use an external microphone:

Simply connect it to the Audio In port, located on the right side of the unit.
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Installing a Printer
If you need to print reports directly from your FTB-500, you can install an 
external printer.

To install a USB printer on your FTB-500:

1. Follow the printer’s manufacturer instructions regarding the 
installation of required drivers or software.

2. Connect the printer to a USB port, located on the right side or on the 
front of the unit. 
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Installing an Express Card
The Express card slot found in the FTB-500 supports 34-mm format card, 
such as Wi-Fi cards, or memory cards.

To install an Express card:

1. Turn on the FTB-500.

2. Insert the Express card in the Express card slot, located on the left side 
of the unit. The Express card is automatically recognized.
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Automating Application Startup
You can have selected applications automatically start upon starting the 
FTB-500 up. This saves you time, as you do not need to ensure that they are 
already running before starting your tests.

To set some applications to start automatically at startup:

1. From the main window, tap Setup.
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2. Select the Application Startup tab.

3. Select the items you want to start at startup by checking the 
corresponding boxes.

4. Tap OK to use the new settings. Tap Cancel to exit without using the 
new settings.

Note: The new settings will only apply the next time your start your unit.
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Selecting the FIP Startup Application
Your unit supports both the fiber inspection probes (FIP) of the FIP-400 and 
FIP-400B series. By default, the unit prompts you to select the application 
corresponding to the FIP with which you want to work (FIP-400 or 
FIP-400B). If you prefer, you can configure the unit to always start your 
favorite application directly instead.

To select the FIP startup application:

1. From the main window, tap Setup.
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2. Select the Application Startup tab.

3. From the When I tap the Probe button list, select the desired 
behavior. If you want to be prompted each time to confirm the 
application to use, select the Ask me what to do option.

Note: If the list is not available, it means that the ConnectorMax2 application is 
not installed on your unit. In this case, the ConnectorMax application will 
start automatically, enabling you to work with the probes of the FIP-400 
series. If you also wish to work with probes of the FIP-400B series, you will 
need to install the most recent ConnectorMax kit.

4. Tap OK to use the new settings. Tap Cancel to exit without using the 
new settings.

Your changes are automatically saved.
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Selecting the Language of Operation

Note: Only administrator-level users can modify the language of operation.

You may display the user interface in one of the available languages.

When you change the interface language, the corresponding keyboard is 
not automatically added to the list of available keyboards. You must add 
the desired keyboard separately if you want to enter text in a specific 
language (both on-screen or “real” keyboards). Once the keyboards are 
added, you can switch easily from one input language to another.

Values are kept in memory even when you turn the unit off.

IMPORTANT
The keyboards that you add will not be available from the logon 
window. 

To avoid problems, when you define or modify passwords, EXFO 
recommends that you always use the keyboard corresponding to 
the language of the unit at time of purchase. Otherwise, you might 
not be able to log on to your user account (unsupported characters, 
different keyboard layout, etc.)
FTB-500 69



Setting Up Your FTB-500
Selecting the Language of Operation
To select a new interface language:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Regional and Language Options.
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4. Select the Languages tab.

5. From the Language used in menus and dialogs list, select the 
desired language.

6. To ensure that all applications are displayed correctly, configure the 
language for non-Unicode programs as follows:

6a. Select the Advanced tab.
FTB-500 71



Setting Up Your FTB-500
Selecting the Language of Operation
6b. Under Language for non-Unicode programs, select the desired 
language.

7. Press Apply to confirm the changes. When the application displays a 
message indicating that the new language will be effective at next 
logon, tap OK. 

8. Tap OK to return to the Control Panel window.
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To add new input languages:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Regional and Language Options.
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4. Select the Languages tab.

5. Under Text services and input languages, tap Details.
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6. Under Installed services, tap Add.

7. From the Input language list, select the desired language.

8. If necessary, from the Keyboard layout/IME list, select the desired 
option.

9. Tap OK to confirm.

10. Repeat steps 6 to 9 for all the languages that you want to add.

11. Tap Apply to confirm the changes, and then OK to return to the 
Control Panel window.

The added keyboards will be available at your next logon. You will then 
able to switch from one input language to another.
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To switch from one of the available input languages to another:

1. Tap  to display the on-screen keyboard.

2. From the on-screen keyboard, tap  to display the list of available 
input languages.

3. From the list of languages, select the desired one.

You are now ready to start entering text in the selected input language.

Note: Modifying the input language does not modify the language of the 
interface.
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Adjusting the Date, Time and Time Zone

Note: Only administrator-level users can adjust the date, time and time zone.

The current date and time are displayed at the bottom of the main window. 
When saving results, the unit also saves the corresponding date and time.

Note: Modifying date and time settings will affect some of the Windows XP 
settings.

To adjust the date and time:

1. From the main window, select the Tools tab.

2. Tap Control Panel.
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3. Tap Date and Time.

4. Select the Date & Time tab.

5. Modify the settings according to your needs.

6. Tap Apply to confirm the changes, and then OK to return to the 
Control Panel window.
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To change the time zone:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Date and Time.

4. Select the Time Zone tab.

5. Modify the settings according to your needs.

6. Tap Apply to confirm the changes, and then OK to return to the 
Control Panel window.
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Configuring the Power Management Options

Note: Only administrator-level users can configure the power management 
options. These options can only be modified for administrator-level 
accounts.

To get the optimum performance out of your FTB-500, your unit comes 
with predefined sets of parameters (schemes) to manage power.

When you do not use the unit for a while, the display and hard disks may 
be turned off to save power. You can also configure the unit to go into 
standby or hibernation mode after the specified duration has expired 
(see Turning Off the FTB-500 on page 30).

For all of these actions, you can set idle durations for AC adapter/charger 
and battery operation. The values that you set are kept in memory even 
when you turn the unit off.

Note: When the backlight is turned off, the unit operation is not interrupted. Press 
any key or touch anywhere on the screen to return to normal operation.

The table below indicates the default values that are included in each of 
the predefined power schemes.

Power Scheme Action When AC is 
connected

Running on 
batteries

Portable/Laptop
(selected by 
default)

Turn off monitor Never Never

Turn off hard disks Never After 10 minutes

System standby Never Never

System hibernates Never Never
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You can either modify one of the existing power schemes or create one 
(based on an existing power scheme).

Standard Turn off monitor Never After 5 minutes

Turn off hard disks Never After 10 minutes

System standby Never After 15 minutes

System hibernates Never After 30 minutes

Always On Turn off monitor Never Never

Turn off hard disks Never Never

System standby Never Never

System hibernates Never Never

Max Battery Turn off monitor After 15 minutes After 5 minutes

Turn off hard disks Never After 10 minutes

System standby After 30 minutes After 15 minutes

System hibernates After 45 minutes After 30 minutes

WARNING
Your unit has been designed to manage power as well as battery 
alarms automatically. Never modify the parameters that appear on 
the Alarms tab. Doing so WILL prevent the unit from working 
properly.

Power Scheme Action When AC is 
connected

Running on 
batteries
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To select a power scheme:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Power Options.
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4. From the Power Schemes list, select the desired predefined set of 
parameters.

5. Tap Apply to confirm the changes, and then OK to return to the 
Control Panel window.
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To modify a power scheme:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Power Options.

4. From the Power Schemes list, select the predefined set of parameters 
that you want to modify or on which you want to base your new 
scheme.

5. Modify the parameters to your needs.
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6. Tap Save As.

 If you want to modify the existing power scheme, keep the name 
as is, and then tap OK.

OR

 If you prefer to create a new power scheme, enter a new name, 
and then tap OK.

7. Tap Apply to confirm the changes, and then OK to return to the 
Control Panel window.
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Setting ToolBox Options
You can specify how ToolBox behaves when the application is started, 
minimized or closed.

To set the ToolBox options:

1. From the main window, tap Setup.

2. Select the ToolBox tab.
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3. Select one or more option that corresponds to your needs:

 Hide ToolBox in the system tray when minimized: If this option is 
selected, the ToolBox icon appears in the system tray (where the 
clock is located) when you minimize the window.

 Start ToolBox in the system tray: If this option is selected, 
ToolBox is automatically started, then minimized to the system 
tray.

 Display the system shutdown dialog when exiting ToolBox: If 
this option is selected, the standard system Shut Down window 
appears to let you shut down the unit directly instead of closing the 
ToolBox application, then shutting down the unit from Windows. 
For more information on the different ways to turn off your unit, 
see Turning Off the FTB-500 on page 30.

Setting Communication Parameters
For information on how to configure your FTB-500 for remote control, see 
Preparing for Automation on page 175.
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5 Working with Your Unit
Accessing Platform-Related Tools from 
ToolBox

Tools for your platform include remote control settings, battery 
management, Windows Control Panel, and platform-specific settings.

You can display the list of applications either in Tiles or List mode, 
depending on your preference.

To access the platform tools:

1. Select the Tools tab.

2. Select the desired tool.

3. Tap Start Application.

For more information on each tool, see the corresponding sections.

To switch between the display modes
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Accessing Other Tools
Your unit comes with various tools that can help you better analyze or 
manage your data.

You have also access to free tools such as Wireshark to help you 
troubleshoot networks. For more information, refer to the online help 
provided with these tools. 

You can display the list of applications either in Tiles or List mode, 
depending on your preference.

To access the applications:

1. Tap the Applications tab.

2. Select the application that you want to start.

3. Tap Start Application.

To switch between the display modes
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Printing Documents
You can print documents and images directly from your unit by using either 
the PDFCreator (for PDF files) or an external printer (for printing on paper). 

You can view the PDF files from your unit, using the SumatraPDF reader. 
For more information, see Viewing PDF Files on page 94.

To print on an external printer, you must connect the printer to your unit 
and install the required software and drivers provided by the manufacturer 
of the printer (see Installing a Printer on page 63). 

If you need more flexibility and a greater choice of report types, using a 
USB memory key, you can also transfer result files to a computer onto 
which applications such as EXFO FastReporter2 are installed.

Note: Some applications may not offer print functions.
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To print documents:

1. Open a Web browser as follows:

1a. Minimize the ToolBox window.

1b. On the Windows taskbar, tap Start, then tap Internet Explorer to 
open the browser.

2. Select the document that you want to print as follows:

2a. From the menu, select File > Open.

2b. Tap Browse to locate the file that you want to open.

2c. Tap Open to load the file in Internet Explorer.

2d. Tap OK to confirm.

3. From the menu, select File > Print.

4. From the General tab, select the desired printer (PDFCreator by 
default).

5. If necessary, tap Preferences to adjust the parameters to your needs.

Note: If you selected an external printer, you can save the whole set of 
preferences for future use with the Save As button.
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6. Tap Print to start the printing process.

7. If you selected PDFCreator, proceed as follows:

7a. Enter the desired information.

7b. Tap Save.

7c. Specify a location and a file name and tap Save. 
If you have selected the option to view the PDF file after its 
creation, the SumatraPDF reader will display the new file.

7d. If necessary, tap  to close the SumatraPDF window.

8. Tap  to close Internet Explorer and return to Windows desktop.

To view the PDF file
immediately after its

creation
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Viewing PDF Files
You can view PDF files directly from your unit using the SumatraPDF 
reader. For more information on the available features for this reader, refer 
to the SumatraPDF online help.

To view PDF files:

1. Minimize the ToolBox window.

2. From Windows, open Windows Explorer.

3. Browse through the folders to find the desired PDF file.

4. Tap the file.

5. The file opens automatically in the SumatraPDF application.

Note: You can access the online help directly from the Help menu of the 
SumatraPDF application. You will need a connection to the Internet to view 
the online help.

CAUTION
DO NOT update the SumatraPDF reader. Otherwise, you will lose the 
custom version prepared by EXFO for your unit. The application 
may no longer function properly. If you updated the SumatraPDF 
reader by mistake, see Solving Common Problems on page 263.
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Taking Screen Captures
You can take captures of what is displayed on your screen, directly from 
your unit. This could be useful for troubleshooting when you need another 
person to have a look at a specific configuration or problem. You could also 
use this tool for training purposes. If you want to capture images of the 
fibers that you examine with the fiber inspection probe, you can use the 
capture feature of the probe instead.

To take screen captures:

1. From the floating toolbar, tap the  button to send the image to the 
clipboard.

2. Minimize the Toolbox window.

3. On the Windows taskbar, tap Start, then select All Programs > 
Accessories >Paint.

4. Paste the image, and then save it.

5. Close Paint, and then return to TooBox.
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Browsing the Web 
You can browse the Web directly from your unit, provided that you have 
access to an Internet connection. 

For more information on how to connect to the Internet using a 3G USB 
modem key, see Accessing the Internet with a 3G USB Modem Key on 
page 97.

To browse the Web:

1. Open a Web browser as follows:

1a. Minimize the ToolBox window.

1b. On the Windows desktop, tap the Internet Explorer icon to open 
the browser.

2. Enter the desired Web address in the address bar and tap the

 button (located at the right of the address bar) to start browsing.

3. Close the window to return to Windows desktop.
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Accessing the Internet with a 3G USB Modem 
Key

Note: Only administrator-level users can install software under Windows XP 
However, when the installation is complete, all users will have the 
possibility to access the Internet with a USB modem key.

Your can connect an optional 3G USB modem key to your unit to have a 
wireless access to the Internet.

When you receive your modem key, it contains no Subscriber Identity 
Module (SIM) card. This means that you will need to:

 Purchase a compatible and unlocked SIM card from a provider offering 
3G services. If you need more information on the 3G coverage in your 
area, contact your regional sales representative.

 Have the card activated (you must subscribe to a package of mobile 
services). 

 Insert the card in the modem key. 

The very first time you connect a USB modem key to your unit, the AirCard 
Watcher application will be installed automatically on your unit. You will 
use this application to establish a connection with the mobile network 
whenever you want to work with your USB modem key. You only need to 
install this application once.
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To upgrade your unit to the latest System Upgrade and Platform 
components:

1. If necessary, turn on your unit.

2. Retrieve the latest System Upgrade and Platform kits:

2a. From your computer or your unit, open a Web browser and go to 
www.exfo.com.

2b. Log on to your My EXFO account. 

2c. Under FTB-500, find the System Upgrade and Platform kits. If you 
need information on how to download the kits, refer to the 
Readme files provided with the kits.

IMPORTANT
 Only the Sierra Wireless 319U keys provided by EXFO are 

supported on your unit.

 Before using the USB modem key for the first time, you must 
install the most recent System Upgrade and Platform kits for 
your unit. To do this, you will need a standard USB memory key 
and a computer with an Internet access. You can also retrieve 
the kits directly from your unit, but you will need an Internet 
access (other that the one that would be provided by the 3G 
USB modem key).
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3. Install the retrieved kits on your unit:

3a. Install the System Upgrade. For more information, refer to the 
installation procedure provided with the kit.

3b. Once the installation of the System Upgrade is complete, install 
the Platform kit on your unit. For more information, refer to the 
Readme file provided with the kit.

Note: At this point, if you have used a USB memory key to transfer the installation 
files to your unit, you can remove it.

You are now ready to install the AirCard Watcher application as explained 
hereafter.

To install the AirCard Watcher application on your unit:

1. If necessary, turn on your unit and wait for the startup sequence to 
complete.

2. If necessary, insert the SIM card into the USB modem key. For more 
information, refer to the documentation that came with your modem 
key.

3. Connect the USB modem key to one of the USB ports of your unit. 

The installation of the AirCard Watcher application will start 
automatically. 

IMPORTANT
Always turn your unit on before connecting the USB modem key to 
it. Otherwise, the USB modem may not be detected properly. 
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4. Follow the on-screen instructions. 

You will know that the installation is complete when the AirCard 
Watcher application starts.

5. Close the AirCard Watcher application.

6. Disconnect the USB modem key from your unit.

7. Reconnect the USB modem key to your unit so that it can be detected 
properly.

All users are now ready to start working with the USB modem key as 
explained hereafter. 

To work with a 3G USB modem key:

1. If necessary, turn on your unit and wait for the startup sequence to 
complete.

2. If necessary, insert the SIM card into the USB modem key. For more 
information, refer to the documentation that came with your modem 
key.

3. If necessary, connect the USB modem key to one of the USB ports of 
your unit. 

IMPORTANT
Always turn your unit on before connecting the USB modem key to 
it. Otherwise, the USB modem may not be detected properly. 
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4. From the Windows desktop, tap the AirCard Watcher icon to start the 
application.

5. Once the AirCard Watcher application starts, tap Connect to establish a 
connection with the mobile network.

As soon as the connection is established, you are ready to browse the 
Web. 

Note: If you want to customize the behavior and appearance of the AirCard 
Watcher application, refer to the online help provided with the application 
(available by tapping ? from the toolbar).

Note: The application will display a warning message if no SIM card has been 
inserted in the USB modem key.

Note: Depending on the package that you have purchased with your service 
provider and the type of network, you may have to set specific parameters. 
If you are not sure on how to proceed or need more information about the 
configuration, see with your service provider.

6. When you have finished working, tap Disconnect from the AirCard 
Watcher application, and then remove the USB modem key from your 
unit.
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Retrieving the GPS Location of Your Unit
With the optional GPS USB key and the provided GPS utility, you can 
retrieve the last known latitude and longitude coordinates of your unit. 

In addition to viewing the GPS information on-screen, you can copy it to 
the Clipboard in two formats: a text string or a URL link. The text string 
contains the GPS coordinates as well as a date and time stamp. Once the 
information is in the Clipboard, you can paste it to any document or test 
report (in editable sections). If your unit is connected to the Internet, you 
can even directly paste the URL link to a Web browser to locate your unit 
on a map.

Note: Only administrator-level users can install software under Windows XP.

IMPORTANT
 Only the Canmore GT-730F(L) keys provided by EXFO are 

supported on your unit.

 Before using the GPS USB key for the first time, you must install 
the most recent System Upgrade and Platform kits for your unit. 
To do this, you will need a standard USB memory key and a 
computer with an Internet access. You can also retrieve the kits 
directly from your unit, but you will need an Internet access.
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To upgrade your unit to the latest System Upgrade and Platform 
components:

1. If necessary, turn on your unit.

2. Retrieve the latest System Upgrade and Platform kits:

2a. From your computer or your unit, open a Web browser and go to 
www.exfo.com.

2b. Log on to your My EXFO account. 

2c. Under FTB-500, find the System Upgrade and Platform kits. If you 
need information on how to download the kits, refer to the 
Readme files provided with the kits.

3. Install the retrieved kits on your unit:

3a. Install the System Upgrade. For more information, refer to the 
installation procedure provided with the kit.

3b. Once the installation of the System Upgrade is complete, install 
the Platform kit on your unit. For more information, refer to the 
Readme file provided with the kit.

All users are now ready to start working with the GPS USB key as explained 
hereafter. 

Note: At this point, if you have used a USB memory key to transfer the installation 
files to your unit, you can remove it.
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To retrieve the GPS location of your unit:

1. If necessary, turn on your unit and wait for the startup sequence to 
complete.

2. Ensure that the GPS USB key is connected to your unit.

3. From Toolbox, select the Applications tab, then tap GPS Coordinates 
Viewer.

IMPORTANT
Always turn your unit on before connecting the GPS USB key to it. 
Otherwise, the GPS key may not be detected properly. 
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The GPS coordinates are displayed.

Note: As this is the case with any other GPS device, you may have to wait a few 
minutes to get a valid GPS signal.

 Tap Copy Coordinates to send the displayed information to the 
Clipboard as a text string.

 Tap Copy Hyperlink to send the displayed information to the 
Clipboard as a URL link.

4. When your work is finished, tap  to close the utility.
FTB-500 105





6 Using the Optional Built-In 
Power Meter and VFL 

The FTB-500 can be equipped with an optical power meter to measure 
absolute power (dBm or W) or insertion loss (dB). The power meter can 
detect modulated signals (1 kHz, 2 kHz, and 270 Hz).

The FTB-500 can also include a visual fault locator (VFL) to inspect or 
identify fibers.

IMPORTANT
If you intend to take measurements with a very low power level, 
make sure that your testing conditions are optimal to ensure the 
best results (for example, do not use the VFL, make sure that the 
other modules in your platform are not performing measurements 
and that their internal parts are not moving, etc.).
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Accessing the Built-In Power Meter
To access the built-in power meter:

From Toolbox, tap Optical Power Meter and VFL.

Note: Some buttons are not displayed when you first access the Power Meter 
application, but will be displayed after you tap Add for the first time or after 
you open a file.
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Below is a description of the Power Meter buttons and functions.

Selected wavelength

To switch between available
power meter wavelengths

To access reference mode

Measured power or loss
Fail values appear in red (when option is

selected.)

To switch between dB, dBm
and W as measurement

units

Reference value (when in
reference mode)

To store a reading to the
Measurements window

Pass/Fail status icon (displayed 
only when option is selected.)

To activate VFL and 
changes VFL mode

To perform an offset
nulling
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Nulling Offsets
Temperature and humidity variations affect the performance of electronic 
circuits and optical detectors, which can offset measurement results. To 
compensate for this offset, the unit is equipped with an offset nulling 
function.

Your unit has been designed not to require offset nulling under normal 
operation, but you should perform it whenever environmental conditions 
change significantly or when measuring very low power values.

To perform an offset nulling:

1. Tighten the protective cap on the power meter port.

2. From the Instrument View tab, tap Offset Nulling.

The nulling process takes approximately 5 seconds.

IMPORTANT
Light must not reach the detector when nulling offsets. Always use 
an EUI or protective screw cap. Do not use a soft rubber cover.
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Setting Thresholds and Correction Factors
You can define thresholds to specify acceptable power or loss values for 
each wavelength. Thresholds are usually supplied by system 
manufacturers and depend on the system deployed.

A power measurement (in dBm) will be considered as “Fail” when its 
value is lower than the defined absolute power threshold. 

A loss measurement (in dB) will be considered as “Fail” when its value 
is greater than the insertion loss threshold.

When the measurement status is “Pass”:

 The value is displayed in black and the  symbol appears next to 
it, both in the Instrument View tab and on the Measurements list. 

 In reports, the value is displayed in black and the Status column 
shows a check mark.

When the measurement status is “Fail”:

 The value is displayed in red and the  symbol appears next to it, 
both in the Instrument View tab and on the Measurements list. 

 In reports, the value is displayed in black and the Status column 
shows an X.

You must select the pass/fail status feature for the application to take 
into account the defined thresholds and display the appropriate status 
icons. By default, this feature is not selected.
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You may apply a correction factor (CF) to measured power to compensate 
for inaccuracies or drifts. You should change the CF after performing an 
offset nulling.

where:

Powercorrected = the corrected power value

Powermeasured = the measured power value

CF = the correction factor

For each favorite wavelength, the CF is set to 1.00 at the factory (even if 
the unit indicates “----”), but allowed values range between 0.85 and 
1.15.

Note: Some other products express the CF in dB, so the CF would be added to 
measured power.

IMPORTANT
If you revert to factory settings, you will erase all your thresholds 
and correction factors. The pass/fail status feature will be disabled 
automatically.

Powercorrected Powermeasured CF=
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To set thresholds or correction factors:

1. On the button bar, tap Setup.

2. From the Thresholds list, select the wavelength for which you want to 
set a threshold or a correction factor.

3. If desired, select Apply thresholds (Pass/Fail status) if you want the 
application to identify the pass and fail values using visual clues, and 
activate the pass/fail LED on your unit. 

Wavelength list

Thresholds list (dB, dBm, W)
for each wavelength

Correction factor for each 
wavelength

To revert to 
default values

To display pass/fail
status icons and

indicators
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4. Tap Edit. 

5. Modify the thresholds or correction factor for the selected wavelength.

6. Tap OK to close the dialog box and confirm the new values, then tap 
OK to exit the window.
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Setting Reference Values on Your Power Meter
In Reference mode, your unit displays the loss created by the fiber under 
test only, since it subtracts a reference value from the measured power.

You can set a different reference value for each wavelength. A reference 
value remains in memory until a new one is stored at the same 
wavelength.

To set reference values to use in Reference mode:

1. Check your fibers and clean them properly.

2. Using the proper adapter and test jumpers, connect a light source to 
your power meter.

3. From the Instrument View tab, select the wavelength in the list. 
Activate the source at the same wavelength.

4. Tap Reference to save the current power value as the new reference. It 
will appear on the upper-right corner of the data display.

Wavelength list
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Measuring Power or Loss 
Measuring absolute power or link (insertion) loss is done the same way, 
except for the referencing step. You can take power or loss measurements 
and save them for further analysis.

To perform power or loss measurements:

1. If necessary, perform an offset nulling (see Nulling Offsets on 
page 110).

2. Check your fibers and clean them properly.

3. For loss measurements, reference your power meter to a light source 
(see Setting Reference Values on Your Power Meter on page 115), then 
deactivate the light source.

4. If you have used a single reference patchcord, disconnect it from the 
power meter port only, then attach a second reference patchcord to 
the power meter.

OR

If you have used two reference patchcords, disconnect both of them at 
the bulkhead.
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5. Using bulkhead adapters or the system patch panels, connect a fiber 
under test to reference patchcord attached to the light source and 
power meter.

6. From the Instrument View tab, use the list to select a wavelength. 
Activate the source at the same wavelength.

7. Tap Add to transfer the displayed values to the Measurements list.

8. Repeat the procedure for other wavelengths.

9. Once your work is complete, tap Save.

IMPORTANT
If you specify a name that already exists, the original file will be 
overwritten and only the new file will be available.

Wavelength list
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To view and edit power or loss measurements:

1. Select the Measurements tab. All your measurements are displayed in 
the order they were performed.

2. Tap Rename to rename the fiber, tap Delete to remove the selected 
value from the list.

3. Once your work is complete, tap Save.

Note: If you tap Add while using another measurement unit, you will have to save 
previous values first.

To change the fiber name

Fiber name

To delete the selected row from the table

Wavelength at which power or loss
was measured

Loss measurement (in dB) or power 
measurement (in dBm)

Average power
or loss measured

per wavelength

Reference power (in dBm); appears only 
when measuring loss (in dB).

Measurement not
acceptable according
to defined threshold
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Opening Results Files
You can open results files that are stored on your unit or on a USB memory 
key. If you need more flexibility and a greater choice of report types, you 
can also transfer results files to a computer onto which applications such 
as EXFO FastReporter2 are installed.

To open results files:

1. From the button bar, tap Open.

2. If necessary, change the location from which the file should be 
opened.
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3. From the given list of files, select the file to open.

4. Confirm with Open.

If you have already performed power measurements, but not saved 
them, the application will prompt you to save your work. You must 
either save or discard the unsaved measurements before being able to 
open a file.

5. To view the reopened file, go to the Measurements tab. The power or 
loss measurements are displayed on the results list.
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Clearing Measurements from the Display
When measurements do not meet your requirements, you can clear the 
display and start over.

Note: Clearing measurements from the display does not delete them from the 
disk (if they were saved previously).

To clear power measurements:

1. From the button bar, tap Close.

OR

From the Measurements tab, tap Clear All.

If you have not saved the measurements already, the application will 
prompt you to save your work.

2. Select Yes to save the file. 
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Adding Information to Your Results
A report is available to keep notes on the measurements, the location of 
the tested fiber, the type of job performed, and general comments. This 
information will be saved, along with your measurements, in the power 
meter results file. When you open the results files with applications such as 
EXFO FastReporter2 (installed on a computer), all the information that you 
entered will be available.

To speed up information entry, once you have provided the required data, 
the contents is kept in memory. This information will be used for all new 
results.

To add information to your results:

1. From the button bar, tap Setup, and then select the Job Information 
tab.

2. Enter information in the appropriate boxes.

3. Tap OK to confirm. 

The information that you have entered will be copied to all the new files 
(and reports) that you will create.
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Printing Results Reports
You can print reports directly from your unit if you connect a printer to it.

You can modify the information related to customer, cable and job 
(see Adding Information to Your Results on page 122). 

The following table shows the items that are included in each type of 
report:

Sections appearing on the report Summarized
report

Detailed
report

Job Information: job ID, customer name, 
cable ID, location A and B, unit model and 
serial numbers, as well as test date and 
time. 

X X

Comments --- X

Measurements: pass/fail status (only 
shown if this option is selected; see Setting 
Thresholds and Correction Factors on 
page 111.), fiber ID, wavelength, 
measurement, and reference values (if 
applicable).

X X

Statistics: wavelength and associated 
average loss or power measurement.

--- X
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To print a power measurement report:

1. Connect a printer to your FTB-500. For more information, see Installing 
a Printer on page 63.

2. From the button bar, tap Print.

3. Select the desired report format.

4. If needed, tap Page Setup to adjust settings related to page layout, 
paper size, and printer.

5. Tap Print. You will automatically return to the power meter main 
window.
124 FTB-500



Using the Optional Built-In Power Meter and VFL
Identifying Fiber Faults Visually with the VFL
Identifying Fiber Faults Visually with the VFL
The visual fault locator (VFL) helps you identify bends, faulty connectors, 
splices and other causes of signal loss. It can also help the person at the 
other end of the link to identify the fiber under test, which could be 
particularly useful when working with cables containing many fibers.

From its dedicated port, the VFL emits a red signal which becomes visible 
at the location of a fault on the fiber. This signal can be continuous (CW, 
the default) or blinking (1 Hz).

WARNING
When the VFL is active, the VFL port emits visible laser radiation. 
Avoid exposure and do not stare directly into the beam. Protect any 
unused port with a cap.
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To activate the VFL and inspect a fiber:

1. Clean the connectors properly.

2. Connect the fiber under test to the VFL port.

3. If necessary, from Toolbox, on the Main Menu, tap Optical Power 
Meter and VFL.

4. Select the Instrument View tab.

5. Tap ON/Blink/OFF to change the VFL state.

6. Without looking directly into the beam, examine the fiber. If the fiber is 
defective, you will see light coming through its rubber jacket or on the 
side of the ferrule.
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7 Inspecting Fibers with a Probe
The fiber inspection probe (FIP) is used to find dirty or damaged 
connectors by displaying an enlarged view of the connector surface. You 
can connect a probe to your unit to view fiber ends.

Your unit supports both the probes of the FIP-400 and FIP-400B series. 

Fiber inspections are made using the ConnectorMax (FIP-400) or the 
ConnectorMax2 (FIP-400B) application, depending on the probe that you 
use. By default, you will be prompted to select the application with which 
you want to work. If you prefer, you can configure the unit to always start 
your favorite application directly instead (see Selecting the FIP Startup 
Application on page 67). 

For more information on how to work with the probe, refer to the 
ConnectorMax or ConnectorMax2 online help.
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To inspect fibers with a probe:

1. Connect the probe to your unit.

For a probe of the FIP-400 series, connect it to the probe port on the 
right panel of the unit.

2. From the Main Menu, tap Probe.

IMPORTANT
For a probe of the FIP-400B series, connect it to the USB port that is 
closest to the bottom, on the front panel of the unit. Otherwise, the 
probe will not be detected properly.

USB host port
(for FIP-400B probes)

Fiber inspection probe port
(for FIP-400 probes)

Front panel

Right panel
128 FTB-500



Inspecting Fibers with a Probe
3. If the unit prompts you to select an application, tap the button 
corresponding to the probe that you want to use to start the 
corresponding application.

Note: If you have not updated the ConnectorMax product lately, the 
ConnectorMax2 application may not be installed on your unit. In this case, 
you will not be presented with a choice of applications. The ConnectorMax 
application will start automatically, enabling you to work with the probes 
of the FIP-400 series. If you also wish to be able to work with probes of the 
FIP-400B series, you will need to install the most recent ConnectorMax kit.

Note: You can access the online help by tapping the  button from the 
ConnectorMax or ConnectorMax2 application.
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8 Managing Data
You can copy, move, rename, delete files and folders directly on your unit. 

You can transfer files from your unit to a USB memory key, an Express card, 
or a computer. You can also transfer data from a storage device or a 
computer to your unit.

Your unit is equipped with the following ports and devices for data transfer:

 Four USB 2.0 ports to connect 

 a memory key

 a USB to RS-232 adapter (see Using the USB to RS-232 Adapter on 
page 145.)

 a Bluetooth device (optional) to transfer data via Bluetooth.

 an Express card reader to connect

 a memory card 

 a Wi-Fi card (optional) to connect to a wireless network

 an Ethernet port to connect to a network (for transfer via VNC or 
Remote Desktop - see Accessing Your Unit Remotely on page 155)
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Transferring Data via Bluetooth
With the optional Bluetooth device, you can transfer data between your 
unit and a computer using the Bluetooth technology.

Note: The computer that you use must run Windows XP SP3 or later; otherwise, 
there could be problems during data transfer. The computer must also be 
equipped with a Bluetooth device and be configured properly. 

Note: To save power when your unit is running on batteries, you may wish to 
disconnect the Bluetooth device when you do not use it.

Note: If you prefer to use devices such as BlackBerry smartphones instead of a 
computer for data transfer, you must ensure that they are 
Bluetooth-compatible and configured properly. 
Some devices only allow data transfer between devices of the same make. 
In this case, you will need to use another type of device or a standard 
computer to transfer data from your FTB-500 unit.

Your unit must be located within a 9-meter area from your computer 
(limitation of the Bluetooth technology). 

If you need to transfer large files (more than 1 Gb), use a USB key, or 
connect to a Wi-Fi or an Ethernet network.
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The procedure presented hereafter explains how to transfer data from your 
unit to a computer. Data transfer from the computer to your unit is similar, 
except that data will be sent using the Bluetooth Transfer Wizard of the 
computer (Send a file option) and received by the unit (Receive a file 
option).

IMPORTANT
Depending on the operating system that your computer is running 
(or on the smartphone that you are using), it is possible that only 
data transfer secured with a passkey be allowed. 

Since your unit cannot receive data secured with passkeys, in such a 
case, data transfer would only be possible from your unit to the 
computer (or smartphone). 
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To transfer data via Bluetooth:

1. Configure your unit as follows:

1a. Connect the Bluetooth device to one of the USB ports of your unit.

1b. From the main window, select the Tools tab.

1c. Tap Control Panel.

1d. Tap Bluetooth Devices.
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1e. From the Options tab, under Discovery, select the 
Turn discovery on check box.

1f. Ensure that the Allow Bluetooth devices to connect to this 
computer check box is selected.

1g. Tap OK to confirm.
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2. Configure the computer as follows:

2a. Connect another Bluetooth device to one of the USB ports of your 
computer.

2b. On the computer, from Control Panel, double-click Bluetooth 
Devices.

2c. From the Options tab, under Discovery, select the 
Turn discovery on check box.

2d. Ensure that the Allow Bluetooth devices to connect to this 
computer check box is selected.

2e. Tap OK to confirm.

3. On the computer, click the Bluetooth icon (located on the taskbar) and 
select Receive a file.

4. On your unit, from the Windows taskbar, tap Start > All Programs > 
Accessories > Communications > Bluetooth File Transfer Wizard.

5. From the Welcome window, tap Next.

6. Select Send a file and tap Next.
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7. Select the computer to which you want to transfer data as follows:

7a. Tap Browse.

7b. Select the desired computer, and then tap OK to confirm.
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8. If you want to use a passkey, select the corresponding check box and 
enter the passkey.

When you have finished, tap Next.

9. Tap Browse to select the file that you want to send to the computer.

10. Select the file, tap Open to confirm, and then Next.
138 FTB-500



Managing Data
Transferring Data via Bluetooth
11. On the computer, when the application prompts you, allow the 
connection and enter the passkey if necessary.

Note: Once you have established a secured connection using a passkey, this 
passkey is kept in memory both on your unit and on the computer until you 
remove this connection (Control Panel> Bluetooth Devices > Devices) or 
change the passkey.

12. On the computer, click Finish.

13. From the Bluetooth File Transfer Wizard on your computer, if 
necessary, modify the name of the received file and the storage 
location. Click Next to save the file. Click Finish to close the wizard.

14. On your unit, tap Finish to close the Bluetooth File Transfer Wizard.
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Connecting to a Wireless Network
With the optional Wi-Fi card (or a USB wireless adapter of your choice), 
you can connect to a wireless network and benefit from all resources that 
are available on this network. You can transfer data exactly as you would 
do from an Ethernet network.

Note: To save power when your unit is running on batteries, you may wish to 
remove the Wi-Fi card when you do not use it.

To connect to a wireless network:

1. Insert the Wi-Fi card into the express card reader located on the left 
panel of your unit.

Note: If you use a Wi-Fi card (or a Wi-Fi USB key) other than the one purchased 
from EXFO, Windows may not detect your device properly. In this case, you 
will have to install the drivers that are specific to your device (usually 
provided on a CD). Contact your IT department for assistance.

2. If it is not already done, share all the required folders both on your unit 
and on your computer. If you are not sure on how to proceed, see with 
your network administrator.
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3. If it is not already done, configure the firewall as follows:

3a. From the main window, select the Tools tab.

3b. Tap Control Panel.

3c. Tap Windows Firewall.

3d. Select the Exceptions tab.
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3e. Ensure that the File and Printer Sharing item is selected. 

3f. Tap OK to confirm.

4. Tap Network Connections.
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5. Double-tap Wireless Network Connection.

6. If your unit is already connected to a wireless network, tap View 
Wireless Networks to display the list of wireless networks.
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7. From the Wireless Network Connection window, select the wireless 
network to which you want to connect.

8. Tap Connect.

9. If the network is protected by a network key (password) enter it in the 
corresponding boxes and tap Connect.

Note: Since all networks are different, you may also need to configure other 
parameters before being able to transfer data via Wi-Fi. For information on 
the configuration specific to your network, see with your network 
administrator.

As soon as the connection is established, you can start working with the 
selected wireless network. When you have finished, from the Wireless 
Network Connection window, tap Disconnect to stop communication 
with the wireless network. 
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Using the USB to RS-232 Adapter
If you want to transfer data between your unit and a device that is only 
equipped with RS-232 (serial) ports, you have to use a USB/RS-232 adapter. 
You can use any USB/RS-232 adapter that you like.

Once the adapter has been detected, the unit assigns it a COM port 
number. This COM port number is kept in memory even when you turn the 
unit off. This means that next time you connect the same adapter to any of 
the USB ports, the unit will recognize the adapter and identify it with the 
saved COM port number.

Note: For some adapters, the port values do not begin at COM 1. You may want to 
verify the actual port number. 

The communication between your unit and the device is established using 
the PuTTY application. 
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To use the USB/RS-232 adapter:

1. Turn on both the unit and the serial device.

2. Connect as shown. You can connect the USB end of the adapter to any 
of the USB ports.

Note: If the device that you want to use is a computer (not equipped with USB 
ports) you may want to use a null-modem serial cable as an “extension 
cable” between the device and the USB/RS-232 adapter.

The adapter will be detected automatically on your unit.

Serial 
device

Serial end

USB/RS-232
adapter

USB end
FTB-500
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3. From your unit, retrieve the COM port of the adapter as follows:

3a. From the main window, select the Tools tab.

3b. Tap Control Panel.

3c. Tap System.
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3d. From System Properties, select the Hardware tab, then tap 
Device Manager.

3e. Expand the Ports (COM & LPT) list to retrieve the COM port 
number that has been assigned to the adapter (identified as USB 
Serial Port) and write it down.

3f. Close the Device Manager.
148 FTB-500



Managing Data
Using the USB to RS-232 Adapter
4. From your unit, configure the communication parameters as follows:

4a. From the main window, select the Tools tab, then tap PuTTY.

4b. Configure the parameters.

 From the tree view, select Connection > Serial and set the 
parameters as needed. Ensure that the COM port that you specify 
corresponds to the one that you wrote down at step 3e.

 If you want to view the characters that you type on screen, from the 
tree view, select Terminal. Under Local echo, set the value to 
Force on.

 From the tree view, select Session. Select Serial. The COM port 
number and the speed should correspond to those that you have 
previously entered.

4c. Tap Open. The unit is now ready to receive or send data.

Tree view
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5. From the device, set the communications parameters.

Note: The COM port number that you set on your device will probably differ from 
the one that you used on your unit.

6. From the device, establish communication with the unit using your 
favorite communication tool (PuTTY, HyperTerminal, etc.).

IMPORTANT
To be able to establish a communication between the unit and the 
device, you must set the following parameters to the same values 
as those defined on your unit:

 Speed

 Data bits

 Stop bit

 Parity

 Flow control
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Connecting to a VPN from Your Unit

Note: Only administrator-level users can install software under Windows XP. 
However, when the installation is complete, all users have the possibility to 
connect to a VPN from the unit.

You can connect to a Virtual Private Network (VPN) from your unit if you 
install one of the supported VPN clients (applications). Such clients allow 
you to connect to the VPN of your company from anywhere in the world 
and have access to network resources as if your unit was connected locally 
to the network. This could be useful if you need to transfer data to a 
centralized folder on the company’s private network, for example.

To establish the communication between the VPN client and the VPN 
server, you can use either a 3G USB modem key (see Accessing the Internet 
with a 3G USB Modem Key on page 97) or a standard Ethernet connection.

Note: Since all networks are different, the parameters that you need to configure 
before being able to connect to the VPN may vary. For information on the 
configuration specific to your network, see with your network 
administrator.

If you ever need to change to another VPN client or remove it, use the 
Add/Remove Programs utility from Windows.
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To install a VPN client on your unit:

1. If the date on your unit does not correspond to the current date, modify 
it (see Adjusting the Date, Time and Time Zone on page 77).

2. Start the installation of the VPN client using the files and settings 
provided by your network administrator.

3. Follow the on-screen instructions. 

Once the installation is complete, all users will now be able to connect to a 
VPN from the unit.

To connect to a VPN from your unit:

Start the VPN client and follow the on-screen instructions.

If you are not sure about the information that you should provide, see with 
your network administrator.

IMPORTANT
EXFO does not recommend to install more than one VPN client on a 
single FTB-500 unit.

IMPORTANT
To avoid communication problems between the VPN client and the 
VPN server, ensure that the date set on your unit corresponds to the 
current date.
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Using Your Unit as an FTP Server
If you want your unit to act as an FTP server, you can use the Internet 
Information Services (IIS) Manager. If you need information on the IIS 
Manager or on how to transfer files via an FTP server, refer to Windows 
online help.

To access the IIS Manager:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Administrative Tools.

4. Tap Internet Information Services.

You are now ready to start working with the IIS Manager.
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9 Accessing Your Unit Remotely
You can access your unit remotely from a computer using either the 
Remote Desktop Connection or TightVNC Client applications.

This could be particularly useful if you do not intend to perform automation 
tasks on your platform. If you prefer to perform automation tasks on your 
platform and modules, see Preparing for Automation on page 175, Using 
FTB Products in an Automated Test Environment on page 213, or Preparing 
to Control Modules with a Dedicated Application on page 208.

The table below presents the differences between the two applications.

Characteristic Remote Desktop 
Connection TightVNC Client

Type of connection Direct between the unit and the 
computer; only one user can be 
connected to the unit at a time.

Usually, the connection is made 
with the user name of the 
person currently logged on the 
unit. Otherwise, this person will 
be automatically disconnected.

Not exclusive; several users 
can be connected to the unit at 
the same time (sharing the 
same session).

Windows user rights Taken into account. Not taken into account.

Password-protected Yes; mandatory. The user name 
and password are the same as 
those used to connect to the 
unit.

By default, all the accounts with 
administrator rights can use 
Remote Desktop Connection. If 
you want accounts with limited 
rights to be able to use Remote 
Desktop as well, you must 
specifically grant them access.

Yes; mandatory. The password 
is defined on the TightVNC 
Server, the first time you start 
the server. This password is not 
related to the one used to 
connect to the unit. By default, 
all people that use TightVNC 
Client will enter the same 
password (as defined on the 
server).

Each user to whom you 
provide the password will be 
able to connect to the unit via 
TightVNC.
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Working with Remote Desktop
By default, the remote access to your unit with Remote Desktop is not 
enabled. However, once you enable it, all the accounts with administrator 
rights can use Remote Desktop. If you want accounts with limited rights to 
be able to use it as well, you must specifically grant them access.

You can also configure the unit to prevent users from accessing it remotely.

Accessing Your Unit with Remote Desktop

To be able to connect to the unit using Remote Desktop, you must:

 Allow the remote access to your unit (only necessary the first time that 
you access your unit with Remote Desktop).

 Know the IP address of the unit and provide it in the connection 
settings on the computer.

 Use an account that is secured by a password. Remote Desktop will 
not allow any connection with empty passwords.

 Enter the appropriate user name when Remote Desktop application 
prompts you. Usually, this user name must correspond to the user 
name of the person currently logged on the unit. Otherwise, you will 
disconnect the person that was already connected.
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To allow the remote access to your unit with Remote Desktop:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap System.

4. From the System Properties dialog box, tap the Remote tab.
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5. Under Remote Desktop, select Allow users to connect remotely to 
this computer.

6. Tap OK to confirm the changes and return to Control Panel.

7. Close the Control Panel window.
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To access your unit remotely with Remote Desktop:

1. Connect both the computer and your unit to the same network and 
make sure they can “see” each other as network restrictions might 
prevent them from communicating.

 If you want to use an Ethernet network, connect an RJ-45 
(network) cable to the unit’s RJ-45 (Ethernet) port located on its 
left side. 

 If you want to use a wireless network, see Connecting to a Wireless 
Network on page 140.

 You could also create a Private Area Network with your Bluetooth 
device (see with your network administrator).

2. Turn on both the computer and the unit.

3. On your unit, in Toolbox, go to Main Menu. Select System 
Information > Platform.

4. Write down the IP address, and then close the window.

Note: It may take a few seconds before you see the IP address on the list.

5. From the computer, on the taskbar, click Start, then select 
All Programs > Accessories > Remote Desktop Connection.
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6. In the Connecting to Remote Desktop window, in the Computer list, 
type the IP address of the unit that you wrote down at step 4.

7. Click Connect.

8. When the application prompts you, enter your user name and 
password.

9. Click OK to open the session.

Allowing Users with Limited Accounts to Use 
Remote Desktop

By default, only the accounts with administrator rights can use Remote 
Desktop. However, you can assign extra user rights to accounts with 
limited rights so that they can also use Remote Desktop.
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To allow a user with limited accounts to use Remote Desktop:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap System.

4. From the System Properties dialog box, tap the Remote tab.
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5. Under Remote Desktop, select Allow users to connect remotely to 
this computer.

6. Tap Select Remote Users.
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7. From the Remote Desktop Users dialog box, tap Add.

8. From the Select Users dialog box, tap Advanced.
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9. Tap Find Now to let the system find and display the list of users.

10. Select the user to which you want to grant access rights, and then tap 
OK.

11. From the list of users, select the user that you have just added, and 
then tap OK.

12. Repeat steps 9 to 11 with all the users to which you want to grant 
access rights.

13. From the Remote Desktop Users dialog box, tap OK.

14. From the System Properties dialog box, tap OK to confirm the 
changes and return to Control Panel.
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Preventing Users from Connecting with Remote 
Desktop

You can also configure the unit to prevent users to access it using Remote 
Desktop. However, all users having administrator user rights will be able to 
modify this setting at any time.

To prevent users from connecting to the unit using Remote 
Desktop:

1. From the main window, select the Tools tab.

2. Tap Control Panel.
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3. Tap System.

4. From the System Properties dialog box, tap the Remote tab.

5. Under Remote Desktop, clear the Allow users to connect remotely to 
this computer check box.

6. From the System Properties dialog box, tap OK to confirm the 
changes and return to Control Panel.
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Working With TightVNC
The control of your unit with TightVNC requires the TightVNC Server 
(already installed on your unit) and the TightVNC Client Viewer (that you 
must install on your computer).

The first time you start the TightVNC Server on your unit, the application 
will prompt you to define passwords. Once these passwords are defined, 
you are now ready to connect to your unit using the TightVNC Client (on 
your computer).

To be able to connect to the unit using TightVNC, you must:

 Know the IP address of the unit and provide it in the connection 
settings on the computer.

 Know the password (same for all users by default). 

This section provides you with the basic information to control your unit 
with TightVNC. For more information, refer to the TightVNC online help.

CAUTION
Be very careful if you use TightVNC to transfer files between a 
computer and your unit (TightVNC Server).

 Transfer from a computer to your unit: If the transfer is 
interrupted, all files on your unit having the same name as 
those on the computer WILL BE DELETED. However, the files on 
the computer will remain available. 

 Transfer from your unit to a computer: If the transfer is 
interrupted, all files on the computer having the same name as 
those on your unit WILL BE DELETED. However, the files on your 
unit will remain available.
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Configuring the TightVNC Server

The TightVNC Server is already installed on your unit. You must configure 
passwords before establishing a connection between a computer and your 
unit. 

To configure the TightVNC Server:

1. On the Windows taskbar, tap Start, and then select All Programs.

2. Select TightVNC, and then Launch TightVNC Server.

3. If the Current User Properties window is not displayed automatically, 
from the Windows taskbar, tap Start >All Programs >TightVNC > 
Show User Settings.

4. Select the Server tab.

5. Under Incoming connections, select Accept socket connections.
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6. In the Primary password and View-only password boxes, type the 
desired passwords.

Note: The two passwords are independent of each other. They do not have to be 
identical.

7. Tap Apply, and then OK.
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Installing the TightVNC Viewer on a Client 
Computer

If the TightVNC Viewer is not already installed on your computer, you can 
install it with the DVD that came with your FTB-500. 

To install the TightVNC Viewer on your computer:

1. Insert the installation DVD into the CD/DVD drive of your computer.

2. From the DVD Main Menu, click Explore this DVD.

3. Open the Utilities folder, and then copy the VNC Client folder.

4. Paste the VNC Client folder to a location of your choice on your 
computer.

You are now ready to start working with the TightVNC Viewer.

Note: If you want to access the TightVNC Viewer without having to install it on 
your computer, you can start it from the DVD (Main Menu > Utilities > 
VNC Client)
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Connecting to Your Unit with TightVNC

Once the TightVNC Viewer is installed on your computer, you are ready to 
access your unit remotely.

To connect to your unit with TightVNC:

1. Connect both the computer and your unit to the same network and 
make sure they can “see” each other as network restrictions might 
prevent them from communicating.

 If you want to use an Ethernet network, connect an RJ-45 
(network) cable to the unit’s RJ-45 port located on its left side. 

 If you want to use a wireless network, see Connecting to a Wireless 
Network on page 140.

 You can also create a Private Area Network with your Bluetooth 
device (see Transferring Data via Bluetooth on page 132).

2. Turn on both the computer and the unit.

3. On your unit, in Toolbox, go to Main Menu. Select System 
Information > Platform.

4. Write down the IP address, and then close the window.

Note: It may take a few seconds before you see the IP address on the list.
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5. On the Windows taskbar, tap Start, and then select All Programs.

6. Select TightVNC, and then Launch TightVNC Server.

7. From your computer, double-click the TightVNC Viewer shortcut on 
your desktop.

8. In the VNC Server list, type the IP address of your unit that you wrote 
down at step 4. 

9. Click Connect.
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Adding Exceptions to the Firewall

Note: Only administrator-level users can add exceptions to the firewall.

Your unit is protected by the Microsoft firewall to prevent unauthorized 
access when it is connected to a network or to the Internet. The firewall 
has been preconfigured so that all the applications that come with your 
unit work properly. However, you can allow other applications to access 
the network or the Internet by adding exceptions.

If you are not sure about how to configure the firewall, see with your 
network administrator.

To add exceptions to the firewall:

1. From the main window, select the Tools tab.

2. Tap Control Panel.
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3. Tap Windows Firewall.

4. Select the Exceptions tab.

5. Tap Add Program to add any application that you need.

6. When you have finished, tap OK to confirm the changes and return to 
the Control Panel window.
174 FTB-500



10 Preparing for Automation
The FTB-500 was designed to meet the requirements of automation and to 
facilitate its integration with your test environment.

EXFO supplies commands that follow the guidelines determined by the 
SCPI consortium and LabVIEW drivers for many instruments.EXFO also 
supplies COM properties and events allowing you to build your own 
application.The instruments can be controlled either locally or remotely via 
the following technologies:

RS-232

ActiveX 
(DCOM)

(Ethernet, TCP/IP)

LabView

Visual Basic

Visual C++

Delphi

ActiveX (COM Software protocol)

Visual Basic

Visual C++

Delphi

Local Access

Remote access

SCPI Commands

SCPI Commands

Libraries & "drivers"

LabWindows

LabView

LabWindows

Telnet
(Ethernet, TCP/IP)
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The choice of a technology will depend on your particular needs.

For more information on programming aspects, see the section on using 
your product in an automated test environment.

Control Technology Characteristics

Local ActiveX (COM)  Allows you to develop an application that will run 
locally on the FTB-500 within Windows XP

 Best approach when speed is your top priority (no 
physical connection that slows down the 
process)

 Supported by most development software

 Lower cost

Remote ActiveX (DCOM) 
(Ethernet, 
TCP/IP)

 Allows the sharing of network resources

 Allows you to develop computer-based 
applications to directly communicate with the 
FTB-500

Remote RS-232  Null-modem cable required to establish 
connection between the computer and the 
FTB-500

 For increased speed and performance, run the 
application locally on the FTB-500 through 
ActiveX instead of using RS-232

Remote Telnet (Ethernet, 
TCP/IP)

 FTB-500 can be directly connected to a Local 
Area Network (LAN) or Wide Area Network 
(WAN) via its 10/100/1000 Base-T interface

 Allows the sharing of network resources

 Allows you to develop computer-based 
applications very easily to directly communicate 
with the FTB-500
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Linking Units with the Ethernet Port
Your FTB-500 is equipped with an Ethernet port (10/100 000)to send and 
receive data.Refer to the Windows documentation for information about 
Ethernet port settings and possibilities.

Ethernet port
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Linking Units with the Serial Port
Your FTB-500 is equipped with a serial (RS-232) port to send and receive 
data. Refer to the Microsoft Windows documentation for information about 
serial port settings and possibilities. 

Serial port
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Getting Optimum Performance from Your 
FTB-500

Several factors influence the data transfer rate of an FTB-500. The 
information presented hereafter will help you get the best transfer rate 
possible.

 Output unit (RS-232, ActiveX and TCP/IP): The FTB-500 can return 
results in

 linear units (for example, watts)

 log units (for example, dBm)

Since internal units are linear, you will get optimal performance by 
using linear units for output (no need for an internal conversion to log).

Note: You must make the choice of output unit for each instrument offering such 
a feature. Refer to the user guide of each optical instrument for a list of 
available commands and queries.
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 Output format (RS-232, ActiveX and TCP/IP): The FTB-500 provides the 
following output formats for measurement results:

 ASCii

 PACKed

Generally, the PACKed format allows to pass three to four times more 
information than the ASCii format for the same transfer rate. Often, the 
PACKed format is also more efficient since it reduces the FTB-500 CPU 
work load (no need for an internal conversion to ASCII format).

Note: The PACKed format will only be applied to <DEFINITE LENGTH ARBITRARY 
BLOCK RESPONSE DATA> and <INDEFINITE LENGTH ARBITRARY BLOCK 
RESPONSE DATA>.

Note: The choice of data format cannot be made directly via the ToolBox 
software.

For more information on how to set the output format and data types, see 
:FORMat[:DATA](IEEE 488.2 and specific commands appendix), Read and 
ReadBinary (COM properties and events appendix), and the data types 
appendix.
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Changing Communication Settings
Communication settings cannot be modified without turning on your 
FTB-500 and starting ToolBox

To change communication settings:

1. Select the Tools tab, then Instrument Control Configuration.
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2. Under Platform Startup, determine whether your module applications 
will be started locally or remotely by clicking the corresponding option.

 If Local mode is selected, you will not be able to send remote 
commands to your FTB-500.

 If Remote mode is selected, all modules in your FTB-500 will be 
initialized upon startup so you are ready to send remote 
commands.

If you selected Local mode, you can go directly to step 5.

3. Under Communication Type, select ActiveX, RS-232, or TCP/IP.

For more information on the choice of a particular type, see the table 
on page 176.

Note: If the selected communication type does not match the protocol that will 
actually be used, an error message is displayed when attempting to control 
the instruments.
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4. According to the communication type you have selected, customize 
the corresponding parameters as shown below.

 For RS-232

 For TCP/IP

For information on communicating with TCP/IP over Telnet, see 
the section pertaining to communication through TCP/IP over 
Telnet.

5. Click Apply to confirm your changes.

Serial port—used to connect the RS-232 cable.
The only available value is COM1.

Determines the speed at which data
is sent between the FTB-500 and a
computer, in bits per second (b/s).

End-of-string (EOS) character—used to indicate the
end of a data string (when sending or receiving data).

TCP/IP port 5024—used to
connect over Telnet.
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To revert to default general settings:

1. Click the Restore Default Settings button.

2. Click Apply to confirm your changes.

To revert to default RS-232 settings:

1. Click the Default RS-232 Settings button.

2. Click Apply to confirm your changes.
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Configuring DCOM Access to Your Unit
DCOM technology allows to control devices and optical instruments via 
Ethernet. The EXFO IcSCPIAccess Class component provided with your 
FTB-500 acts as a communication link between a client application and 
EXFO’s Instrument Control.

DCOM ensures communication between the client application and 
Instrument Control via your local network. Since each network has its own 
configuration, you need to be familiar with network security, users, groups, 
domain management, etc. Basic programming skills are also required to 
work with DCOM. For more information, you can refer to the Microsoft 
MSDN Help feature, which provides exhaustive technical documentation 
on all DCOM issues.

The example presented in the following pages illustrates how to make the 
EXFO IcSCPIAccess Class component available to all users of a local 
network under Windows XP. The example provided below is for guidance 
only; it may not work properly with all networks and interfaces may slightly 
differ depending on the operating system used.

To enable DCOM access to your FTB-500, you must:

 set the general security parameters

 customize the specific security parameters

 register callback events. 
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Setting the General Security Parameters

Note: To run DCOMCNFG.EXE, you need administrator access rights.

To set the general security parameters:

1. On the Windows taskbar, click Start and select Run.

2. In the Open box, type DCOMCNFG.EXE and click OK.

3. In the Component Services dialog box, go to Console Root > 
Component Services > Computers.

4. In the Computers dialog box, right-click My Computer, and then select 
Properties.
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5. In the My Computer Properties dialog box, click the COM Security 
tab.

6. Under Access Permissions, click Edit Limits.
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7. In the Access Permission dialog box, ensure that the Distributed COM 
Users group appears in the Group or user names list.

You can now allow users to access general DCOM services on your 
FTB-500. You can either:

 Add a user to the Distributed COM Users group (refer to Microsoft 
help).

OR

 Add a user explicitly under both, Access Permission and Launch 
Permission tabs (see procedure below).

Note: If you add a user explicitly, ensure to give remote access rights to the new 
user.
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To add a user explicitly:

1. In the My Computer Properties dialog box, click the COM Security 
tab.

2. Under Access Permissions, click Edit Limits.

3. In the Access Permission dialog box, click Add.
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4. In the Select Users or Groups dialog box, under Enter the object 
names to select, type the name of the user to whom you want to give 
access rights.

5. Click OK.
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6. Confirm the newly added user has remote access permission as 
follows:

6a. In the Access Permission dialog box, select the name of the new 
user.

6b. Under Permissions for (new user), ensure Allow is selected for 
Remote Access.

6c. Click OK.

7.  In the My Computer Properties dialog box, click the COM Security 
tab.

8. Under Access Permissions, click Edit Limits.
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9. In the Launch Permission dialog box, click Add.

10. In the Select Users or Groups dialog box, under Enter the object 
names to select, type the name of the user to whom you want to give 
start and activation access rights.

11. Click OK.
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12. Confirm the newly added user has Remote Launch and Activation 
permission as follows: 

12a.In the Launch Permission dialog box, select the name of the new 
user.

12b.Under Permissions for (new user), ensure Allow is selected for 
both Remote Launch and Remote Activation.

12c. Click OK.
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Customizing the Specific Security Parameters

Once you have defined the general security parameters, you can define the 
specific security parameters.

To customize the specific security parameters:

1. From the Component Services dialog box, select: Console Root> 
Component Services> Computers> My Computer> DCOM Config to 
show the contents of the DCOM Config folder.

2. From DCOM Config, right-click EXFO KernosHost, and select 
Properties.

3. Click the General tab.
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4. In the Authentication Level list, select Default.
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5. In the EXFO KernosHost Properties dialog box, click the Security tab.

6. Under Launch and Activation Permissions, select Customize, and 
then click Edit to edit the list of allowed users.

7. In the Launch Permission dialog box, click Add.

IMPORTANT
Customizing access rights sets both remote AND local permissions. 
As a result, you will have to specify every user who must have local 
access to the system (see Setting the General Security Parameters 
on page 186).

If you do not specify local access rights, no user will be able to 
access EXFO KernosHost and, therefore, no user will be able to start 
ToolBox.
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8. In the Select Users or Groups dialog box, under Enter the object 
names to select, type the name of the user to whom you want to give 
start and activation permissions for remote access.

9. Click OK.
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10. In the Launch Permission dialog box, select a user. 

11. To allow this user to start and activate the FTB-500 remotely, select 
Allow for all four permission choices.

12. Repeat steps 10 and 11 for each newly added user.

13. Click OK.
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14. In the EXFO KernosHost Properties dialog box, click the Security tab.

15. Under Access Permissions, select Customize, and click Edit to edit 
the list of allowed users.

16. In the Access Permission dialog box, click Add.

IMPORTANT
Customizing access rights sets both remote AND local permissions. 
As a result, you will have to specify every user who must have local 
access to the system (see Setting the General Security Parameters 
on page 186).

If you do not specify local access rights, no user will be able to 
access EXFO KernosHost and, therefore, no user will be able to start 
ToolBox.
FTB-500 199



Preparing for Automation
Configuring DCOM Access to Your Unit
17. In the Select Users or Groups dialog box, under Enter the object 
names to select, type the name of the user to whom you want to give 
access permissions for remote access. 

18. Click OK.

19. In the Access Permission dialog box, select a user.

20. To allow this user to access the FTB-500 remotely, select Allow for both 
permission choices.
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21. Repeat steps 19 and 20 for each newly added user.

Note: You can also deny connection permission for specific users.

22. Click OK to close the Access Permission dialog box.

23. Click OK to close the EXFO KernosHost Properties dialog box.

24. Restart your FTB-500.

The EXFO IcSCPIAccess Class component, located on your FTB-500, 
can now be accessed with DCOM.

Note: To run DCOMCNFG.EXE, you need Administrator access rights.
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Enabling DCOM on Client Computer

If you want to subscribe to EXFO IcSCPIAccess Class component events, 
you need to set security parameters on the client computer.

To enable DCOM on the client computer:

1. Start Windows, on the taskbar, click Start and select Run.

2. In the Open box, type “DCOMCNFG.EXE” and click OK.

3. Click OK to open the Component Services dialog box.
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4. In the Component Services dialog box, select: Console Root> 
Component Services> Computers> to show available computers.
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5. Right-click My Computer, and then select Properties.

6. In the My Computer Properties dialog box, click the Default 
Properties tab.

7. Select Enable Distributed COM on this computer.

8. Under Default Distributed COM Communication Properties, in the 
Default Authentication Level list, select Connect.

9. In the Default Impersonation Level list, select Identify.

10. Click OK.
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11. Click the COM Security tab and, under Access Permissions, click Edit 
Limits.

12. In the Access Permission dialog box, ensure that, for ANONYMOUS 
LOGON, local and remote accesses are allowed.

If ANONYMOUS LOGON is not listed under Group or user names, 
click Add to add it.

 
For more information on enabling events with DCOM, refer to 
AppId Key in MSDN Documentation.
FTB-500 205



Preparing for Automation
Configuring DCOM Access to Your Unit
Disabling DCOM Access to Your FTB-500

If you no longer want client computers to access your FTB-500 using 
DCOM, you can disable this access.

To disable DCOM access to your FTB-500:

1. Start Windows, on the taskbar, click Start and select Run.

2. In the Open box, type “DCOMCNFG.EXE” and click OK.

3. In the Component Services dialog box, select: Console Root> 
Component Services> Computers> My Computer> DCOM Config to 
show the contents of the DCOM Config dialog box.

4. In the DCOM Config dialog box, right-click EXFO KernosHost, and 
select Properties.
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5. In the EXFO KernosHost Properties dialog box, click the Security tab.

6. Under Launch and Activation Permissions and Access Permissions, 
select Use Default.

This ensures the EXFO IcSCPIAccess Class component uses the default 
lists instead of the customized lists.

7. Click OK.

8. Restart your FTB-500.

The EXFO IcSCPIAccess Class component, located on your FTB-500, 
cannot be accessed with DCOM.
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Preparing to Control Modules with a 
Dedicated Application

Some modules come with a dedicated application designed to control 
them remotely from a computer. The main characteristic of this application 
is that it lets another user control the module exactly as if he had it close at 
hand.

To control the module remotely, you must configure it on the unit 
containing the module, including a description that can help you identify it. 
The user controlling the module from a computer must install the 
dedicated application (for more information on the installation, refer to the 
application documentation).

 The module can be controlled both remotely and locally at the same 
time.

 You will have to configure your remote control again in the following 
cases:

 you inserted the module in another slot

 you applied changes on applications while the module is not 
inserted in its slot.

Note: Some modules do not support the remote control.

IMPORTANT
If there is a network failure or a problem with your 
remotely-controlled module, you can shut down the latter without 
closing all the other applications. The local and remote module 
session will then be closed.
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To activate or deactivate remote control:

1. Select the Tools tab.

2. Select Remote Control Configuration.
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3. From the Remote Control Configuration window you will see all the 
inserted modules. Select the module you want to have a remote 
access on.

Note: Modules for which remote control is not supported are identified as 
unrecognized.

4. Set the parameters:

 Select Remote Control to let another user control the module from 
a computer.

 Select Standalone to leave the module active even if all users 
close their dedicated applications.
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5. Under Description, type a relevant description (test interface ID, for 
example).

Note: You can enter up to 10 characters. The description corresponds to the test 
interface ID or any other relevant description.

6. Press Apply to enter your changes or OK to apply your changes and 
close the window.

Note: This information will be updated the next time you start the module 
application and appear in the title bar if the module application allows it. 
Refer to the corresponding module documentation for more details.

To shut down the remotely-controlled module: 

Press Shut Down Module.
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Automated Test Environment

EXFO supplies commands that follow the guidelines determined by the 
SCPI consortium and LabVIEW drivers for all available instruments. EXFO 
also supplies COM properties and events allowing you to build your own 
application.

Your application can be developed using LabVIEW, Visual C++, 
Delphi.NET, Visual Basic or any other language that runs under 
Windows XP.

The present chapter gives you information to help you use the provided 
commands, drivers, and COM properties and events to remotely control 
your instruments.

If you need information on how to prepare your FTB-500 for remote 
control, see the corresponding section in this documentation.
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Managing the States of Your FTB-500
Your FTB-500 can be in one of the following states:

Note: The current state is displayed in the ToolBox status bar.

State Characteristics

Local  Front-panel keys of the FTB-500 unit and peripherals 
are all functional

 Default state at unit turn on

Remote  Front-panel keys of the FTB-500 unit and peripherals 
are not functional except for the LOCAL key and the 
power switch

Local with lockout  Return to Local mode only possible via commands 
sent from the system controller

 Pressing the front-panel LOCAL key causes an URQ 
message (see Standard Status Data Structure on 
page 216)

Remote with lockout  Front-panel keys of the FTB-500 unit and peripherals 
are not functional except for the power switch

 Return to Local mode only possible via commands 
sent from the system controller

 Pressing the front-panel LOCAL key causes an URQ 
message (see Standard Status Data Structure on 
page 216)
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The following diagram shows the possible transitions between the 
different states.

Note: See the appendix on COM properties and events for more information.

Note: You can also return to local state by turning the device off and on again. 
However, this operation will cause the controller to lose control of the 
system (no more local lockout state). All settings made on the device by the 
controller will be lost (reset of device configuration when turning on).

No. Possible in ActiveX by setting:

1 The RemoteState property to True.

2 The LockoutState property to True.

3 The RemoteState property to False.

4 The LockoutState property to True.

5 The LockoutState property to False.

6 The RemoteState property to True.

7 -----

8 The RemoteState property to False.

9 The LockoutState property to False.

Local

Local Lockout Remote Lockout

Remote
3

52 9

6

8

1

7
4
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Standard Status Data Structure
Each device that is physically connected to the remote bus has four status 
registers with a structure complying with the IEEE 488.2 standard. These 
registers allow the controller to monitor events and get useful information 
on the status of the devices it controls.

 Standard Event Status Register (ESR)

 Standard Event Status Enable Register (ESE)

 Status Byte Register (STB)

 Service Request Enable Register (SRE)

ESR and ESE

The standard event status register and status enable register information is 
presented in the following table.

Bits Mnemonics Bit Value

7 Power On (PON) 128

6 User Request (URQ) 64

5 Command Error (CME) 32

4 Execution Error (EXE) 16

3 Device-Dependent Error (DDE) 8

2 Query Error (QYE) 4

1 Not Used (N.U.) 0

0 Operation Complete (OPC) 1
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The following table presents a summary of the possible operations on ESR 
and ESE registers.

STB and SRE

The status byte register and service request enable register information is 
presented in the following table.

Register Read Write Clear

ESR Use *ESR?. Impossible 
to write.

 Use *CLS.

 Read the register.

ESE Use *ESE?. Use *ESE. Use *ESE with a value equal to 0.

Bits Mnemonics Bit Value

7 Not Used (N.U.) 0

6 Master Summary Status (MSS)/ Service 
Request (RQS)

64

5 Event Summary Bit (ESB) 32

4 Message Available (MAV) 16

3 Not Used (N.U.) 0

2 Error Available (EAV) 4

1 Not Used (N.U.) 0

0 Not Used (N.U.) 0
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The following table presents a summary of the possible operations on STB 
and SRE registers.

The diagram displayed on the next page is a useful aid in understanding 
the general commands and how a service request (SRQ) is generated.

Using a service request, a device notifies the controller that an event 
requiring special attention occurred. The controller will then find which 
device generated a SRQ (its RQS bit is set) and the causes of it.

Register Read Write Clear

STB  Use *STB?.

 Use serial poll (GPIB 
bus sequence that 
allows retrieval of the 
value without 
interrupting the current 
process).

Impossible to write; 
the register content is 
only modified when 
the Event registers or 
Queues are modified.

Use *CLS before 
sending a query (to 
clear the Event registers 
and Queues and by the 
same token clear the 
STB register).

SRE Use *SRE?. Use *SRE with a value 
equal to 0 to disable 
the register or with a 
value equal to 1 to 
enable it.

 Use *SRE with a 
value equal to 0.

 At  startup, the 
register is set to 0.
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SCPI Command Structure
The information presented in this section provides an overview of GPIB 
programming. If you need detailed information, refer to:

 The International Institute of Electrical and Electronics Engineers. IEEE 
Standard 488.2-1992, IEEE Standard Codes, Formats, Protocols and 
Common Commands For Use with ANSI/IEEE Std. 488.1-1987. New 
York, 1992.

 Standard Commands for Programmable Instruments (SCPI). Volume 
1: Syntax and Style. Vers. 1999.0 May, U.S.A, 1999.

The provided commands follow the guidelines determined by the Standard 
Commands for Programmable Instruments (SCPI) consortium. A program 
message consists of one or more commands (and/or queries) with their 
appropriate parameters.

For example, a program message could contain a command used to 
activate or deactivate a source. The corresponding command syntax 
would be:

When sending a message containing the previous command, you would 
actually type: SOUR:POW ON.

SOUR:POW[:STAT]<wsp><Boolean Program Data>

Mandatory
keywords

Optional keyword 
(in square brackets)

Required 
space

ParameterKeyword 
separators
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The following table shows elements that are commonly used in the 
commands or queries syntax.

Item Meaning

[ ] Enclose optional keywords or parameters. 
Do not include square brackets in your program message.

[1..n] Indicates that the instrument provides multiple capabilities and that you 
have to specify which one you want to use. If you omit the value, the 
command will take effect on the first capability.

Multiple capabilities can be found at any branch of the command tree 
(root, intermediate node or terminal node).

Example: If the command is :SENSe[1..n]:CORRection:COLLect:ZERO 
and you want it to take effect on the second SENSe (sensor) capability 
of the instrument, you may send this:

:SENSe2:CORRection:COLLect:ZERO.

Do not include square brackets in your program message; simply enter 
the number. 

<wsp> Indicates that a space is required (“wsp” stands for “white space”). 
Corresponds to ASCII character codes (0 to 9 and 11 to 32, in decimal).
Do not include “<wsp>” in your program message; simply type a space.

<digit> Element used in the construction of various numeric data types. Can 
take any value between 0 and 9 inclusively (corresponds to ASCII 
character codes 48 to 57, in decimal).
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<mnemonic> Element used in the construction of certain data types and program 
messages.

In the diagram above, 

 “<Upper/lower case alpha>” corresponds to ASCII character codes 
(65 to 90 and 97 to 122, in decimal).

 “_” corresponds to an underscore character (code 95, in decimal).

< > Text appearing between angled brackets specifies the command 
parameter to be sent or the response you will receive from an 
instrument.
Do not include angled brackets in your program message.

| Indicates that one, and only one, value must be selected from the 
available choices.
Example: If the list is 0|1, you can only select 0 or 1.
Do not include the pipe character in your program message.

{ } Indicate that the enclosed parameters can appear 0 to n times when the 
command is used.
Do not include braces in your program message.

: Mandatory to separate keywords. Can be omitted at the beginning of a 
program message. For example, you can use either :SYST:ERR or 
SYST:ERR.

Item Meaning

<Upper/lower
case alpha>

<Upper/lower
case alpha>

_

<digit>
222 FTB-500



Using FTB Products in an Automated Test Environment
Consulting Data Types
There are also several conventions regarding command syntax:

 Spelling errors will cancel the command or query.

 Commands and queries are not case-sensitive. You can type your 
program messages using either lower-case or upper-case letters.

 The command or query can be written using only the three- or 
four-letter shortcuts, only full words, or a combination of both.

The example below shows the long and the short forms of a same 
query.

Consulting Data Types
If you need information about data types used in EXFO’s documentation, 
see the appendix on data types.

;  Mandatory to separate the different commands of a program 
message when more than one command is sent at a time. In this 
case, it is called <PROGRAM MESSAGE UNIT SEPARATOR>.

 Also used to separate responses when multiple queries were sent in 
a single program message. In this case, it is called <RESPONSE 
MESSAGE UNIT SEPARATOR>.

,  Mandatory to separate parameters in a command or a query. In this 
case, it is called <PROGRAM DATA SEPARATOR>.

 Also used to separate the various responses from a query. In this 
case, it is called <RESPONSE DATA SEPARATOR>.

Item Meaning

:SYSTem:ERRor?

:SYST:ERR?
:syst:err?

Long form

Short form (small words 
represented by the capital letters 
of the long form)
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Writing Remote Control Code
Complex measurement programs may be written using any programming 
environment that supports GPIB communication. GPIB development kits 
are available for most of the popular commercial programming languages.

The FTB-500 offers many commands permitting complete remote control 
of all the FTBcomponents. These commands adhere to the SCPI standard.

You can find all the commands and queries supported by the FTB-500 unit 
in the IEEE 488.2 and Specific Commands appendix. For information on 
commands specific to particular instruments, refer to the instrument’s user 
guide.
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When you write code, you must follow these rules on message reception 
and transmission:

 The controller must have sent a complete message to the instrument 
(including the message terminator) before retrieving a response.

 The controller must retrieve all the responses from previous queries 
(including the response terminator) before sending a new message to 
an instrument.

 The controller must not try to retrieve a response from an instrument if 
the corresponding query has not been previously sent to the 
instrument.

 You must pay special attention to queries that return an indefinite ASCII 
response. To avoid any confusion, the IEEE 488.2 standard requires that 
this data type be immediately followed by a response termination 
character. For this reason, when working with compound queries, you 
must ensure that a query sending an indefinite ASCII response is the 
last query of the series.

 Be careful when sending program messages containing multiple 
queries that return large amounts of data. Since the controller can only 
retrieve data when the instrument has finished processing the queries, 
it could result in problems ranging from a saturation of the output 
queue to the complete blocking of the whole system.
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Error Message Format
System and device-specific errors are managed by the FTB-500. The 
generic format for error messages is illustrated in the following figure.

As shown in the above figure, the message contains three parts: 

 error number

 error description

 device-dependent information

Error messages ending in a negative number are SCPI-based errors.

<Error
number> , " <Error

description> ; "
<Device

dependent
information>
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Working with EXFO COM Objects
The ToolBox CD offers you a demo application to show how to 
communicate with your FTB-500 using COM technology via the provided 
IcSCPIAccess interface.

The source files can be found on the CD under:
F:\examples\ScpiActiveX

where F corresponds to the CD-ROM drive (the CD-ROM drive letter may 
differ from one computer to another).

This application has been designed with Visual Basic and, therefore, must 
be compiled using Visual Basic 6.0, Service Pack 5.

With this demo application, you can control your FTB-500 either in local 
(COM technology) or remote (DCOM technology) mode.

If you want to work in remote mode, see the section on configuring DCOM 
access for your unit in this user guide.
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Working with EXFO LabVIEW Drivers
EXFO provides you with custom drivers that you can use to program 
commands for your inspection instruments.

Regardless of whether you work with the provided Getting Started 
applications or your own VIs (using EXFO drivers), the steps remain the 
same.

Before configuring the communication parameters via LabVIEW (provided 
applications or new VI), you must configure the FTB-500 for remote 
control. For more information, see the section on preparing your unit for 
automation in this user guide. 

IMPORTANT
You need to be familiar with the LabVIEW environment and 
programming methods to work with EXFO drivers.

IMPORTANT
Ensure that the communication type that you will set in LabVIEW 
matches the one selected for the FTB-500.

Perform all operations on 
instrument

Set up communication 
parameters

Open communication

Close communication
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The following table presents the possible settings for communication 
parameters. These parameters must be set from LabVIEW for each 
instrument.

Note: When you are working with platform or IEEE 488.2 commands, you can 
leave the slot number at its current value.

Parameter Active X
(local)

Active X
(remote)

RS-232
(remote)

Communication 
type

ActiveX ActiveX RS232

VISA resource 
name

N/A N/A Select the serial 
port from the list

FTB slot number Concatenation of 
the FTB-500 unit 
number (0) and 
the instrument’s 
slot number

Concatenation of 
the FTB-500 unit 
number (0) and 
the instrument’s 
slot number.

Concatenation of 
the FTB-500 unit 
number (0) and 
the instrument’s 
slot number.

Machine name localhost Ethernet address, 
that is
IP address or 
machine name of 
your FTB-500

N/A
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Using the EXFO Getting Started Applications
Once the LabVIEW drivers are installed, the Getting Started demo 
applications are available to demonstrate the following:

 How to open and close the communication link between the remote 
computer and the device.

 Some of the available functions (by loading the necessary .vi files).

All the .vi files related to an instrument are presented in the same folder. By 
default, they can be found under:

C:\Program Files\EXFO\LabVIEW Getting Started\Getting Started xxxx 
(where xxxx corresponds to the instrument code).

All Getting Started filenames follow this pattern: InstrumentxxxxTest.vi 
(where xxxx corresponds to the product code).

You can also directly start a demo application this way:

From the Windows task bar, click the Start button, then point to All 
Programs > EXFO > LabVIEW Getting Started Applications, and click 
Getting Started xxxx (where xxxx corresponds to the product code).

Each Getting Started application offers a user interface (called Front Panel 
and a design view (called Block Diagram).

Getting Started file
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On the Front Panel, you can set communication parameters between the 
FTB-500 and the current instrument. It also offers various controls and 
buttons to use the instrument easily. In fact, the application performs the 
necessary calls to the instrument’s drivers so it is transparent to the user.

The application state (called State Machine) changes whenever an action 
is performed on the instrument. If you toggle to Block Diagram view, you 
can see the list of possible states. The application is always in one of the 
predefined states.

Communication
indicator

(light green when
connected)

Communication
parameters

Function examples
FTB-500 231



Using FTB Products in an Automated Test Environment
Using the EXFO Getting Started Applications
The following figure illustrates the State Machine after the user has clicked 
on the button allowing you to set the source state (from the Front Panel). 
When the State Machine changes to “SetSourceState”, the application calls 
“Instrument2600bTest_SetSourceState.vi”, which, in turn, calls the 
“SourcePowerState_GSet.vi”sub VI that will perform the appropriate action 
on the instrument.

State Machine

Instrument2600bTest_SetSourceState.vi
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The detail of this sub VI gives precious information on how to call an 
instrument driver VI.

To use a Getting Started application:

1. Turn on the FTB-500, start ToolBox, and ensure that all the 
remote-control parameters are set correctly.

2. Open the desired Getting Started application and run it from LabVIEW.

3. From the application’s Front Panel, set the communication parameters.

For information on communication parameters, see Working with 
EXFO LabVIEW Drivers on page 228.

4. Once the parameters are configured, click Initialize Communication.

5. Using the provided buttons and controls, perform the desired actions.

Instrument driver VI
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6. When you are finished, select Close to end the communication.

7. Close LabVIEW.

IMPORTANT
To avoid losing the original version of the Getting Started 
applications, do not save changes when prompted by LabVIEW.
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Building and Using Custom VIs
EXFO LabVIEW drivers have been designed to let you control the various 
instruments according to your needs, by building your own VIs in LabVIEW.

You can access EXFO drivers

 directly from 
C:\Program Files\National Instruments\LabVIEW 6\instr.lib\EXFO

 from the LabVIEW function palettes

Each icon of the EXFO palette corresponds to a set of drivers that allow you 
to either

 communicate with EXFO instruments that support remote control

 open and close communication links with instruments

 send IEEE 488.2 (common) commands

 send platform commands (specific to FTB-500)

To send
IEEE 488.2
commands

To send platform 
commands

To open and close 
communication link

To control EXFO instruments 
(one icon per instrument)
FTB-500 235



Using FTB Products in an Automated Test Environment
Building and Using Custom VIs
When you click an icon in the EXFO palette, the corresponding sub-palette 
opens, giving you access to the different functions.

Red background:
write-only command (Set)

Blue background:
read-and-write command 
(Get/Set)

Yellow background:
read-only command (Get)

Symbols: refer to first keyword
of associated SCPI command
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Note: The procedure provided hereafter is for guidance only. The actual 
procedure may vary depending on the type of product you are using.

To build a custom VI:

1. Start LabVIEW and create a new VI.

2. Open the EXFO palette.

2a. From LabVIEW, open the Diagram Block view.

2b. Display the Functions palette and select Instrument I/O.

2b

2c

2d
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2c. From the Instrument I/O palette, select Instrument Drivers.

2d. From the Instrument Drivers palette, select EXFO.

3. Select EXFO IQS Base.

4. From the EXFO IQS Base palette, select EXIQSBASE_OpenComm.vi 
and add it to your new VI.

5. Set the communication parameters. For information on 
communication parameters, see Working with EXFO LabVIEW Drivers 
on page 228.

6. From the EXFO palette, select the desired instrument.

7. From the instrument’s palette, select the function you need and add 
the corresponding driver to your VI.
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8. Set the required parameters and connect the instrument 
Communication ID in parameter to the Communication ID out 
parameter fromEXIQSBASE_OpenComm.vi.

The example below shows how to configure the 
SourcePowerState_GSet.vi to turn on the  tunable lasersource.In this 
example, Set was chosen and the PowerState parameter was set to 
True.

9. Repeat steps 7 and 8 for each of the functions you want to use.

However, you have to link Communication ID in of the new driver to 
Communication ID out of the preceding driver.

Note: If you want to use platform or IEEE 488.2 commands, add the desired driver 
to your VI and configure its parameters exactly as you would do with any 
instrument function.
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10. When you are finished, add EXIQSBASE_CloseComm.vi to your VI.

Connect the Communication ID out parameter of the last function to 
the Communication ID in parameter of EXIQSBASE_CloseComm.vi.

Note: You only have to open communication once at the beginning, and close it 
when all of the desired functions will have been added.

11. Save your work.

To use your new VI:

1. Turn on the FTB-500, start ToolBox, and ensure that all the 
remote-control parameters are set correctly.

2. From LabVIEW, run the VI.
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Monitoring Remote Commands
ToolBox allows you to monitor remote commands sent to your units, if 
desired.

To monitor remote commands:

1. Select the Tools tab.

2. Depending on which type of communication protocol you are using, 
select IC Monitor or SCPI Telnet Monitor.
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3. Do one of the following:

 If monitoring using ActiveX or RS-232, click Connect to IC.

You are automatically connected to the monitoring system. The 
Disconnect from IC button becomes available for you when you 
are ready to disconnect.

Once connected, your current connection information will appear 
in the upper part of the window, and the commands will appear as 
a list in the lower part of the window.

With the History parameter, you determine how many commands 
you want to keep in the list. You can change the number by using 
the arrow buttons on each side of the list.

To clear the history, click .

To view the list in any word processor, click  to copy it to the 
clipboard, and then paste it in your document. You can use any 
program, as the list is copied in text format.

To exit the monitoring utility, click Exit.

For more information, see the section on using your unit in an 
automated test environment.

Connection 
information

Incoming 
commands
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 If monitoring using TCP/IP, which provides sending SCPI 
commands over TCP/IP through Telnet from the EXFO Instrument 
Control, you are automatically connected to the monitoring 
system.

Note: Port 5024 is designated for sending SCPI commands in the Telnet protocol.

Once connected, your current connection information will appear 
in the All Connections View tab, and the commands will appear as 
a list in the lower part of the window.

The Disconnect button becomes available for you to click when 
you are ready to disconnect.

Connection 
tabs

List of 
connections
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Connection information is also displayed in a separate tab, 
identified by its IP address, from where you can monitor the 
commands and other actions sent through TCP/IP over Telnet, as 
well as the results.

With the History parameter, you determine how many commands 
you want to keep in the list. You can increase or decrease the 
number by using the arrow buttons on each side of the list.

To clear the history, click Clear.

To view the list in any word processor, click Copy to copy it to the 
clipboard, and then paste it in your document. You can use any 
program, as the list is copied in text format.

To save the list as a file, click Save.

To exit the monitoring utility, click Exit.

For more information, refer to the user documentation about 
communication through TCP/IP over Telnet. 

Connection 
tabs

List of actions 
and results
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12 Maintenance
To help ensure long, trouble-free operation:

 Always inspect fiber-optic connectors before using them and clean 
them if necessary.

 Keep the unit free of dust.

 Clean the unit casing and front panel with a cloth slightly dampened 
with water.

 Store unit at room temperature in a clean and dry area. Keep the unit 
out of direct sunlight.

 Avoid high humidity or significant temperature fluctuations.

 Avoid unnecessary shocks and vibrations.

 If any liquids are spilled on or into the unit, turn off the power 
immediately, disconnect from any external power source, remove the 
batteries and let the unit dry completely.

WARNING
The use of controls, adjustments and procedures, namely for 
operation and maintenance, other than those specified herein may 
result in hazardous radiation exposure or impair the protection 
provided by this unit.
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Cleaning Detector Ports
Regular cleaning of detectors will help maintain measurement accuracy.

To clean detector ports:

1. Remove the protective cap and adapter (FOA) from the detector.

2. If the detector is dusty, blow dry with compressed air.

3. Being careful not to touch the soft end of the swab, moisten a cleaning 
tip with only one drop of isopropyl alcohol.

4. While applying light pressure (to avoid breaking the detector window), 
gently rotate the cleaning tip on the detector window.

5. Repeat step 4 with a dry cleaning tip or blow dry with compressed air.

6. Discard the cleaning tips after one use.

IMPORTANT
Always cover detectors with protective caps when unit is not in use.

IMPORTANT
Alcohol may leave traces if used abundantly. Do not use bottles that 
distribute too much alcohol at a time.
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Cleaning VFL-Type Connectors
VFL-type connectors are fixed on your unit and can be cleaned using a 
mechanical cleaner.

To clean a connector using a mechanical cleaner:

1. Insert the mechanical into the optical adapter, and push the outer shell 
into the cleaner.

Note: The cleaner makes a clicking sound to indicate that the cleaning is done. 

2. Verify connector surface with a portable fiber-optic microscope (for 
example, EXFO’s FOMS) or fiber inspection probe (for 
example, EXFO’s FIP).

WARNING
Verifying the surface of the connector with a fiber-optic microscope 
WHILE THE UNIT IS ACTIVE WILL result in permanent eye damage.
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Cleaning the Touchscreen
Clean the touchscreen with a soft, non-abrasive cloth, such as one used for 
cleaning reading glasses, dampened with water.

When not using your unit, EXFO recommends using the screen protector 
that came with it.

CAUTION
Using anything else than water can damage the special coating 
used for units equipped with an outdoor-enhanced screen 
(S2 option).
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Battery Maintenance Recommendations

 To ensure that batteries function or charge properly, keep them in 
temperatures between 10 oC and 40 oC (50 oF and 104 oF). Store below 
50 oC (122 oF).

 Leave the unit plugged in when not in use.

 Do not leave a battery discharged for several days.

 Remove the batteries if the unit will not be used for more than two 
weeks.

 After 300 cycles (approximately 18 months of use), replace the 
batteries with new ones to maintain optimal operation conditions. 
Otherwise, the operating time might be reduced.

 Li-Ion batteries that are not used for a long period of time (over three 
months) will not be damaged, but might need to be recalibrated.

IMPORTANT
Fully charge batteries before using the unit for the first time. New 
batteries are fully charged after approximately 4 hours or when the 

LED stops flashing.

WARNING
Do not throw batteries into fire or water and do not short-circuit 
the battery electrical contacts. Do not disassemble.
FTB-500 249



Maintenance
Inserting and Removing Batteries
Inserting and Removing Batteries
The FTB-500 can be powered either by batteries or from an appropriate 
power outlet when used with the provided power supply. 

For more information on the available power sources for your unit, as well 
as their characteristics, see Technical Specifications on page 295.

Note: Whenever batteries are inserted or removed, the FTB-500 will beep.

Before you go out in the field, make sure you install batteries in the unit 
unless you have an adequate and reliable power source.

To replace the batteries in the unit:

1. Place the FTB-500 with the screen facing down.

CAUTION
Your unit uses smart lithium-ion (Li-Ion) batteries with built-in 
protection that have been especially designed for EXFO. For this 
reason, you can only replace them with batteries of the same type 
and model.

The use of other batteries may damage your unit and compromise 
your safety.

IMPORTANT
To avoid losing test data that you have not saved, make sure at 
least one battery is always present in the unit if it is not under 
alternating current (AC).

IMPORTANT
When changing batteries, make sure that the unit is off or that the 
AC power is connected.
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2. Open the battery compartment located on the back panel of the unit 
by undoing the retaining screw (two retaining screws on the eight-slot 
model), then pulling the battery compartment door away.

3. Pull out one of the batteries using the tab.

Four-slot model

Eight-slot model
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4. Slide the new battery in, using the image below as a guide. It will not 
go in completely if inserted incorrectly.

5. Repeat steps 3 and 4 with the other battery (two remaining batteries 
for the eight-slot model).

6. Close the battery compartment and tighten the retaining screw back 
into position (two retaining screws on the eight-slot model).

Verifying Battery Status
The battery gauge located at the bottom of your screen indicates how 
much power you have left.

If you are using the FTB-500’s batteries, the gauge will show a battery icon. 

Battery poles

(-) 
T

D
 C

 (+
)

Negative end

Positive end Tab

Four-slot model

Eight-slot model
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If you are using alternating current (AC), the gauge will show an electric 
plug icon.

Tapping the icon will detail how much power is left for each battery in your 
unit. Should the batteries require a recalibration, you will be notified in the 
battery status window.

IMPORTANT
Your FTB-500 was set at the factory to warn you about low battery 
charge level (when it reaches about 10 %), and to shut down 
automatically when the batteries are at a very low charge level (less 
than 5 %). 

However, if you are using modules that are more demanding 
energy-wise, your unit will shut down automatically before it 
reaches 5 %. The charge level that triggers the automatic shutdown 
depends on the power required by the modules.

If you are using such modules often, you can set your unit through 
the Windows Control Panel to increase the value at which you will 
be warned of the low battery level and when the unit will shut 
down automatically. For more information about power 
management in Windows, refer to the corresponding online 
documentation.
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Recalibrating the Batteries
Depending on the way the unit is used, after a while, the charge status icon 
may no longer correspond to the actual power level of the batteries (for 
example, the battery LED is green and not blinking, which normally 
indicates that the batteries are fully charged, yet the battery gauge 
indicates that they are only charged at 85 % of their capacity). A complete 
calibration cycle will be necessary.

You can perform a recalibration with the battery calibration utility:

 The utility will charge the battery until it is full.

 It will then discharge the battery completely.

 You will have to let the battery recharge completely.

The whole calibration process can take several hours. You can stop the 
process at any time, but the battery will still need calibration and could be 
empty.

To recalibrate the batteries:

1. Select the Tools tab, then Battery Calibration.

IMPORTANT
During the calibration process, the unit will turn off. Do not restart 
the platform while the battery LED indicator is cycling through its 
green-red-yellow sequence. This will cancel the calibration process.
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2. Connect your unit to a power outlet using the provided AC 
adapter/charger or power supply.

3. Tap the Start Calibration button (the Stop Calibration button will 
become available). 

When a calibration step is underway, the on-screen LED preceding the 
step name appears in yellow. When a step is complete, the LED turns 
to green.

Once calibration is complete, the Start Calibration button becomes 
available again.
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Enabling Automatic Windows Updates
You can configure your unit to automatically search and install Windows 
updates to ensure that you benefit from the latest versions of the Windows 
applications. Your unit will need an Internet access for the updates.

Only the applications from Microsoft will be updated with the automatic 
Windows update feature. If you want to update EXFO applications, 
see Installing or Upgrading the Applications on page 36. The third-party 
applications will need to be updated manually.

CAUTION
DO NOT update the SumatraPDF reader (see Viewing PDF Files on 
page 94). Otherwise, you will lose the custom version prepared by 
EXFO for your unit. The application may no longer function 
properly. If you updated the SumatraPDF reader by mistake, 
see Solving Common Problems on page 263.

IMPORTANT
Before enabling the automatic Windows updates, ensure that you 
install the most recent System Upgrade kit for your unit. To do this, 
you will need a standard USB memory key and a computer with an 
Internet access. You can also retrieve the kits directly from your 
unit, provided that you have an Internet access.
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To enable the automatic updates for Windows applications:

1. From the main window, select the Tools tab.

2. Tap Control Panel.

3. Tap Automatic Updates.
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4. Select the update option that better suits your need.

5. Tap Apply to confirm the changes, and then OK to return to the 
Control Panel window.
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Replacing Fuses (Eight-Slot Model Only)
The unit contains two F6.3A L type fuses (5 mm x 20 mm (0.197 in x 
0.787 in), fast-acting, low-breaking capacity, 250 V). The fuse holder is 
located on the left panel of the unit, just below the power inlet.

To replace a fuse:

1. Turn off the unit and unplug the power cord.

2. Using a flat-head screwdriver as a lever, pull the fuse holder out of the 
unit.

3. Check and replace the fuses, if necessary.

4. Insert the new fuse into the fuse holder.

WARNING
Both neutral and live wires are energized. If a fuse is blown, make 
sure that no part of the unit remain energized when changing it.

Fuse holder

Fuse

Fuse holder
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5. Make sure the fuses are placed firmly in the holder prior to reinsertion.

6. Firmly push the fuse holder into place.

Recalibrating the Unit
EXFO manufacturing and service center calibrations are based on the 
ISO/IEC 17025 standard (General Requirements for the Competence of 
Testing and Calibration Laboratories). This standard states that calibration 
documents must not contain a calibration interval and that the user is 
responsible for determining the re-calibration date according to the actual 
use of the instrument.

The validity of specifications depends on operating conditions. For 
example, the calibration validity period can be longer or shorter depending 
on the intensity of use, environmental conditions and unit maintenance, as 
well as the specific requirements for your application. All of these elements 
must be taken into consideration when determining the appropriate 
calibration interval of this particular EXFO unit.

Under normal use, the recommended interval for your FTB-500 is: one 
year.

For newly delivered units, EXFO has determined that the storage of this 
product for up to six months between calibration and shipment does not 
affect its performance (EXFO Policy PL-03).
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To help you with calibration follow-up, EXFO provides a special calibration 
label that complies with the ISO/IEC 17025 standard and indicates the unit 
calibration date and provides space to indicate the due date. Unless you 
have already established a specific calibration interval based on your own 
empirical data and requirements, EXFO would recommend that the next 
calibration date be established according to the following equation:

Next calibration date = Date of first usage (if less than six months 
after the calibration date) + Recommended calibration period (one 
year) 

To ensure that your unit conforms to the published specifications, 
calibration may be carried out at an EXFO service center or, depending on 
the product, at one of EXFO’s certified service centers. Calibrations at 
EXFO are performed using standards traceable to national metrology 
institutes.

Note: You may have purchased a FlexCare plan that covers calibrations. See the 
Service and Repairs section of this user documentation for more 
information on how to contact the service centers and to see if your plan 
qualifies.

Recycling and Disposal 
(Applies to European Union Only)

For complete recycling/disposal information as per European Directive 
WEEE 2012/19/UE, visit the EXFO Web site at www.exfo.com/recycle. 
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13 Troubleshooting
Solving Common Problems

Before calling EXFO’s technical support, you may want to consider the 
following solutions to problems that could occur.

Problem Possible Cause Solution

My FTB-500 does not start.  It is not connected to a 
power source.

 Batteries are completely 
discharged.

 Windows startup files 
have been corrupted.

 The system has 
encountered a problem.

 Ensure that the power 
cord or power supply is 
connected to both the 
FTB-500 and the power 
inlet.

 Change or recharge the 
batteries.

 Contact EXFO.

 Press the On/Off button 
for ten seconds to 
reboot the system.

The screen remains black 
even if the FTB-500 is turned 
on.

The display parameters are 
not correctly set.

 If no external monitor is 
connected, press the 
backlight level button.

 If an external monitor is 
connected, verify the 
brightness settings in 
ToolBox.

My FTB-500 is not 
responding.

The system has 
encountered a problem.

Press the On/Off button for 
fifteen seconds to reboot the 
system. 
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The USB device I have just 
installed is not working.

 There might have been 
a problem during 
installation.

 You do not have the 
proper driver for this 
device.

 Disconnect, then 
reconnect the device.

 Turn off the FTB-500, 
then turn it on again.

 Ensure that you have the 
right driver (can be 
provided with the 
device itself).

The FTB-500 does not 
recognize a test module.

 Module application is 
not installed.

 Defective module.

 Install the 
corresponding 
application using the 
Update Manager 
application.

 If the FTB-500 
recognizes other 
modules, the faulty 
module could be 
defective. Return it to 
EXFO for repairs.

Express cards are not 
recognized at insertion.

You might not have the 
latest Express card driver.

Install the most recent 
Express card driver available 
for your card.

Problem Possible Cause Solution
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The 3G USB modem key is 
connected, but you are not 
able to access the Internet.

 There is no SIM card in 
the USB modem key.

Insert the SIM card into the 
USB modem key. For 
complete instructions, refer 
to the documentation that 
came with your modem key.

 The FTB-500 unit is not 
up to date.

Ensure that the latest System 
Upgrade and Platform kits 
are installed on your unit 
before connecting your USB 
modem key. For more 
information, see Accessing 
the Internet with a 3G USB 
Modem Key on page 97.

 The USB modem key is 
not detected properly.

Disconnect the modem key 
from your unit, and try 
connecting it again.

If the modem key is still not 
detected, try connecting it to 
another USB port.

 The SIM card has not 
been activated or there 
is a problem with 
service package that you 
purchased.

 There is a problem with 
the mobile network.

Contact your provider of 
mobile services.

Problem Possible Cause Solution
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(...continued) The 3G USB 
modem key is connected, 
but you are not able to 
access the Internet.

 A problem occurred 
during the installation of 
the AirCard Watcher 
application.

 From ToolBox, select the 
Tools tab, then tap 
Control Panel.

 Tap System, and then 
select the Hardware 
tab.

 Tap the Device Manager 
button.

 If the 3G USB modem 
key appears as an 
“Unknown Device”, 
remove the Sierra 
AirCard Watcher 
application with 
Add/Remove Programs, 
and then restart your 
unit.

 Return to the Device 
Manager.

 Select the USB modem 
key form the list of 
devices.

 From the Action menu, 
select Update Driver 
and let Windows search 
for the driver. 

Once the installation is 
complete, the USB modem 
key should be working 
properly.

Problem Possible Cause Solution
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The GPS USB key is not 
detected.

--- Disconnect the GPS key 
from your unit, and try 
connecting it again.

If the GPS key is still not 
detected, try connecting it to 
another USB port.

The SumatraPDF reader has 
been updated by mistake.

OR

The language that you have 
selected for the SumatraPDF 
reader is no longer 
available.

OR

The SumatraPDF reader is 
no longer working properly.

--- Restore your unit. To do so, 
see Restoring Your Unit to 
Normal Operation on 
page 272.

Batteries are not recharging.  Ambient temperature is 
too high or too low.

 The AC adapter is not 
connected properly.

 Make sure that the 
temperature in the 
location where you 
recharge the batteries is 
within the specifications

 Make sure that the AC 
power cord is 
connected to the unit 
and the wall inlet.

Problem Possible Cause Solution
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Battery indicator shows only 
a fraction of the power is 
left, but the batteries are 
fully charged.

(You are able to operate 
your unit, but the software 
automatically blocks when it 
reaches its set power 
threshold).

Battery needs to be 
recalibrated or changed.

 Use the battery 
calibration process 
explained in Equation  
on page 254.

 Change the batteries.

When I start the probe 
application, an error 
message warns me that the 
probe application is not 
installed on my unit.

The fiber inspection probe 
application is no longer 
installed on FTB-500 units by 
default.

Install the fiber inspection 
probe application 
(ConnectorMax) using 
Update Manager. For more 
information on how to 
install products, refer to the 
Update Manager online 
help. For more information 
on how to use the 
ConnectorMax application, 
refer to the corresponding 
online help.

When I start the probe 
application 
(ConnectorMax), the probe 
is no longer detected.

OR

No image is displayed in the 
probe application.

There may be a problem 
with the probe’s driver.

Install the latest System 
Upgrade kit on your unit, 
then try again.

Problem Possible Cause Solution
268 FTB-500



Troubleshooting
Solving Common Problems
My module does not seem 
to fit all the way inside the 
platform and I cannot lock it 
in place using the retaining 
screw.

You are using an older 
module with a rubber O ring 
directly behind the 
faceplate.

Remove the O ring simply by 
pulling it away from the 
module. The O ring will be 
permanently removed, but 
this does not affect the way 
your module will perform. 
Your module also remains 
fully functional on the other 
EXFO platforms

Problem Possible Cause Solution
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LED Indicator Color Codes
The LED indicators can convey different message depending on their 
colors and state.

LED Color and Status Message

Power  Green

 Green, 
blinking

 Unit on.

 Unit in Standby mode.

Battery (external 
power connected)

 Green

 Green, 
blinking

 Yellow, 
blinking

 Fully charged

 Charging

 Module using or could be using more 
power than what is available from 
batteries. Do not disconnect AC power 
while this module is in use. 

A blinking yellow LED takes precedence 
over a blinking green one, so when AC 
power is connected, even if the LED is 
blinking yellow, batteries are probably 
charging (depending on conditions).
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LED Color and Status Message

Battery (external 
power not 
connected)

 Not lit

 Yellow

 Yellow, 
blinking

 Red

 Above LOW charge level

 LOW charge level

 Module and platform could be using more 
power than what is available from the 
batteries at any time. Connect AC power 
as soon as possible.

 Battery error

Laser  Red, blinking  One or more laser sources are on.

Alarm Varied  Each application using the Alarm LED 
provides its alarm level to the platform 
when needed (Red/Yellow/Green/OFF).

 If more than one application uses the 
alarm LED, the LED is displayed using the 
color of the most severe alarm with red as 
the most severe, followed by yellow and 
finally green. 

 If more than one application uses the 
alarm LED, the LED is blinking.

Remote Control Green  Unit is controlled remotely.
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Restoring Your Unit to Normal Operation
Your FTB-500 is set to start using the standard Windows startup sequence. 
However, you can also use the emergency system tools feature if you need 
to:

 check the disk integrity

 back up some files directly onto a USB storage device for recovery 
purposes

 revert your unit to its initial state (as it was when you purchased it) or 
restore it with a specific Windows image (WIM) that could have been 
provided to you by EXFO customer service, for example.

CAUTION
 Before starting the recovery operation, connect your unit to a 

power outlet using the provided AC adapter/charger.

 DO NOT TURN OFF your unit while the recovery operation is 
underway. Doing so may severely damage your unit. Damaged 
units will need to be sent back to EXFO for repair.
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Note: You may find useful to connect a keyboard and a mouse to your unit before 
using the emergency system tools.

IMPORTANT
Restoring the system partition will format the unit’s C drive and 
replace what is currently installed on your unit with the image you 
choose. This operation cannot be undone or stopped once it is 
started.

If you have installed other products that are not included in your 
image file, you will have to reinstall them afterwards.

To avoid loosing the data that is stored on the D drive, you may 
want to back it up before restoring the system partition. Otherwise, 
all your files will be lost.
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To restore the system partition:

1. Turn on the FTB-500.

2. While the system is displaying the boot menu (3 seconds), press .

 OR

Press any key on the keyboard (if you have connected one).

3. Press  to select the emergency system tools operation mode, then 
LOCAL to confirm your choice.

Note: The touchscreen becomes effective at this point.
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4. From the main window, select Restore system partition from an 
image, then tap Next.

5. Select which image (.wim file) you want to use. An image file is 
available on the E drive. However, you can use an image file that you 
have on a USB storage device. Use the Browse button to locate the 
image file that you want to use.
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6. Tap Next to proceed to the next step.

7. Tap Next to start the restoration process. The unit will restart upon 
completion of the process.
276 FTB-500



Troubleshooting
Restoring Your Unit to Normal Operation
To retrieve data from the D drive:

1. Turn on the FTB-500.

2. While the system is displaying the boot menu (3 seconds), press .

 OR

Press any key on the keyboard (if you have connected one).

3. Press  to select the emergency system tools operation mode, then 
LOCAL to confirm your choice.

Note: The touchscreen becomes effective at this point.

4. From the main window, select Backup data and configuration files 
to USB flash drive, then tap Next.
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5. Select the files to back up. 

A green check mark indicates a selection of the entire folder 
(subfolders and files). A shaded check box indicates that not all of the 
files of subfolders are selected.

6. If the USB device you want to use is not connected to the unit, connect 
it now so that the system can find it. Tap Next.
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7. Select the USB device onto which you want to save the data from the 
list of available devices.

Note: If you have forgotten to connect the USB device at this point and that it does 
not show up in the list, tap Back, connect the device, then tap Next to 
return to this window.

8. Tap Next to start the file copy process.

A progress bar indicates which files are being copied. If you tap Cancel 
while the transfer is in progress, any file that was copied onto the USB 
device will still be on the USB device.

9. Once the transfer is complete, tap Cancel to return to the main 
window.
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To verify disk integrity:

1. Turn on the FTB-500.

2. While the system is displaying the boot menu (3 seconds), press .

 OR

Press any key on the keyboard (if you have connected one).

3. Press  to select the emergency system tools operation mode, then 
LOCAL to confirm your choice.

Note: The touchscreen becomes effective at this point.

4. From the main window, select Check disk integrity, then tap Next.
280 FTB-500



Troubleshooting
Restoring Your Unit to Normal Operation
5. Tap Next to start the disk analysis.

Once the analysis is complete, you can view a report on each drive by 
tapping Details.

6. Tap OK once you have finished.

7. To exit the integrity analysis tool, tap Cancel to return to the main 
window. 
FTB-500 281



Troubleshooting
Accessing Online Help
Accessing Online Help
You can either access the online help for the platform itself, or obtain more 
information about the modules currently in the unit. Each module also has 
its own online help accessed independently.

Accessing the Platform Online Help

The platform online help is conveniently available from the Main Menu.

To open the online help file:

From the Main Menu, tap Help.
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Viewing Information about the Modules

You can obtain more information on the modules that are currently 
inserted in your unit.

For information on how to start an application, see Starting Module 
Applications on page 40.

To use the Module Information feature:

1. From the Modules tab, select the module for which you want more 
information. The corresponding Module Applications section will 
appear.

2. Tap Module Information. 

A pop-up window containing more information on the module 
appears.

3. When you have finished reading the information, simply close the 
window.
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Contacting the Technical Support Group
To obtain after-sales service or technical support for this product, contact 
EXFO at one of the following numbers. The Technical Support Group is 
available to take your calls from Monday to Friday, 8:00 a.m. to 7:00 p.m. 
(Eastern Time in North America).

 

For detailed information about technical support, and for a list of other 
worldwide locations, visit the EXFO Web site at www.exfo.com.

If you have comments or suggestions about this user documentation, you 
can send them to customer.feedback.manual@exfo.com.

To accelerate the process, please have information such as the name and 
the serial number (see the product identification label), as well as a 
description of your problem, close at hand.

Technical Support Group
400 Godin Avenue
Quebec (Quebec) G1M 2K2
CANADA

1 866 683-0155 (USA and Canada)
Tel.: 1 418 683-5498
Fax: 1 418 683-9224
support@exfo.com
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Viewing System Information
The System Information function tab contains important information on 
your unit. Should you need to contact the technical support group, this is 
the location where you can find information they may require to help you, 
such as version numbers for kits and components.

Consulting the About Tab

The About tab contains information on how to contact EXFO should you 
need to do so. 

To access the About tab:

1. Tap the System Information function tab.
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2. Select the About tab to view information on your unit.
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Viewing Platform-Related Information

You might need information specific to the platform, such as component 
versions, when calling EXFO’s technical support team.

To access the Platform tab:

1. Tap the System Information function tab.
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2. Select the Platform tab.

Transportation
Maintain a temperature range within specifications when transporting the 
unit. Transportation damage can occur from improper handling. The 
following steps are recommended to minimize the possibility of damage:

 Pack the unit in its original packing material when shipping.

 Avoid high humidity or large temperature fluctuations.

 Keep the unit out of direct sunlight.

 Avoid unnecessary shocks and vibrations.
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14 Warranty
General Information

EXFO Inc. (EXFO) warrants this equipment against defects in material and 
workmanship for a period of one year from the date of original shipment. 
EXFO also warrants that this equipment will meet applicable specifications 
under normal use.

During the warranty period, EXFO will, at its discretion, repair, replace, 
or issue credit for any defective product, as well as verify and adjust the 
product free of charge should the equipment need to be repaired or if the 
original calibration is erroneous. If the equipment is sent back for 
verification of calibration during the warranty period and found to meet all 
published specifications, EXFO will charge standard calibration fees.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES EXPRESSED, 
IMPLIED, OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. IN NO EVENT SHALL EXFO BE LIABLE FOR 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

IMPORTANT
The warranty can become null and void if:

 unit has been tampered with, repaired, or worked upon by 
unauthorized individuals or non-EXFO personnel.

 warranty sticker has been removed.

 case screws, other than those specified in this guide, have been 
removed.

 case has been opened, other than as explained in this guide.

 unit serial number has been altered, erased, or removed.

 unit has been misused, neglected, or damaged by accident.
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Liability
EXFO shall not be liable for damages resulting from the use of the product, 
nor shall be responsible for any failure in the performance of other items to 
which the product is connected or the operation of any system of which 
the product may be a part.

EXFO shall not be liable for damages resulting from improper usage or 
unauthorized modification of the product, its accompanying accessories 
and software.
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Exclusions
EXFO reserves the right to make changes in the design or construction of 
any of its products at any time without incurring obligation to make any 
changes whatsoever on units purchased. Accessories, including but not 
limited to fuses, pilot lamps, batteries and universal interfaces (EUI) used 
with EXFO products are not covered by this warranty.

This warranty excludes failure resulting from: improper use or installation, 
normal wear and tear, accident, abuse, neglect, fire, water, lightning or 
other acts of nature, causes external to the product or other factors beyond 
the control of EXFO.

Certification
EXFO certifies that this equipment met its published specifications at the 
time of shipment from the factory.

IMPORTANT
In the case of products equipped with optical connectors, EXFO will 
charge a fee for replacing connectors that were damaged due to 
misuse or bad cleaning.
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Service and Repairs
Service and Repairs
EXFO commits to providing product service and repair for five years 
following the date of purchase.

To send any equipment for service or repair:

1. Call one of EXFO’s authorized service centers (see EXFO Service 
Centers Worldwide on page 293). Support personnel will determine if 
the equipment requires service, repair, or calibration.

2. If equipment must be returned to EXFO or an authorized service 
center, support personnel will issue a Return Merchandise 
Authorization (RMA) number and provide an address for return.

3. If possible, back up your data before sending the unit for repair.

4. Pack the equipment in its original shipping material. Be sure to include 
a statement or report fully detailing the defect and the conditions under 
which it was observed.

5. Return the equipment, prepaid, to the address given to you by support 
personnel. Be sure to write the RMA number on the shipping slip. EXFO 
will refuse and return any package that does not bear an RMA number.

Note: A test setup fee will apply to any returned unit that, after test, is found to 
meet the applicable specifications.

After repair, the equipment will be returned with a repair report. If the 
equipment is not under warranty, you will be invoiced for the cost 
appearing on this report. EXFO will pay return-to-customer shipping costs 
for equipment under warranty. Shipping insurance is at your expense.

Routine recalibration is not included in any of the warranty plans. Since 
calibrations/verifications are not covered by the basic or extended 
warranties, you may elect to purchase FlexCare Calibration/Verification 
Packages for a definite period of time. Contact an authorized service center 
(see EXFO Service Centers Worldwide on page 293).
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EXFO Service Centers Worldwide
EXFO Service Centers Worldwide
If your product requires servicing, contact your nearest authorized service 
center.

EXFO Headquarters Service Center
400 Godin Avenue
Quebec (Quebec) G1M 2K2
CANADA

1 866 683-0155 (USA and Canada)
Tel.: 1 418 683-5498
Fax: 1 418 683-9224
support@exfo.com 

EXFO Europe Service Center
Winchester House, School Lane
Chandlers Ford, Hampshire S053 4DG
ENGLAND

Tel.: +44 2380 246800
Fax: +44 2380 246801
support.europe@exfo.com 

EXFO Telecom Equipment
(Shenzhen) Ltd.
3rd Floor, Building 10,
Yu Sheng Industrial Park (Gu Shu 
Crossing), No. 467, 
National Highway 107, 
Xixiang, Bao An District, 
Shenzhen, China, 518126

Tel: +86 (755) 2955 3100
Fax: +86 (755) 2955 3101
support.asia@exfo.com 
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A Technical Specifications
IMPORTANT

The following technical specifications can change without notice. 
The information presented in this section is provided as a reference 
only. To obtain this product’s most recent technical specifications, 
visit the EXFO Web site at www.exfo.com.

SPECIFICATIONS a

Central processing unit (CPU) Intel Core 2 Duo

Display Touchscreen, color TFT, 800 x 600 TFT, 307 mm (12.1 in)

Interfaces Ethernet port
Fiber probe port
ExpressCard port 34 mm format
Serial RS-232 port
Monitor port 
Four USB 2.0 ports
Standard PC Mic in and Speaker out ports (3.5 mm)

Storage Internal 80 GB hard drive minimum with G-shock protection
Flash USB drive (1 GB, 2 GB and 8 GB optional)
ExpressCard memory card (16 GB and up, optional)
External USB read/write DVD drive (optional)

Batteries b

Power supply 100–240 VAC, 50/60 Hz

GENERAL SPECIFICATIONS
Temperature
 operating
 storage c

0 ºC to 50 ºC (32 ºF to 122 ºF)
–40 ºC to 70 ºC (–40 ºF to 158ºF)

Relative humidity 0 % to 95 % (non-condensing)

Size (H x W x D) Eight-slot configuration: 366 mm x 296 mm x 216 mm (11 11/16 in x 14 7/16 in x 8 ½ in)
Four-slot configuration: 366 mm x 296 mm x 146 mm (11 11/16 in x 14 7/16 in x 5 ¾ in)

Weight d Eight-slot configuration: 10.9 kg (24 lb)
Four-slot configuration: 8.5 kg (18.7 lb)

CE compliance, CSA, EU WEEE, China RoHS

ACCESSORIES
GP-10-047B Semi-rigid carrying case with wheels and handle (four-slot platform) GP-2091 USB keyboard (USB port)

GP-10-056B Semi-rigid carrying case with wheels and handle (eight-slot platform) GP-2092 USB memory stick (8 GB) 

GP-10-075 Universal hard carrying case (eight-slot platform) GP-2093 ExpressCard Wi-Fi

GP-10-078 Universal hard carrying case (four-slot platform) GP-2095 Headset

GP-302 USB mouse GP-2096 USB A-A for master-to-master communication

GP-2016 RJ-45 LAN cable (10 ft) GP-2100 DVD ±R writable 8x external USB 2.0

GP-2028 Computer security cable kit GP-2101 Cable RS232 straight F-M

GP-2086 Bluetooth USB Adapter GP-2112 3G Universal USB Dongle

GP-2090 Extra Li-ion smart battery GP-2113 GPS USB Dongle
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Technical Specifications
Notes

a.  All specifications valid at 23 °C (73 °F).

b.  Standard recharge time is 4 h. Recharge temperature: 0 °C to 45 °C (32 °F to 113 °F).

c.  Not including internal batteries. Battery storage temperatures: —20 ºC to 60 ºC (—4 °F to 140 °F) for shipping, and  —20 ºC to 45 ºC (—4 °F to 113 °F) for long-term storage.

d.  Platform with batteries (three for the eight-slot configuration, and two for the four-slot configuration) and without modules.

e.  At 23 ºC ± 1 ºC, at 1550 nm and with an FC connector. With modules in idle mode. Battery-operated.

f.  For ±0.05 dB, from 18 ºC to 28 ºC.

PM-500 BUILT-IN POWER METER SPECIFICATIONS (OPTIONAL) e

Calibrated wavelengths (nm) 850, 1300, 1310, 1490, 1550, 1625, 1650

Power range (dBm) 10 to —86

Uncertainty (%) e ±5 % ± 3 pW (up to 5 dBm)

Display resolution (dB)
0.01 = max to —76 dBm
0.1 = —76 dBm to —86 dBm

Automatic offset nulling range f Max power to —63 dBm

Tone detection (Hz) 270/1000/2000

VISUAL FAULT LOCATOR (VFL) (OPTIONAL)
Laser, 650 nm ±10 nm 

CW

Typical Pout in 62.5/125 μm: 2 dBm (1.6 mW)

LASER SAFETY

21 CFR 1040.10 AND IEC 60825-1:2007
CLASS 3R WITH VFL OPTION

LASER RADIATION
AVOID DIRECT EYE EXPOSURE

CLASS 3R LASER PRODUCT

IEC 60825-1:2007
21 CFR 1040.10 

l: 650 ±10 nm
Pout maximum < 5mW (into free space)
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B Data Types
The following section provides an overview of the most common data 
types that may appear in EXFO’s documentation on commands and 
queries. The information is supplied for guidance only.

For more detailed information, please refer to IEEE 488.2 and SCPI 
standards.

Data types are divided into two groups: <PROGRAM DATA> for the types 
that are used when you want to send messages to a device and 
<RESPONSE DATA> for the types that are used when a device sends 
responses to the controller. 

The data types are presented in graphics often referred to as “railroad 
diagrams”. The following example illustrates how to interpret such 
diagrams.

<Upper/lower
case alpha>

<Upper/lower
case alpha>

_

<digit>

Entry Exit

The reverse arrow indicates that 
the item specified in the box can 
be repeated several times

The splitting arrow indicates a
choice of items

In circles: literal 
items (to be 
typed as such)

In boxes: syntactic
items (use the

elements to which
they refer)
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Data Types
Applicable Data Types for Input—IEEE 488.2
Applicable Data Types for Input—IEEE 488.2
 <PROGRAM MESSAGE TERMINATOR>

In the diagram above, 

 “NL” corresponds to ASCII character code 10, in decimal (0A in 
binary)

 “END^” corresponds to the last data byte of the message sent with 
EOI = True and ATN =  False

<wsp> NL END^

NL

END^
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Data Types
Applicable Data Types for Input—IEEE 488.2
 <CHARACTER PROGRAM DATA>

This data type will be used to send short mnemonics when a 
<DECIMAL NUMERIC PROGRAM DATA> cannot be used.

Examples: TRIANGLEWAVE, NCONTINUOUS

 <DECIMAL NUMERIC PROGRAM DATA> (or <NRf>)

This data type includes <NR1>, <NR2> and <NR3> data types. It will 
be used for decimal fractions with or without an exponent. Instruments 
will adapt the values they receive to fit their degree of precision. For 
example, if an instrument has a precision of two digits after the 
decimal point and the incoming value is 12.048, this value will be 
rounded off to 12.05.

The second diagram below illustrates the <mantissa> syntax.

The third diagram illustrates the <exponent> syntax.

Examples: +2.0 e5, –.56E+4, 6.5e–10

<mantissa> <wsp> <exponent>

+

-

<digit> . <digit>

<digit> <digit>.

E/e <wsp>

+

-

<digit>
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Data Types
Applicable Data Types for Input—IEEE 488.2
 <NON-DECIMAL NUMERIC PROGRAM DATA>

This data type will be used for integer representation in hexadecimal 
(base 16), octal (base 8) or binary (base 2). The numeric 
representations will begin with “#H” for hexadecimal, “#Q” for octal 
and “#B” for binary.

Examples: #Hf3bc015d, #h01a4, #hfe

# H/h C/c

B/b

A/a

D/d

E/e

<digit>

F/f
300 FTB-500



Data Types
Applicable Data Types for Input—IEEE 488.2
Examples: #Q1234567, #q1275, #q07

Examples: #B10010111, #b10110, #b1100

# Q/q

2

1

0

3

4

5

6

7

# B/b

0

<digit>

# B/b

1

0
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Data Types
Applicable Data Types for Input—IEEE 488.2
 <STRING PROGRAM DATA>

This data type will be used for strings containing 7-bit ASCII characters 
that have to be enclosed in either single- or double-quotes delimiters.

If a string needs to contain a character that is exactly the same as the 
delimiter, make sure to double the character to avoid syntax errors.

Examples: "SCPI Commands", ’SCPI Commands’, "SCPI ’Commands’", 
’SCPI "Commands"’, "SCPI ""Commands""", ’SCPI ’’Commands’’’

'

<inserted '>'

<non single
quote char>

'

"

<inserted ">"

<non single
quote char>

"
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Data Types
Applicable Data Types for Input—IEEE 488.2
 <ARBITRARY BLOCK PROGRAM DATA>

This data type is used to send blocks of arbitrary 8-bit information 
when you need to work with large amounts of data.

The actual length of the data that you send has the following structure:

 The first byte contains the # character.

 The byte that immediately follows contains the number of 
subsequent bytes that you have to check to obtain the total length.

Note: If you use a zero as the first digit (#0), it has to be followed by a 
<PROGRAM MESSAGE TERMINATOR > so that the device will detect the 
end of the <ARBITRARY BLOCK PROGRAM DATA>. This will also force 
immediate termination of the message.

For example, if you send the following data (here, values are expressed 
in decimal instead of binary for easier readability):

# 2 1 3 7 6 8 9 2 ...

The byte that immediately follows the # contains 2, which means that 
you would have to read the two following bytes to know the length (in 
bytes) of the retrieved data. The bytes indicate 1 and 3. The length will 
then be 13 bytes. The actual response will begin at byte number 5, in 
this case.

#

<non-zero
digit>

<digit>
<8-bit data

byte>

0 <8-bit data
byte>

<PROGRAM MESSAGE
TERMINATOR>
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Data Types
Applicable Data Types for Input—IEEE 488.2
 <SUFFIX PROGRAM DATA>

This data type is used when units and multipliers have to be sent.

Examples: nm, kHz, km/s2, uW

A relative unit (dB) can be referenced to an absolute level, as shown on the 
following diagram.

Examples: db, dbm, dBW

<wsp> /

<suf f ix unit>

<suf f ix mult.> <suf f ix unit>

<digit>-

- <digit>

/

.

D/d B/b <suf f ix mult.> <suf f ix  unit>
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Data Types
Applicable Data Types for Input—IEEE 488.2
The following table illustrates the possible forms for <suffix mult.>:

Name Value Mnemonic

Exa 1E18 EX

Peta 1E15 PE

Tera 1E12 T

Giga 1E9 G

Mega 1E6 MA

Kilo 1E3 K

Milli 1E-3 M

Micro 1E-6 U

Nano 1E-9 N

Pico 1E-12 P

Femto 1E-15 F

Atto 1E-18 A
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Data Types
Applicable Data Types for Input—IEEE 488.2
The table below gives the possible forms for <suffix unit>: 

Reference Unit Suffix Unit

Degrees DEG

Radians RAD

Amperes A

Volts V

Hertz HZ

Meters M

Watts W

DBs ref to 1mW DBM

Decibels DB

Degrees Celsius CEL

Degrees Fahrenheit FAR

Kelvins K

Seconds S

Hours HR

Minutes MIN
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Data Types
Applicable Data Types for Output —IEEE 488.2
Applicable Data Types for Output —IEEE 488.2
 <RESPONSE MESSAGE TERMINATOR>

In the diagram above, 

 “NL” corresponds to ASCII character code 10, in decimal (0A in 
binary)

 “END^” corresponds to the last data byte of the message sent with 
EOI = True and ATN =  False

 <CHARACTER RESPONSE DATA>

This data type will be used by a device to return short mnemonics 
when a <DECIMAL NUMERIC PROGRAM DATA> cannot be used. The 
returned information is sent in the long form and in upper case.

Examples: TRIANGLEWAVE, NCONTINUOUS

NL END^
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Data Types
Applicable Data Types for Output —IEEE 488.2
 <NR1 NUMERIC RESPONSE DATA> (or <NR1>)

This data type will be used by a device to return positive or negative 
integers.

Examples: 4, –23, 90

 <NR2 NUMERIC RESPONSE DATA> (or <NR2>)

This data type will be used by a device to return positive or negative 
real numbers (fixed-point numbers).

Examples: 23.45, 1.22, –4.55

+

-

<digit>

.
+

-

<digit> <digit>
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Data Types
Applicable Data Types for Output —IEEE 488.2
 <NR3 NUMERIC RESPONSE DATA> (or <NR3>)

This data type will be used by a device to return positive or negative 
exponential numbers (floating-point numbers).

Examples: 4.3E–3, –8.9456E8, 123E–5

E
+

-

<digit>

.
+

-

<digit> <digit>
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Data Types
Applicable Data Types for Output —IEEE 488.2
 Special Numeric Values Received on Output

In some cases, an instrument may send values indicating that an 
unusual event has occurred. The following tables present the possible 
values.

Value is ASCII 4 bytes PACKED 4 bytes

Under range 2143289345.000000 7FC00001

Over range 2143289346.000000 7FC00002

Invalid 2143289347.000000 7FC00003

Inactive 2143289348.000000 7FC00004

Value is ASCII 8 bytes PACKED 8 bytes

Under range 9221120237577961472 7FF8000020000000

Over range 9221120238114832384 7FF8000040000000

Invalid 9221120238651703296 7FF8000060000000

Inactive 9221120239188574208 7FF8000080000000
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Data Types
Applicable Data Types for Output —IEEE 488.2
 <HEXADECIMAL NUMERIC RESPONSE DATA>

This data type will be used by a device to return integer representations 
in hexadecimal (base 16).

Examples: #HA3C5, #H0123C, #H010F

# H C

B

A

D

E

<digit>

F
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Data Types
Applicable Data Types for Output —IEEE 488.2
 <OCTAL NUMERIC RESPONSE DATA>

This data type will be used by a device to return integer representations 
in octal (base 8).

Examples: #Q753214, #Q0124, #Q0725

# Q

2

1

0

3

4

5

6

7
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Data Types
Applicable Data Types for Output —IEEE 488.2
 <BINARY NUMERIC RESPONSE DATA>

This data type will be used by a device to return integer representations 
in binary (base 2).

Examples: #B11011110101, #B110100, #B0100

 <STRING RESPONSE DATA>

This data type will be used by a device to return strings containing 7-bit 
ASCII characters and especially when text has to be displayed since 
even the non-printable characters are also returned.

Examples: "SCPI Commands", "SCPI ""Commands"""

# B

1

0

"

<inserted ">"

<non-single
quote char>

"
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Data Types
Applicable Data Types for Output —IEEE 488.2
 <DEFINITE LENGTH ARBITRARY BLOCK RESPONSE DATA>

This data type is used by a device to return blocks of 8-bit binary 
information with a fixed and predetermined length.

The actual length of the retrieved data has the following structure:

 The first byte contains the # character.

 The byte that immediately follows contains the number of 
subsequent bytes that you have to check to know the total length. 

For example, if you receive this response (here, values are expressed 
in decimal instead of binary for easier readability):

# 2 1 3 7 6 8 9 2 ...

The byte that immediately follows the # contains 2, which means that 
you have to read the two following bytes to know the length (in bytes) 
of the retrieved data. The bytes indicate 1 and 3. The length will then 
be 13 bytes. The actual response will begin at byte number 5, in this 
case.

Examples: #14<DAB><DAB><DAB><DAB>, 
#3004<DAB><DAB><DAB><DAB>

where “<DAB>” stands for data byte

# <non-zero
digit>

<digit>
<8-bit data

byte>
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Applicable Data Types for Output —IEEE 488.2
 <INDEFINITE LENGTH ARBITRARY BLOCK RESPONSE DATA>

This data type is used by a device to return blocks of 8-bit binary 
information when the block length was not predefined or when data 
has to be computed later.

Note: If you receive a zero as the first digit (#0), it is necessarily followed by a 
<RESPONSE PROGRAM MESSAGE TERMINATOR> so that you will detect 
the end of the <INDEFINITE LENGTH ARBITRARY BLOCK RESPONSE 
DATA>.

Example: #0<DAB><DAB><DAB><DAB><terminator> where 
“<DAB>” stands for data byte.

# 0 <8-bit data
byte>

<RESPONSE MESSAGE
TERMINATOR>
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Applicable Data Types for Output —IEEE 488.2
 <SUFFIX RESPONSE DATA>

This data type is used by a device to return units and multipliers.

Examples: DBW, W, KHZ

 <ARBITRARY ASCII RESPONSE DATA>

This data type is used by a device to return information when it is 
impossible to use any other data type.

Example: To the *IDN? query, the device will return this response in an 
arbitrary ASCII bytes format:
EXFO E.O. Engineering,,125-2A55,1.0.1.97

/

<suf f ix unit>

<suf f ix mult.> <suf f ix unit>

<digit>-

- <digit>

/

.

<ASCII data
by te>

<RESPONSE MESSAGE
TERMINATOR>
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Data Types
Applicable Data Types for Input—SCPI
Applicable Data Types for Input—SCPI
SCPI data types include the IEEE 488.2 data types (see Applicable Data 
Types for Input—IEEE 488.2 on page 298) with certain additional 
restrictions.

 <numeric_value>: abbreviated form of the decimal numeric element. 
It differs from the <DECIMAL NUMERIC PROGRAM DATA> “<NRf>” 
described in IEEE 488.2.

Several forms of <CHARACTER PROGRAM DATA> are defined as 
special forms of numbers. These are: MINimum, MAXimum, DEFault, 
UP, DOWN, Not A Number (NAN), INFinity and Negative INFinity 
(NINF). The following special forms are likely to be used by EXFO’s 
instruments in certain commands or queries:

 DEFault: This special <numeric_value> parameter forces the 
instrument to select a value, which is deemed to be convenient to 
the user.

 MINimum|MAXimum: These special <numeric_value> 
parameters refer to the instrument’s limit values. MINimum 
corresponds to the value closest to negative infinity that the 
function can accept. MAXimum corresponds to the largest value 
that the function can accept.

 <Boolean Program Data>: This form is often used as a shorthand 
of the <DECIMAL NUMERIC PROGRAM DATA>ON|OFF form. 

<Boolean Program Data> parameters have a value of 0 or 1 and 
are not followed by any unit. 

On input, an <NRf> is rounded to an integer.

A non-zero result is interpreted as 1.

ON and OFF are accepted on input for readability purposes. They 
correspond respectively to 1 and 0. However, on output, they 
appear as 1 or 0, never ON or OFF.
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Data Types
Special Numeric Values Received on Output
Special Numeric Values Received on Output
It is possible that an instrument returns unusual values in certain cases. For 
information on these values, see Applicable Data Types for Output —IEEE 
488.2 on page 307.
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C IEEE 488.2 and Specific 
Command Reference

This chapter presents detailed information about the commands and 
queries supplied with your FTB-500.

IEEE 488.2 Commands–Quick Reference
The FTB-500 recognizes the required commands identified in IEEE 488.2. 
The table below summarizes these commands. These commands are fully 
explained on the following pages.

Command Function

*CLS Clear status command

*ESE Standard event status enable command

*ESE? Standard event status enable query

*ESR? Standard event status register query

*IDN? Identification query

*OPC Operation complete command

*OPC? Operation complete query

*RST Reset command

*SRE Service request enable command

*SRE? Service request enable query

*STB? Read status byte query

*TST? Self-test query

*WAI Wait for pending operations to be completed
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
IEEE 488.2 Required Commands

*CLS
Description The *CLS command clears the Standard Event 

Status Register and the Error/Event Queue.

Syntax *CLS

Parameter(s) None
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
*ESE
Description The *ESE command sets the Standard Event 

Status Enable Register bits, as defined in the 
table below. This register contains a mask value 
for the bits to be enabled in the Standard Event 
Status Register. 

Syntax *ESE<wsp><RegisterValue>

Parameter(s) RegisterValue: 

The program data syntax for <RegisterValue> is 
defined as a <DECIMAL NUMERIC PROGRAM 
DATA> element.

The <RegisterValue>, expressed in base 2, 
represents the bit values of the Standard Event 
Status Enable Register.

PON URQ CME EXE DDE QYE N.U. OPC

MSB LSBStandard Event Status Enable Register
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
 The table below shows the contents of this 
register.

A value of 1 in the Enable Register enables the 
corresponding bit in the Status Register, a value 
of 0 disables the bit. The value of the 
<RegisterValue> shall be in the range of 0 
through 255.

Example(s) *ESE 25 
where 25 = (bit EXE, bit DDE and bit OPC)

*ESE 0 
clears the content of the Standard Event Status 
Enable register

See Also *ESE?
*ESR?

*ESE

Bit Weight Meaning

PON 128 Power ON Enable

URQ 64 User ReQuest Enable

CMD 32 CoMmanD Error Enable

EXE 16 Execution Error Enable

DDE 8 Device Dependent Error Enable

QRY 4 QueRry Error Enable

N.U. 2 Not used

OPC 1 Operation Complete Enable
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
*ESE?
Description With the *ESE? query you can determine the 

current contents of the Standard Event Status 
Enable Register. See the contents of this register 
below.

Syntax *ESE?

Parameter(s) None

Response Syntax <RegisterValue>

PON URQ CME EXE DDE QYE N.U. OPC

MSB LSBStandard Ev ent Status Enable Register
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
Response(s) RegisterValue: 

The response data syntax for <RegisterValue> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <RegisterValue> ranges from 0 through 255.

The <RegisterValue> value expressed in base 2 
(binary) represents the bit values of the Standard 
Event Status Enable register. See below.

Example(s) *ESE?  returns 133
where 133 = (bit PON, bit QYE and bit OPC)

See Also *ESE
*ESR?

*ESE?

Bit Weight Meaning

PON 128 Power ON Enable

URQ 64 User ReQuest Enable

CMD 32 CoMmanD Error Enable

EXE 16 Execution Error Enable

DDE 8 Device Dependent Error Enable

QRY 4 QueRry Error Enable

N.U. 2 Not used

OPC 1 Operation Complete Enable
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
*ESR?
Description With the *ESR? query you can determine the 

current contents of the Standard Event Status 
Register. Reading the Standard Event Status 
Register clears it. See the contents of this register 
below.

Syntax *ESR?

Parameter(s) None

Response Syntax <RegisterValue>

PON URQ CME EXE DDE QYE N.U. OPC

MSB LSB
Standard Event Status

Register
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
Response(s) RegisterValue: 

The response data syntax for <RegisterValue> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <RegisterValue> ranges from 0 through 255.

The <RegisterValue> value expressed in base 2 
(binary) represents the bit values of the Standard 
Event Status register. See below.

Example(s) *ESR?  returns 33 
where 33 = (bit CME and bit OPC)

See Also *ESE
*ESE?

*ESR?

Bit Weight Meaning

PON 128 Power ON Enable

URQ 64 User ReQuest Enable

CMD 32 CoMmanD Error Enable

EXE 16 Execution Error Enable

DDE 8 Device Dependent Error Enable

QRY 4 QueRry Error Enable

N.U. 2 Not used

OPC 1 Operation Complete Enable
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IEEE 488.2 and Specific Command Reference
IEEE 488.2 Required Commands
*IDN?
Description The intent of the *IDN? query is for the unique 

identification of devices over the system 
interface.

Syntax *IDN?

Parameter(s) None

Response Syntax <Identification>

Response(s) Identification: 

The response data syntax for <Identification> is 
defined as an <ARBITRARY ASCII RESPONSE 
DATA> element. 

The response syntax for the *IDN? query, 
<Identification> is defined as an <ARBITRARY  
ASCII RESPONSE DATA> element. This implies 
that the *IDN? query should be the last <QUERY 
MESSAGE UNIT> in a <TERMINATED PROGRAM 
MESSAGE>. 
The response is organized into four fields 
separated by commas. The field definitions are 
as follows:

Field 1 (Manufacturer): EXFO Inc. 
Field 2 (Model): Instrument Model
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Field 3 (Serial number):   ASCII character (0 if not 
available)
Field 4 (Firmware level):  ASCII character (0 if 
not available)

ASCII character 0 represents a single 
ASCII-encoded byte with a value of 30 (48 
decimal).

The presence of data in all fields is mandatory. If 
either field 3 or 4 is not available, the ASCII 
character 0 shall be returned for that field. A field 
may contain any 7-bit ASCII-encoded bytes in the 
range of 20 through 7E (32 through 126 decimal) 
except commas (2C, 44 decimal) and 
semicolons (3B, 59 decimal).

Example(s) *IDN? returns EXFO Inc., 
FTB-500,125-2A55,1.0.1.97

Notes The overall length of the *IDN? response is less 
than or equal to 72 characters.

*IDN?
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*OPC
Description The *OPC command makes synchronization 

between the instrument and an external 
controller possible. The *OPC command causes 
the instrument to set bit 0 (Operation Complete) 
in the Standard Event Status Register to the TRUE 
(logic 1) state when the instrument completes all 
pending operations. Detection of the Operation 
Complete message can be accomplished by 
continuous polling of the Standard Event Status 
Register using the *ESR? common query 
command. However, using a service request 
eliminates the need to poll the Standard Event 
Status Register thereby freeing the controller to 
do other useful work.

Syntax *OPC

Parameter(s) None

See Also *OPC?
*WAI
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*OPC?
Description The *OPC? query makes possible the 

synchronization between the instrument and an 
external controller by reading the Output Queue 
or by waiting for a service request on the 
Message Available (MAV) bit in the Status Byte 
Register. The *OPC? query causes the instrument 
to place an ASCII character, 1, into its Output 
Queue when the device completes all pending 
operations. A consequence of this action is that 
the MAV bit in the Status Byte Register is set to 
state 1.

Syntax *OPC?

Parameter(s) None

Response Syntax <Acknowledge>

Response(s) Acknowledge: 

The response data syntax for <Acknowledge> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Acknowledge> response is a single 
ASCII-encoded byte corresponding to 1.

The receipt of an <Acknowledge> response 
indicates that all pending selected device 
operations have been completed.

Example(s) *OPC?  returns 1

See Also *OPC
*WAI
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*RST
Description The *RST command performs a device reset. 

This command is the third reset level in a 
three-level reset strategy. The Reset command 
shall do the following:

a) Sets the device-specific functions to a known 
state that is independent of the past-use history 
of the device.
b) Forces the device into OCIS state (Operation 
complete Command Idle State).
c) Forces the device into OQIS state (Operation 
complete Query Idle State).

The Reset command explicitly DOES NOT affect 
the following:
a) The state of the Communication interface.
b) The Output Queue.
c) Any Event Enable Register setting, including 
the Standard Event Status Enable Register setting.

d) Any Event Register setting, including the 
Standard Event Status Register settings.
e) Calibration data that affects device 
specifications. 
f) The Service Request Enable Register setting.

Syntax *RST

Parameter(s) None
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*SRE
Description The *SRE command sets the Service Request 

Enable Register bits. See the contents of this 
register below. This register contains a mask 
value to enable the bits in the Status Byte 
Register.

Syntax *SRE<wsp><RegisterValue>

Parameter(s) RegisterValue: 

The program data syntax for <RegisterValue> is 
defined as a <DECIMAL NUMERIC PROGRAM 
DATA> element.

The <RegisterValue> value ranges from 0 
through 255.

The <RegisterValue>, expressed in base 2 
(binary), represents the bit values of the Service 
Request Enable Register. 

N.U. N.U. ESB MAV N.U. EAV N.U. N.U.

MSB LSB
Serv ice Request Enable

Register
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See the contents of this register below.

A bit value of zero shall indicate a disabled 
condition.

Example(s) *SRE 52
where 52 = (bit ESB, bit MAV and bit EAV)

See Also *SRE?
*STB?

*SRE

Bit Weight Meaning

N.U. 128 Not used

N.U. 64 Not used

ESB 32 Event Summary Bit Enable

MAV 16 Message AVailable Enable

N.U. 8 Not used

EAV 4 Error / Event AVailable Enable

N.U. 2 Not used

N.U. 1 Not used
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*SRE?
Description With the *SRE? query you can determine the 

current contents of the Service Request Enable 
Register. See the contents of this register below.

Syntax *SRE?

Parameter(s) None

Response Syntax <RegisterValue>

N.U. N.U. ESB MAV N.U. EAV N.U. N.U.

MSB LSB
Serv ice Request Enable

Register

Bit Weight Meaning

N.U. 128 Not used

N.U. 64 Not used

ESB 32 Event Summary Bit Enable

MAV 16 Message AVailable Enable

N.U. 8 Not used

EAV 4 Error / Event AVailable Enable

N.U. 2 Not used

N.U. 1 Not used
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Response(s) RegisterValue: 

The response data syntax for <RegisterValue> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <RegisterValue> ranges from 0 through 255.

When converted to binary (base 2), the 
<RegisterValue> represents the current bit 
values of the Service Request Enable Register.

Example(s) *SRE  returns 32 (bit ESB)

See Also *SRE
*STB?

*SRE?
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*STB?
Description With the *STB? query you can read the status 

byte and Master Summary Status bit. See the 
content of this register below.

Syntax *STB?

Parameter(s) None

Response Syntax <RegisterValue>

N.U. RQS/
MSS

ESB MAV N.U. EAV N.U. N.U.

MSB LSBStatus By te Register
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Response(s) RegisterValue: 

The response data syntax for <RegisterValue> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <RegisterValue> ranges from 0 through 255.

The <RegisterValue> value, expressed in base 2 
(binary) represents the bit values of the Status 
Byte Register. See the contents of this register 
below.

Example(s) *STB?  returns 68
where 68 = (bit MSS and bit EAV)

See Also *SRE
*SRE?

*STB?

Bit Weight Meaning

N.U. 128 Not used

RQS/
MSS

64 ReQuest Service (read by serial 
polling)/MaSter Summary bit 
(read by *STB?)

ESB 32 Event Summary Bit Enable

MAV 16 Message AVailable Enable

N.U. 8 Not used

EAV 4 Error / Event AVailable Enable

N.U. 2 Not used

N.U. 1 Not used
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*TST?
Description The *TST? query causes an internal self-test and 

places a response into the Output Queue 
indicating whether or not the device completed 
the self-test without any detected errors. Upon 
successful completion of *TST?, the device 
settings is restored to their values prior to the 
*TST?.

Syntax *TST?

Parameter(s) None

Response Syntax <Result>

Response(s) Result: 

The response data syntax for <Result> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Result> value ranges from -32767 through 
+32767.

A <Result> with a value of zero indicates that 
the self-test has been completed without errors 
detected. A <Result> with a value not equal to 
zero indicates that the self-test was not 
completed or was completed with errors 
detected.

Example(s) *TST?  returns 0
(self-test was completed with success)
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*WAI
Description The *WAI command shall prevent the device 

from executing any further commands or queries 
until the no-operation-pending flag becomes 
TRUE.

Syntax *WAI

Parameter(s) None

Example(s) *WAI

See Also *OPC
*OPC?
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Specific Commands—Quick Reference
The table below contains a summary of the FTB-500 specific commands. 
These commands are fully explained on the following pages.

Command Parameter(s)

FORMat [DATA] ASCii|PACKed[,<Length>]

[DATA]?

INSTrument CATalog?

CATalog FULL?

SYSTem DATE <Year>,<Month>,<Day>

DATE?

ERRor [NEXT]?

TIME <Hour>,<Minute>,<Seconds>

TIME?

VERSion?
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:FORMat[:DATA]
Description The FORMat[:DATA] command selects the data 

format and <Length>. The <Length> 
parameter is optional for all data format, its 
meaning is dependent on the data format 
selected.

If PACKed type is selected, the data is transferred 
in a <DEFINITE BLOCK RESPONSE DATA>. The 
ASCii-type data is automatically identified by its 
syntax. Therefore, in these cases, the FORMat 
subsystem is only necessary to determine the 
output format.

At *RST, ASCii is selected as the default data 
format and the <Length> is set to 0.

Syntax :FORMat[:DATA]<wsp>ASCii|PACKed[,<Lengt
h>]

Parameter(s)  Type: 

The program data syntax for the first parameter is 
defined as a <CHARACTER PROGRAM DATA> 
element. The allowed <CHARACTER PROGRAM 
DATA> elements for this parameter are: 
ASCii|PACKed. 
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In ASCii format, the numeric data is transferred 
to ASCii bytes in <NR1 NUMERIC RESPONSE 
DATA>, <NR2 NUMERIC RESPONSE DATA> or 
<NR3 NUMERIC RESPONSE DATA> 
representation, as appropriate.

In PACKed format, data is transferred to a 
<DEFINITE BLOCK RESPONSE DATA>, in a 
manner specified in the device documentation.

 Length: 

The program data syntax for <Length> is 
defined as a <DECIMAL NUMERIC PROGRAM 
DATA> element.

When ASCii data format is selected, the optional 
<Length> parameter specifies the number of 
significant digits to be returned. A <Length> 
value of zero indicates that the device selects the 
number of significant digits to be returned. When 
a <Length> of zero has been specified, the 
FORMat[:DATA]? query returns zero as its second 
parameter.

When the PACKed data format is selected, the 
optional parameter <Length> it not used.

Example(s) FORM ASC
FORM ASC,6
FORM:DATA  PACKED

See Also FORMat[:DATA]?

:FORMat[:DATA]
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:FORMat[:DATA]?
Description The FORMat[:DATA]? query returns the data 

format and the <Length>.

At *RST, ASCii is selected as the default data 
format and the <Length> is set to 0.

Syntax :FORMat[:DATA]?

Parameter(s) None

Response Syntax <Type>,<Length>

Response(s)  Type: 

The response data syntax for <Type> is defined 
as a <CHARACTER RESPONSE DATA> element. 

The ASCII <Type> is returned when numeric 
data is transferred to ASCII bytes in <NR1 
NUMERIC RESPONSE DATA>, <NR2 NUMERIC 
RESPONSE DATA> or <NR3 NUMERIC 
RESPONSE DATA> representation, as 
appropriate.

The PACKED <Type> is returned when data is 
transferred to a <DEFINITE BLOCK RESPONSE 
DATA>, as specified in the device 
documentation.

 Length: 

The response data syntax for <Length> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 
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When the data is returned in ASCII, the 
<Length> is the number of significant digits to 
be returned. A <Length> value of zero indicates 
that the device selects the number of significant 
digits to be returned.

When the data is returned in PACKED <Type>, 
the <Length> is not used and always returns 0.

Example(s) FORM?  returns ASCII,6
FORM?  returns PACKED,0

See Also FORMat[:DATA]?

:FORMat[:DATA]?
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:INSTrument:CATalog?
Description The INSTrument:CATalog? query returns a 

comma-separated list of <STRING RESPONSE 
DATA>, which contains the names of all logical 
instruments and groups. If no logical instruments 
are defined, a single null <STRING RESPONSE 
DATA> is returned.

This is not affected by a *RST command.

Syntax :INSTrument:CATalog?

Parameter(s) None

Response Syntax <Catalog>

Response(s) Catalog: 

The response data syntax for <Catalog> is 
defined as a <STRING RESPONSE DATA> 
element. 

The list of <STRING PROGRAM DATA> contains 
the names of all logical instruments and groups.

Example(s) INST:CAT? returns  “FTB-5240 Optical Spectrum 
Analyzer (1250nm-1650nm)”,”FTB-5240 Optical 
Spectrum Analyzer (1250nm-1650nm)”

See Also INSTrument:CATalog:FULL?
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:INSTrument:CATalog:FULL?
Description The INSTrument:CATalog:FULL? returns a list of 

<STRING RESPONSE DATA> - <NR1 NUMERIC 
RESPONSE DATA> pairs. The <STRING 
RESPONSE DATA> contains the name of the 
logical instrument. The immediately following 
<NR1 NUMERIC RESPONSE DATA> formatted 
number is its associated logical instrument 
number. All response data elements are 
separated by commas. If no logical instrument is 
defined, a null <STRING RESPONSE DATA> 
value followed by a zero is returned.

This is not affected by a *RST command.

Syntax :INSTrument:CATalog:FULL?

Parameter(s) None

Response Syntax <Catalog>

Response(s) Catalog: 

The response data syntax for <Catalog> is 
defined as a <STRING RESPONSE DATA> 
element.
The list of <STRING RESPONSE DATA> contains 
the names of all logical instruments and groups. 
The immediately following <NR1 NUMERIC 
RESPONSE DATA> formatted number is its 
associated logical instrument number.

Example(s) INST:CAT:FULL? returns 
“FTB-5240 Optical Spectrum Analyzer 
(1250nm-1650nm)”,1,”FTB-5240 Optical 
Spectrum Analyzer (1250nm-1650nm)”,3 

See Also INSTrument:CATalog?.
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:SYSTem:DATE
Description The SYSTem:DATE command is used to set the 

device's internal calendar.

This is not affected by a *RST command.

Syntax :SYSTem:DATE<wsp><Year>,<Month>,<Day
>

Parameter(s)  Year: 

The program data syntax for <Year> is defined 
as a <DECIMAL NUMERIC PROGRAM DATA> 
element.

The <Year> is rounded to the nearest integer. Its 
range is limited by the capability of the device. 
The year shall be entered as a four-digit number, 
including century and millennium information. 

 Month: 

The program data syntax for <Month> is defined 
as a <DECIMAL NUMERIC PROGRAM DATA> 
element.

The <Month> is rounded to the nearest integer. 
Its range is 1 to 12 inclusive. The number 1 
corresponds to January, 2 to February, and so on.
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 Day: 

The program data syntax for <Day> is defined as 
a <DECIMAL NUMERIC PROGRAM DATA> 
element.

The <Day> is rounded to the nearest integer. It 
ranges from 1 to the number of days in the 
month from the previous parameter. This 
command keeps track of the number of days in 
each month, accounting for leap years through 
the range of years that it accepts.

Example(s) SYST:DATE 2001,11,29

See Also SYSTem:DATE?

:SYSTem:DATE
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:SYSTem:DATE?
Description The SYSTem:DATE query returns the instrument's 

internal calendar.

This is not affected by a *RST command.

Syntax :SYSTem:DATE?

Parameter(s) None

Response Syntax <Year>,<Month>,<Day>
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Response(s)  Year: 

The response data syntax for <Year> is defined 
as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Year> is a four-digit number, including 
century and millennium information. 

 Month: 

The response data syntax for <Month> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Month> ranges from 1 to 12, inclusively. 
The number 1 corresponds to January, 2 to 
February, and so on.

 Day: 

The response data syntax for <Day> is defined 
as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Day> ranges from 1 to the number of days 
in the month from the previous field. This 
command keeps track of the number of days in 
each month, accounting for leap years through 
the range of years that it accepts.

Example(s) SYST:DATE? returns 2001,11,29

See Also SYSTem:DATE

:SYSTem:DATE?
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:SYSTem:ERRor[:NEXT]?
Description The SYSTem:ERRor[:NEXT]? queries the 

error/event queue for the next item and removes 
it from the queue. The response message 
consists of two fields separated by commas 
<Code>,<Description[,Info]>.

SYSTem:ERRor[:NEXT]? is a query only and, 
therefore, does not have an associated *RST 
state.

Syntax :SYSTem:ERRor[:NEXT]?

Parameter(s) None

Response Syntax <Code>,<Description[,Info]>

Response(s)  Code: 

The response data syntax for <Code> is defined 
as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Code> is a unique integer in the range 
[-32768, 32767]. All positive numbers are 
instrument-dependent. All negative numbers are 
reserved by the SCPI standard with certain 
standard error/event codes described in an 
appendix of this document. The zero value is 
also used to indicate that no error or event has 
occurred.

 Description[,Info]: 

The response data syntax for 
<Description[,Info]> is defined as a <STRING 
RESPONSE DATA> element. 
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The <Description[,Info]> parameter of the full 
response is a quoted string containing a 
description followed by information text [,Info]. 
Each <Code> has a unique and fixed 
<Description> associated with it. The <Date> 
and  <Time> are appended to the [,info] 
separated by a semi-colon using the following 
format:
<Date><wsp><Time> where
<Date> = Year/Month/Day
<Time> = Hour,Minute,Second (24 hour time)

The maximum length of <Description[,Info]> is 
255 characters. For standard defined error/event 
<Codes>, the <Description> is sent exactly as 
indicated in the appendix of this document.

Example(s) SYST:ERR:NEXT? returns  -222,”Data out of range”
SYST:ERR:NEXT? returns  -222,”Data out of 
range,instrument monomodule 5240, 2001/11/29 
14:56:16.259”

:SYSTem:ERRor[:NEXT]?
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:SYSTem:TIME
Description This device has an internal clock and 

implements the SYSTem:TIME command to set 
the clock time over the interface.

This is not affected by a *RST command.

Syntax :SYSTem:TIME<wsp><Hour>,<Minute>,<Sec
onds>

Parameter(s)  Hour: 

The program data syntax for <Hour> is defined 
as a <DECIMAL NUMERIC PROGRAM DATA> 
element.

The <Hour> is always rounded to the nearest 
integer. It ranges from 0 to 23 inclusively. The 
device accepts hour information in 24-hour 
format. 

 Minute: 

The program data syntax for <Minute> is 
defined as a <DECIMAL NUMERIC PROGRAM 
DATA> element.

The <Minute> is always rounded to the nearest 
integer. It ranges from 0 to 59 inclusively.
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 Seconds: 

The program data syntax for <Seconds> is 
defined as a <DECIMAL NUMERIC PROGRAM 
DATA> element.

The <Second> is rounded to the resolution of 
the clock. It ranges from 0 to 60. A value of 60 is 
allowed since rounding may cause a number 
greater than 59.5 to be rounded to 60. When this 
element is rounded to 60 it shall be set to 0 and 
the minute value incremented. Any other carries 
shall be rippled through the date.

Example(s) SYST:TIME 12,47,29

See Also SYSTem:TIME?

:SYSTem:TIME
354 FTB-500



IEEE 488.2 and Specific Command Reference
Specific Commands
:SYSTem:TIME?
Description This device has an internal clock and 

implements the SYSTem:DATE? query to get the 
clock time over the interface.

This is not affected by a *RST command.

Syntax :SYSTem:TIME?

Parameter(s) None

Response Syntax <Hour>,<Minute>,<Second>
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Response(s)  Hour: 

The response data syntax for <Hour> is defined 
as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Hour> ranges from 0 to 23. The 
instruments returns hour information in 24-hour 
format.

 Minute: 

The response data syntax for <Minute> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Minute> ranges from 0 to 59.

 Second: 

The response data syntax for <Second> is 
defined as a <NR1 NUMERIC RESPONSE DATA> 
element. 

The <Second> ranges from 0 to 59. The 
resolution of the clock is the second.

Example(s) SYST:TIME? returns 16,55,38

See Also SYSTem:TIME

:SYSTem:TIME?
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:SYSTem:VERSion?
Description The SYSTem:VERSion? query returns a value 

corresponding to the SCPI version number to 
which the device complies.

The SYSTem:VERSion? is a query only and, 
therefore, does not have an associated *RST 
state.

Syntax :SYSTem:VERSion?

Parameter(s) None

Response Syntax <Version>

Response(s) Version: 

The response data syntax for <Version> is 
defined as a <NR2 NUMERIC RESPONSE DATA> 
element. 

The <Version> is shown in the form 
Year.Revision, where Year represents the 
year-version (that is 1990) and Revision 
represents an approved revision number for that 
year. If no approved revisions are claimed, then 
this extension is 0.

Example(s) SYSTem:VERSion? returns 1999.0 (no approved 
revisions are claimed)
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Error 

Number Description Probable Cause

–100 “Command error” This is the generic syntax error for devices that 
cannot detect more specific errors. 
This code indicates only that a Command Error as 
defined in IEEE 488.2, 11.5.1.1.4 has occurred.

–101 “Invalid character” A syntactic element contains a character which is 
invalid for that type; for example, a header 
containing an ampersand, SETUP&. 
This error might be used in place of errors –114,
–121, –141, and perhaps some others.

–102 “Syntax error” An unrecognized command or data type was 
encountered; for example, a string was received 
when the device does not accept strings.

–103 “Invalid separator” The parser was expecting a separator and 
encountered an illegal character; for example, the 
semicolon was omitted after a program message 
unit, *EMC 1:CH1:VOLTS 5.

–104 “Data type error” The parser recognized a data element different 
than one allowed; for example, numeric or string 
data was expected but block data was 
encountered.

–105 “GET not allowed” A Group Execute Trigger was received within a 
program message (see IEEE 488.2, 7.7).

–108 “Parameter not 
allowed”

More parameters were received than expected for 
the header; for example, the *EMC common 
command only accepts one parameter, so 
receiving *EMC 0,1 is not allowed.

–109 “Missing parameter” Fewer parameters were received than required for 
the header; for example, the *EMC common 
command requires one parameter, so receiving 
*EMC is not allowed.
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–110 “Command header 
error”

An error was detected in the header. This error 
message should be used when the device cannot 
detect the more specific errors described for errors 
–111 through –119.

–111 “Header separator 
error”

A character which is not a legal header separator 
was encountered while parsing the header; for 
example, no white space followed the header, thus 
*GMC"MACRO" is an error.

–112 “Program mnemonic 
too long”

The header contains more that twelve characters 
(see IEEE 488.2, 7.6.1.4.1).

–113 “Undefined header” The header is syntactically correct, but it is 
undefined for this specific device; for example, 
*XYZ is not defined for any device.

–114 “Header suffix out of 
range”

The value of a numeric suffix attached to a 
program mnemonic (see IEEE 488.2, Syntax and 
Style section 6.2.5.2) makes the header invalid.

–115 “Unexpected number 
of parameters”

The number of parameters received does not 
correspond to the number of parameters 
expected. This is typically due an inconsistency 
with the number of instruments in the selected 
group (see section on 
INSTrument:DEFine:GROup).

–120 “Numeric data error” This error, as well as errors –121 through –129, are 
generated when parsing a data element which 
appears to be numeric, including the non-decimal 
numeric types.This particular error message 
should be used if the device cannot detect a more 
specific error.

–121 “Invalid character in 
number”

An invalid character for the data type being parsed 
was encountered; for example, an alpha in a 
decimal numeric or a "9" in octal data.

Error 
Number Description Probable Cause
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–123 “Exponent too large” The magnitude of the exponent was larger than 
32000 (see IEEE 488.2, 7.7.2.4.1).

–124 “Too many digits” The mantissa of a decimal numeric data element 
contained more than 255 digits excluding leading 
zeros (see IEEE 488.2, 7.7.2.4.1).

–128 “Numeric data not 
allowed”

A legal numeric data element was received, but 
the device does not accept one in this position for 
the header.

–130 “Suffix error” This error, as well as errors –131 through –139, are 
generated when parsing a suffix. This particular 
error message should be used if the device cannot 
detect a more specific error.

–131 “Invalid suffix” The suffix does not follow the syntax described in 
IEEE 488.2, 7.7.3.2, or the suffix is inappropriate for 
this device.

–134 “Suffix too long” The suffix contained more than 12 characters (see 
IEEE 488.2, 7.7.3.4).

–138 “Suffix not allowed” A suffix was encountered after a numeric element 
which does not allow suffixes.

–140 “Character data error” This error, as well as errors –141 through –149, are 
generated when parsing a character data element. 
This particular error message should be used if the 
device cannot detect a more specific error.

–141 “Invalid character data” Either the character data element contains an 
invalid character or the particular element 
received is not valid for the header.

–144 “Character data tool 
long”

The character data element contains more than 
twelve characters (see IEEE 488.2, 7.7.1.4).

–148 “Character data not 
allowed”

A legal character data element was encountered 
where prohibited by the device.

Error 
Number Description Probable Cause
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–150 “String data error” This error, as well as errors –151 through –159, are 
generated when parsing a string data element. This 
particular error message should be used if the 
device cannot detect a more specific error.

–151 “Invalid string data” A string data element was expected, but was 
invalid for some reason (see IEEE 488.2, 7.7.5.2); 
for example, an END message was received before 
the terminal quote character.

–158 “String data not 
allowed”

A string data element was encountered but was 
not allowed by the device at this point in parsing.

–160 “Block data error This error, as well as errors –161 through –169, are 
generated when parsing a block data element. This 
particular error message should be used if the 
device cannot detect a more specific error.

–161 “Invalid block data” A block data element was expected, but was 
invalid for some reason (see IEEE 488.2, 7.7.6.2); 
for example, an END message was received before 
the length was satisfied.

–168 “Block data not 
allowed”

A legal block data element was encountered but 
was not allowed by the device at this point in 
parsing.

–170 “Expression error” This error, as well as errors –171 through –179, are 
generated when parsing an expression data 
element. This particular error message should be 
used if the device cannot detect a more specific 
error.

–171 “Invalid expression” The expression data element was invalid (see IEEE 
488.2, 7.7.7.2); for example, unmatched 
parentheses or an illegal character.

–178 “Expression data not 
allowed”

A legal expression data was encountered but was 
not allowed by the device at this point in parsing.

Error 
Number Description Probable Cause
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–180 “Macro error” This error, as well as errors –181 through –189, are 
generated when defining a macro or executing a 
macro. This particular error message should be 
used if the device cannot detect a more specific 
error.

–181 “Invalid outside macro 
definition”

Indicates that a macro parameter placeholder 
($<number) was encountered outside of a macro 
definition.

–183 “Invalid inside macro 
definition”

Indicates that the program message unit sequence, 
sent with a *DDT or *DMC command, is 
syntactically invalid (see IEEE 488.2, 10.7.6.3).

–184 “Macro parameter 
error”

Indicates that a command inside the macro 
definition had the wrong number or type of 
parameters.

–200 “Execution error” This is the generic syntax error for devices that 
cannot detect more specific errors. This code 
indicates only that an Execution Error as defined in 
IEEE 488.2, 11.5.1.1.5 has occurred.

–201 “Invalid while in local” Indicates that a command is not executable while 
the device is in local due to a hard local control 
(see IEEE 488.2, 5.6.1.5); for example, a device with 
a rotary switch receives a message which would 
change the switches state, but the device is in local 
so the message can not be executed.

–202 “Settings lost due to rtl” Indicates that a setting associated with a hard local 
control (see IEEE 488.2, 5.6.1.5) was lost when the 
device changed to LOCS from REMS or to LWLS 
from RWLS.

–203 “Command protected” Indicates that a legal password-protected program 
command or query could not be executed 
because the command was disabled.

Error 
Number Description Probable Cause
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–210 “Trigger error” -----

–211 “Trigger ignored” Indicates that a GET, *TRG, or triggering signal was 
received and recognized by the device but was 
ignored because of device timing considerations; 
for example, the device was not ready to respond. 
Note: a DT0 device always ignores GET and treats 
*TRG as a Command Error.

–212 “Arm ignored” Indicates that an arming signal was received and 
recognized by the device but was ignored.

–213 “Init ignored” Indicates that a request for a measurement 
initiation was ignored as another measurement 
was already in progress.

–214 “Trigger deadlock” Indicates that the trigger source for the initiation of 
a measurement is set to GET and subsequent 
measurement query is received. The 
measurement cannot be started until a GET is 
received, but the GET would cause an 
INTERRUPTED error.

–215 “Arm deadlock” Indicates that the arm source for the initiation of a 
measurement is set to GET and subsequent 
measurement query is received. The 
measurement cannot be started until a GET is 
received, but the GET would cause an 
INTERRUPTED error.

–220 “Parameter error” Indicates that a program data element related error 
occurred. This error message should be used 
when the device cannot detect the more specific 
errors described for errors –221 through –229.

–221 “Settings conflict” Indicates that a legal program data element was 
parsed but could not be executed due to the 
current device state (see IEEE 488.2, 6.4.5.3 and 
11.5.1.1.5).

Error 
Number Description Probable Cause
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–222 “Data out of range” Indicates that a legal program data element was 
parsed but could not be executed because the 
interpreted value was outside the legal range as 
defined by the device (see IEEE 488.2, 11.5.1.1.5).

–223 “Too much data” Indicates that a legal program data element of 
block, expression, or string type was received that 
contained more data than the device could handle 
due to memory or related device-specific 
requirements.

–224 “Illegal parameter 
value”

Used where exact value, from a list of possible, 
was expected.

–225 “Out of memory” The device has insufficient memory to perform the 
requested operation.

–226 “Lists not same length” Attempted to use LIST structure having individual 
LIST's of unequal lengths.

–230 “Data corrupt or stale” Possibly invalid data; new reading started but not 
completed since last access.

–231 “Data questionable” Indicates that measurement accuracy is suspect.

–232 “Invalid format” Indicates that a legal program data element was 
parsed but could not be executed because the data 
format or structure is inappropriate. For example 
when loading memory tables or when sending a 
SYSTem:SET parameter from an unknown 
instrument.

Error 
Number Description Probable Cause
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–233 “Invalid version” Indicates that a legal program data element was 
parsed but could not be executed because the 
version of the data is incorrect to the device. This 
particular error should be used when file or block 
data formats are recognized by the instrument but 
cannot be executed for reasons of version 
incompatibility. For example, a not supported file 
version, a not supported instrument version

–240 “Hardware error” Indicates that a legal program command or query 
could not be executed because of a hardware 
problem in the device. Definition of what 
constitutes a hardware problem is completely 
device-specific. This error message should be used 
when the device cannot detect the more specific 
errors described for errors –241 through –249.

–241 “Hardware missing” Indicates that a legal program command or query 
could not be executed because of missing device 
hardware; for example, an option was not 
installed. Definition of what constitutes missing 
hardware is completely device-specific.

–250 “Mass storage error” Indicates that a mass storage error occurred. This 
error message should be used when the device 
cannot detect the more specific errors described 
for errors –251 through –259.

–251 “Missing mass storage” Indicates that a legal program command or query 
could not be executed because of missing mass 
storage; for example, an option that was not 
installed. Definition of what constitutes missing 
mass storage is device-specific.

–252 “Missing media” Indicates that a legal program command or query 
could not be executed because of a missing 
media; for example, no disk. The definition of what 
constitutes missing media is device-specific.

Error 
Number Description Probable Cause
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–253 “Corrupt media” Indicates that a legal program command or query 
could not be executed because of corrupt media; 
for example, bad disk or wrong format. The 
definition of what constitutes corrupt media is 
device-specific.

–254 “Media full” Indicates that a legal program command or query 
could not be executed because the media was full; 
for example, there is no room on the disk. The 
definition of what constitutes a full media is 
device-specific.

–255 “Directory full” Indicates that a legal program command or query 
could not be executed because the media 
directory was full. The definition of what 
constitutes a full media directory is device-specific.

–256 “File name not found” Indicates that a legal program command or query 
could not be executed because the file name on 
the device media was not found; for example, an 
attempt was made to read or copy a nonexistent 
file. The definition of what constitutes a file not 
being found is device-specific.

–257 “File name error” Indicates that a legal program command or query 
could not be executed because the file name on 
the device media was in error; for example, an 
attempt was made to copy to a duplicate file name. 
The definition of what constitutes a file name error 
is device-specific.

–258 “Media protected” Indicates that a legal program command or query 
could not be executed because the media was 
protected; for example, the write-protect tab on a 
disk was present.The definition of what constitutes 
protected media is device-specific.

Error 
Number Description Probable Cause
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–260 “Expression error” [Indicates that a expression program data element 
related error occurred. This error message should 
be used when the device cannot detect the more 
specific errors described for errors –261 through –
269.]

–261 “Math error in 
expression”

[Indicates that a syntactically legal expression 
program data element could not be executed due 
to a math error; for example, a divide-by-zero was 
attempted. The definition of math error is 
device-specific.]

–270 “Macro error” [Indicates that a macro-related execution error 
occurred. This error message should be used 
when the device cannot detect the more specific 
errors described for errors –271 through –279.]

–271 “Macro syntax error” [Indicates that a syntactically legal macro program 
data sequence, according to IEEE 488.2, 10.7.2, 
could not be executed due to a syntax error within 
the macro definition (see IEEE 488.2, 10.7.6.3).]

–272 “Macro execution 
error”

[Indicates that a syntactically legal macro program 
data sequence could not be executed due to some 
error in the macro definition (see IEEE 488.2, 
10.7.6.3).]

–273 “Illegal macro label” [Indicates that the macro label defined in the 
*DMC command was a legal string syntax, but 
could not be accepted by the device (see IEEE 
488.2, 10.7.3 and 10.7.6.2); for example, the label 
was too long, the same as a common command 
header, or contained invalid header syntax.]

–274 “Macro parameter 
error”

[Indicates that the macro definition improperly 
used a macro parameter placeholder (see IEEE 
488.2, 10.7.3).]

Error 
Number Description Probable Cause
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–275 “Macro definition too 
long”

[Indicates that a syntactically legal macro program 
data sequence could not be executed because the 
string or block contents were too long for the 
device to handle (see IEEE 488.2, 10.7.6.1).]

–276 “Macro recursion 
error”

[Indicates that a syntactically legal macro program 
data sequence could not be executed because the 
device found it to be recursive (see IEEE 488.2, 
10.7.6.6).]

–277 “Macro redefinition not 
allowed”

[Indicates that a syntactically legal macro label in 
the *DMC command could not be executed 
because the macro label was already defined (see 
IEEE 488.2, 10.7.6.4).]

–278 “Macro header not 
found”

[Indicates that a syntactically legal macro label in 
the *GMC? query could not be executed because 
the header was not previously defined.]

–280 “Program error” [Indicates that a downloaded program-related 
execution error occurred. This error message 
should be used when the device cannot detect the 
more specific errors described for errors –281 
through –289. A downloaded program is used to 
add algorithmic capability to a device. The syntax 
used in the program and the mechanism for 
downloading a program is device-specific.]

–281 “Cannot create 
program”

[Indicates that an attempt to create a program was 
unsuccessful. A reason for the failure might include 
not enough memory.]

–282 “”Illegal program name [The name used to reference a program was 
invalid; for example, redefining an existing 
program, deleting a nonexistent program, or in 
general, referencing a nonexistent program.]

–283 “Illegal variable name” [An attempt was made to reference a nonexistent 
variable in a program.]

Error 
Number Description Probable Cause
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–284 “Program currently 
running”

[Certain operations dealing with programs may be 
illegal while the program is running; for example, 
deleting a running program might not be possible.]

–285 “Program syntax error” [Indicates that a syntax error appears in a 
downloaded program. The syntax used when 
parsing the downloaded program is 
device-specific.]

–286 “Program runtime 
error”

-----

–290 “Memory use error” [Indicates that a user request has directly or 
indirectly caused an error related to memory or 
<data_handle>, this is not the same as “bad” 
memory.]

–291 “Out of memory” -----

–292 “Referenced name 
does not exist”

-----

–293 “Referenced name 
already exist”

-----

–294 “Incompatible type” [Indicates that the type or structure of a memory 
item is inadequate]

–300 “Device-specific error” [This is the generic device-dependent error for 
devices that cannot detect more specific errors. 
This code indicates only that a Device-Dependent 
Error as defined in IEEE 488.2, 11.5.1.1.6 has 
occurred.]

–310 “System error” [Indicates that some error, termed "system error" 
by the device, has occurred. This code is 
device-dependent.]

–311 “Memory error” [Indicates some physical fault in the device's 
memory, such as parity error.]

Error 
Number Description Probable Cause
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–312 “PUD memory lost” [Indicates that the protected user data saved by the 
*PUD command has been lost.]

–313 “Calibration memory 
lost”

[Indicates that nonvolatile calibration data used by 
the *CAL? command has been lost.]

–314 “Save/Recall memory 
lost”

[Indicates that the nonvolatile data saved by the 
*SAV? command has been lost.]

–315 “Configuration 
memory lost”

[Indicates that nonvolatile configuration data saved 
by the device has been lost. The meaning of this 
error is device-specific.]

–320 “Storage fault” [Indicates that the firmware detected a fault when 
using data storage. This error is not an indication of 
physical damage or failure of any mass storage 
element.]

–321 “Out of memory” [An internal operation needed more memory than 
was available.]

–330 “Self-test failed” -----

–340 “Calibration failed” -----

–350 “Queue overflow” [A specific code entered into the queue in lieu of 
the code that caused the error. This code indicates 
that there is no room in the queue and an error 
occurred but was not recorded.]

–360 “Communication 
error”

[This is the generic communication error for 
devices that cannot detect the more specific errors 
described for errors –361 through –363.]

–361 “Parity error in program 
message”

[Parity bit not correct when data received for 
example, on a serial port.]

–362 “Framing error in 
program message”

[A stop bit was not detected when data was 
received for example, on a serial port (for example, 
a baud rate mismatch).]

Error 
Number Description Probable Cause
FTB-500 371



SCPI-Based Errors
–363 “Input buffer overrun” [Software or hardware input buffer on serial port 
overflows with data caused by improper or 
nonexistent pacing.]

–365 “Time out error” [This is a generic device-dependent error.]

–400 “Query error” [This is the generic query error for devices that 
cannot detect more specific errors. This code 
indicates only that a Query Error as defined in IEEE 
488.2, 11.5.1.1.7 and 6.3 has occurred.]

–410 “Query INTERRUPTED” [Indicates that a condition causing an 
INTERRUPTED Query error occurred (see IEEE 
488.2, 6.3.2.3); for example, a query followed by 
DAB or GET before a response was completely 
sent.]

–420 “Query 
UNTERMINATED”

[Indicates that a condition causing an 
UNTERMINATED Query error occurred (see IEEE 
488.2, 6.3.2.2); for example, the device was 
addressed to talk and an incomplete program 
message was received.]

–430 “Query DEADLOCKED” [Indicates that a condition causing an 
DEADLOCKED Query error occurred (see IEEE 
488.2, 6.3.1.7); for example, both input buffer and 
output buffer are full and the device cannot 
continue.]

–440 “Query 
UNTERMINATED after 
indefinite response”

[Indicates that a query was received in the same 
program message after an query requesting an 
indefinite response was executed (see IEEE 488.2, 
6.5.7.5).]

–500 “Power on” [The instrument has detected an off to on 
transition in its power supply.]

–600 “User request” [The instrument has detected the activation of a 
user request local control.]

Error 
Number Description Probable Cause
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–700 “Request control” [The instrument requested to become the active 
IEEE 488.1 controller-in-charge.]

–800 “Operation complete” [The instrument has completed all selected 
pending operations in accordance with the IEEE 
488.2, 12.5.2 synchronization protocol.]

Error 
Number Description Probable Cause
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E COM Properties and Events
The FTB-500 also provides objects based on Microsoft Component Object 
Model (COM). COM defines a common way to access and create software 
components and services.

COM promotes the integration and the reuse of software components, as 
well as interoperability. In order to interoperate, components developed 
in different languages must adhere to a binary structure specified 
by Microsoft. 

OLE and ActiveX are based on COM. Also, programming languages such as 
C, C++, Smalltalk, Pascal, Ada, Java, and LabVIEW can create and use 
COM components. 

You can build your own programs using the provided properties and events 
via the IcSCPIAccess interface. For information on how to configure your 
FTB-500 for DCOM control, see Configuring DCOM Access to Your Unit on 
page 185.
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ActiveX (COM/DCOM)—Quick Reference
The following diagram illustrates the different properties and events 
available.

These properties and events are fully explained in the following pages.

ICSCPIAccess

ICSCPIActiveX.dll

Object acting 
as an entry 
point

Write property

WriteBinary property

Read property

ReadBinary property

Initialize property

DeviceClear property

RemoteState property

LockoutState property

StatusByte property

RequestService event

ReturnToLocal event
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Write
Description With this method you can send a program 

message (single command or compound of 
commands) to the device input buffer.

Syntax object.Write (Message)

Parameter(s) Message: Required. A string value corresponding 
to the program message to be sent.

Possible error(s) Timeout: This error will occur if the operation 
could not be completed within the allowed 
delay. For information on timeout setting, see 
Initialize on page 381.
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WriteBinary
Description With this method you can send a program 

message (single command or compound of 
commands) as an array of bytes into the device 
input buffer.

Syntax object.Write (BinaryArray)

Parameter(s) BinaryArray: Required. An array of bytes 
corresponding to the program message to be 
sent.

Notes Use this method instead of the Write method if 
you need to send commands in binary (COM is 
UNICODE).

Possible error(s) Timeout: This error will occur if the operation 
could not be completed within the allowed 
delay. For information on timeout setting, see 
Initialize on page 381.

IMPORTANT
Before you retrieve data with the Read or ReadBinary methods, you 
must specify the format in which the information must be returned. 
Details on how to correctly set the format can be found below.
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Read
Description With this method you can retrieve all the data 

from the device output queue in a UNICODE 
format.

Syntax object.Read

Parameter(s) None.

Response(s) A string value (in UNICODE format).

Notes This method must be used in conjunction with 
the Write method. Always ensure that a query 
has been previously sent before attempting to 
read a response from the output queue.

To properly set the data format, send the 
following command (using the Write method):
FORM:DATA<wsp>ASCII <number_of_digits>
where <number_of_digits> corresponds to the 
number of digits after the decimal point that you 
require.

Remember that the retrieved data will have to be 
converted to a numeric format before you can 
use it in calculations, for example.

Possible error(s) Timeout: This error will occur if the allowed 
delay has expired before the preceding Write 
operation could send a response to the output 
queue. For information on timeout setting, see 
Initialize on page 381.

QueryUnterminated: This error will occur if the 
output queue is empty (for example, no query 
has been made previously).
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ReadBinary
Description With this method you can retrieve data from the 

device output queue in a binary format.

Syntax object.ReadBinary

Parameter(s) None.

Response(s) An array of bytes.

Notes This method must be used in conjunction with 
the Write method. Always ensure that a query 
has been previously sent before attempting to 
read a response from the output queue.

To properly set the data format, send the 
following command (using the Write method):
FORM:DATA<wsp>PACKED

The retrieved data does not need to be converted 
to a numeric format before you can use it in 
calculations, for example.

To help you know the actual length of the 
retrieved data, it has the following structure:

 The first byte contains the # character.

 The byte that immediately follows contains 
the number of subsequent bytes that you 
have to check to know the total length.
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For example, if you receive this response (here, 
values are expressed in decimal instead of binary 
for easier readability):

# 2 1 3 7 5 8 9 2 ...

The byte that immediately follows the # contains 
2, which means that you have to read the two 
following bytes to know the length (in bytes) of 
the retrieved data. The bytes indicate 1 and 3. 
The length will then be 13 bytes. The actual 
response will begin at byte number 5, in this 
case.

Possible error(s) Timeout: This error will occur if the allowed 
delay has expired before the preceding Write 
operation could send a response to the output 
queue. For information on timeout setting, see 
Initialize on page 381.

QueryUnterminated: This error will occur if the 
output queue is empty (for example, no query 
has been made previously).

Initialize
Description With this method you can configure the timeout 

value that is, the allowed delay for Read and 
Write operations, in milliseconds. 

Syntax object.Initialize(Timeout)

Parameter(s) Timeout: Required. A numeric value 
corresponding to the delay in milliseconds.

Notes If the Initialize method is not invoked, the default 
value is 10 000 milliseconds.

ReadBinary
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DeviceClear
Description This method performs a Device Clear operation 

as specified in the IEEE 488.1 standard.

Syntax object.DeviceClear

Parameter(s) None.

RemoteState
Description This property returns or sets the device’s remote 

state.

Syntax object.RemoteState (to retrieve the state)

object.RemoteState=State (to set the state)

State: a Boolean value corresponding to:

True: Remote

False: Local

Parameter(s) None.

Response(s) If the property is used to get the device’s remote 
state, the property will return a Boolean value.

Access Get/Set
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LockoutState
Description This property returns or sets the device’s lockout 

state.

Syntax object.LockoutState (to retrieve the state)

object.LockoutState=State (to set the state)

State: a Boolean value corresponding to:

True: Lockout

False: No lockout

Parameter(s) None.

Response(s) If the property is used to get the device’s lockout 
state, the property will return a Boolean value.

Access Get/Set

StatusByte
Description This read-only property returns the device’s 

status byte. Refer to IEEE 488.2 standard for 
status byte description.

Syntax object.StatusByte

Parameter(s) None.

Response(s) A value corresponding to the device’s status byte.

Notes This property can be used in conjunction with 
RequestService event (see RequestService on 
page 384) to find out why the device caused a 
Service Request (SRQ).

Access Get
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RequestService
Description This event is triggered whenever the device 

causes a Service Request (SRQ).

Parameter(s) None.

Notes It is the user’s responsibility to configure the 
different registers (*SRE, *ESE) as stated in the 
IEEE 488.2 standard to receive SRQ.

When used in conjunction with StatusByte 
property (see StatusByte on page 383), this event 
allows you to determine the cause of the SRQ.

ReturnToLocal
Description This event is triggered when the user presses the 

Local button from the controller’s front panel 
when the device is in Remote state.

Parameter(s) None.
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